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Vorwort

Zweck des Handbuchs

Dieses Handbuch ist eine Anleitung zur Software SIGUARD PDP. Sie erhalten einen Überblick über die Ein-
satz- und Konfigurationsmöglichkeiten.

Zielgruppe

Dieses Handbuch wendet sich vorzugsweise an das Betriebspersonal, Inbetriebnehmer und Qualitätsmana-
ger, die für die Konfiguration, Parametrierung und Überwachung von Energienetzen und deren Komponenten 
zuständig sind.

Gültigkeitsbereich des Handbuchs

Dieses Handbuch ist gültig für SIGUARD PDP V2.10.

Normen

Die Entwicklung von SIGUARD PDP wurde nach den Richtlinien der DIN EN ISO 9001:2008 durchgeführt.

Weitere Unterstützung

Bei Fragen zum System wenden Sie sich an Ihren Siemens-Vertriebspartner.

Support

Unser Customer Support Center unterstützt Sie rund um die Uhr.

Tel.: +49 (1805) 24-7000

Fax: +49 (1805) 24-2471

E-Mail: support.ic@siemens.com

Schulung

Sie können das individuelle Kursangebot bei unserem Training Center erfragen:

Siemens AG

Siemens Power Academy

Humboldtstraße 59 

90459 Nürnberg 

Tel.: +49 (911) 433-7415 

Fax: +49 (911) 433-5482 

E-Mail: td.power-academy.energy@siemens.com

Internet: http://www.siemens.com/energy/power-academy
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Vorwort
 

Hinweise zu Ihrer Sicherheit

Dieses Handbuch ist kein vollständiges Verzeichnis aller für einen Betrieb des Betriebsmittels (Baugruppe, 
Gerät) erforderlichen Sicherheitsmaßnahmen. Es enthält aber Hinweise, die Sie zu Ihrer persönlichen Sicher-
heit sowie zur Vermeidung von Sachschäden beachten müssen. Die Hinweise sind je nach Gefährdungsgrad 
wie folgt dargestellt:

GEFAHR
GEFAHR bedeutet, dass Tod oder schwere Verletzungen eintreten werden, wenn die angegebenen Maßnah-
men nicht getroffen werden.

✧ Beachten Sie alle Hinweise, um Tod oder schwere Verletzungen zu vermeiden.

WARNUNG
WARNUNG bedeutet, dass Tod oder schwere Verletzungen eintreten können, wenn die angegebenen Maß-
nahmen nicht getroffen werden.

✧ Beachten Sie alle Hinweise, um Tod oder schwere Verletzungen zu vermeiden.

VORSICHT
VORSICHT bedeutet, dass mittelschwere oder leichte Verletzungen eintreten können, wenn die angegebenen 
Maßnahmen nicht getroffen werden.

✧ Beachten Sie alle Hinweise, um mittelschwere oder leichte Verletzungen zu vermeiden.

ACHTUNG
ACHTUNG bedeutet, dass Sachschäden entstehen können, wenn die angegebenen Maßnahmen nicht ge-
troffen werden.

✧ Beachten Sie alle Hinweise, um Sachschäden zu vermeiden.

 HINWEIS

ist eine wichtige Information über das Produkt, die Handhabung des Produktes oder den jeweiligen Teil der 
Dokumentation, auf den besonders aufmerksam gemacht werden soll.

 

SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

4

http://siemens-russia.com/


Inhaltsverzeichnis

Vorwort  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

1 SIGUARD PDP Systemübersicht. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

1.1 Übersicht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8

1.2 Leistungsmerkmale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12

1.3 Konfigurationsbeispiel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14

1.4 Power System Status berechnen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15

1.4.1 Übersicht  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15

1.4.2 Konfiguration der Messwertbewertung. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15

1.4.3 Berechnungen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17

1.5 SIGUARD PDP Pendelerkennung (PSR)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

2 SIGUARD PDP UI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

2.1 Übersicht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24

2.2 Menü und Symbolleiste . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .26

2.3 Power System Status. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28

2.4 Map . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .33

2.5 Chart View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38

2.6 Messwerte, Anwendungen und Formeln . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .42

2.6.1 Übersicht  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .42

2.6.2 Selected measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43

2.6.3 All measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .44

2.6.4 Predefined formulas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .45

2.6.5 Voltage stability curves. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .46

2.6.6 Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .47

2.7 Warnmeldeliste und Ereignisliste. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48

2.7.1 Übersicht  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48

2.7.2 Warnmeldeliste  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48

2.7.3 Ereignisliste . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49

2.7.4 Bearbeitung von Meldungen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .50

2.8 Programmoberfläche gestalten . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .51

2.9 Limit Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .54

2.10 Berichterstellung  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .56

2.11 Applikationen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .59

2.11.1 Übersicht  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .59

2.11.2 Inselerkennung (Island State Detection ISD) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .59

2.11.3 Schwingungserkennung (Power Swing Recognition PSR)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62

2.11.4 Spannungsstabilitätskurve (Voltage-Stability Curve VSC) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .65
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

5

http://siemens-russia.com/


Inhaltsverzeichnis
 

3 Mit SIGUARD PDP UI arbeiten  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

3.1 Beispielereignis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

3.2 Zeitbereich auswählen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

3.3 Kurven anzeigen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

3.4 Export und Import von Zeitbereichen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

3.4.1 Export von Zeitbereichen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

3.4.2 Import von Zeitbereichen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

3.4.3 Löschen von Zeitbereichen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

3.5 Schlussfolgerung aus der Analyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

3.6 Bericht erstellen und drucken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

4 SIGUARD PDP Engineer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

4.1 Übersicht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

4.2 Menü . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

4.3 Symbolleiste . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

4.4 Phasor Measurement Unit (PMU) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

4.5 Berechnete Werte (Calculated measurements)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

4.6 Grafische Darstellung von Stromnetzen (Graphics) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

4.6.1 Übersicht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

4.6.2 Eigenschaften der Elemente . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

4.6.3 Elementtypen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

4.7 Applikationen (Applications) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118

4.7.1 Übersicht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118

4.7.2 Inselerkennung (Island State Detection ISD)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

4.7.3 Schwingungserkennung (Power Swing Recognition PSRs) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

4.7.4 Spannungsstabilitätskurve (Voltage-Stability Curve VSC). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

4.8 Kommunikation (Communication) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

4.8.1 Übersicht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

4.8.2 Protokoll C37.118  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

4.8.3 ICCP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

4.8.4 OPC. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

4.9 Gemeinsame Funktionen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

5 Mit SIGUARD PDP Engineer arbeiten. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155

5.1 Übersicht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156

5.2 Beispiel: Projekt, PMU  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157

5.3 Beispiel: Berechnete Werte. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165

Literatur. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169

Glossar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Stichwortverzeichnis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

6

http://siemens-russia.com/


1 SIGUARD PDP Systemübersicht

1.1 Übersicht 8

1.2 Leistungsmerkmale 12

1.3 Konfigurationsbeispiel 14

1.4 Power System Status berechnen 15

1.5 SIGUARD PDP Pendelerkennung (PSR) 19
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

7

http://siemens-russia.com/


SIGUARD PDP Systemübersicht
1.1 Übersicht
1.1 Übersicht
.

SIGUARD PDP (Phasor Data Processing) ist eine Software zur Zustandsüberwachung der Energieübertra-
gung in weitverzweigten Energienetzen. Eine Annäherung an kritische Zustände (Frequenzstabilität, Span-
nungsstabilität, Übertragungsstabilität, Pendelung) wird frühzeitig erkannt und angezeigt. Die Schwelle, ab der 
ein kritischer Zustand erreicht wird und ein Eingreifen erforderlich ist, kann definiert und nachträglich jederzeit 
geändert werden.

Außerdem unterstützt Sie SIGUARD PDP bei der Analyse des Energienetzes. 

SIGUARD PDP arbeitet mit PMUs (Phasor Measurement Units) zusammen. Diese Messgeräte sind in den En-
ergieverteilungsanlagen installiert und an die Strom- und Spannungswandler angeschlossen. Die Zeit der 
PMUs muss über GPS mit einer Genauigkeit von < 5 µs synchronisiert werden. Dadurch sind die PMUs in der 
Lage, die Messwerte mit Betrag und Phase als Phasoren (Zeigerwerte) hochpräzise zu erfassen und über die 
Kommunikationsschnittstelle zu senden. Diese zeitsynchronisierten Messwerte aus regional weitverteilten 
Messstellen können mit SIGUARD PDP zusammengefasst und ausgewertet werden.

Software-Komponenten 

SIGUARD PDP besteht aus 5 Software-Komponenten. Sie können auf einem Rechner laufen, aber auch auf 
mehrere Rechner verteilt sein. Wenn die Komponenten auf mehrere Rechner verteilt sind, kommunizieren sie 
per SSI (SIGUARD Service Interface) miteinander. Voraussetzung für SSI ist eine funktionierende TCP (Trans-
mission Control Protocol)-Verbindung.

Die Software-Komponenten von SIGUARD PDP sind:

• SIGUARD PDP Server mit SIGUARD PDP Archive
Der SIGUARD PDP Server sammelt die Informationen der PMU-Geräte und stellt sie den anderen Kom-
ponenten zur Verfügung. Der SIGUARD PDP Server legt die Informationen (Messwerte, Ereignisse und 
Warnmeldungen) in einem Ringarchiv ab und stellt sie weiterverarbeitenden Komponenten, zum Beispiel 
SIGUARD PDP UI, zur Verfügung. Für die Kommunikation mit den Geräten wird das Protokoll IEEE 
C37.118 genutzt.

• SIGUARD PDP ISD (Island Detection)
Diese Komponente wertet Frequenzabweichungen aus und erkennt dadurch die Bildung einer Insel inner-
halb des Netzes.

• SIGUARD PDP PSR (Power Swing Recognition)
Diese Komponente erkennt Wirkleistungsschwingungen im Netz. Es werden die Parameter der Wirkleis-
tung bzw. der Spannungswinkeldifferenz, die proportional zur Wirkleistung ist (Frequenz, Amplitude, 
Dämpfung und Kritikalität), für mehrere Schwingungen (Moden) betrachtet und ausgewertet. In einem 
Übersichtsdiagramm wird eine Schwingung mit farbigen Punkten markiert, in der Landkarte mit kreisför-
migen Flächen dargestellt.

• SIGUARD PDP COM (Communication)
- C37.118

Diese Komponente leitet die Daten und Informationen über eine IEEE C37.118-Verbindung an ein 
anderes PDP-System (z.B. ein zweites SIGUARD PDP) weiter.

- ICCP

Mit dem Inter-Control Center Communication Protocol können Informationen von SIGUARD PDP an 
ein SCADA-System weitergeleitet werden, um die Daten dort dem Netzführungspersonal darstellen 
zu können und die Daten in den höherwertigen Funktionen des Leitsystems (EMS) weiterverarbeiten 
zu können.

- OPC

Mit dieser Komponente wird ein OPC DA-Server (V3) zur Verfügung gestellt. Ausgewählte Informati-
onen von SIGUARD PDP können von OPC-Clients ausgelesen und weiterverarbeitet werden.
SIGUARD PDP Phasor Data Processing, Handbuch
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1.1 Übersicht
• SIGUARD PDP UI (User Interface)
Diese Komponente ist die Benutzeroberfläche von SIGUARD PDP. Mit ihr können Sie die Informationen 
anzeigen und analysieren.

• SIGUARD PDP Engineer
Diese Komponente ist das Parametrier-Tool von SIGUARD PDP.

Empfehlung: Installieren Sie SIGUARD PDP Server auf einem Serverrechner, zum Beispiel im Serverraum mit 
gesicherter Stromversorgung, und richten Sie darauf auch das Archiv ein. Installieren Sie SIGUARD PDP UI 
auf einem anderen Rechner. 

Bild 1-1 Software-Komponenten von SIGUARD PDP

SIGUARD PDP UI (User Interface)

Die SIGUARD PDP-Benutzeroberfläche besteht aus mehreren Oberflächenkomponenten: 

• Menü und Symbolleiste
Über das Menü und die Symbolleiste können Sie allgemeine Funktionen aufrufen.

• PSS Curve (Power System Status)
In dieser Oberflächenkomponente wird der zusammengefasste Status des gesamten gemessenen oder 
beobachteten Energienetzes dargestellt. Eine Überschreitung der kritischen Schwelle wird farbig gekenn-
zeichnet.

• SIGUARD PDP UI - Map
In dieser Oberflächenkomponente wird die Topologie des Energienetzes auf einer Landkarte dargestellt. 
Objekte in einem kritischen Zustand werden farbig gekennzeichnet:
SIGUARD PDP Phasor Data Processing, Handbuch
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- Inselerkennung als Flächen zwischen den Stationen

- Schwingungserkennung als kreisförmige Flächen um die Stationen

• Chart View
In dieser Oberflächenkomponente werden die detaillierten Kurven einzelner Messwerte oder berechneter 
Werte über einen definierten Zeitbereich dargestellt. Mithilfe dieser Diagramme können Sie das Energie-
netz analysieren.

• Measurements, applications and formulas
In dieser Oberflächenkomponente sind die Messstellen, Anwendungen, Formeln und Statistiken aufgelis-
tet. Aus diesen Listen heraus können Sie Diagramme erstellen.

• Event list, Alarm list
In dieser Oberflächenkomponente werden Ereignisse und Warnmeldungen aufgelistet.

• Power Swing Analysis
In dieser Oberflächenkomponente werden PSR-Aufträge für die Stationen im Netz mit dem dazugehören-
den Phasenwinkel und PSR-Modi aufgelistet.

Bild 1-2 SIGUARD PDP UI, Hauptfenster

• Limit Editor
Im Limit Editor definieren Sie für die einzelnen Messstellen des Energienetzes die Grenzwerte/Schwel-
len, die bei der Bewertung berücksichtigt werden sollen.
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011
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Bild 1-3 SIGUARD PDP, Limit Editor

SIGUARD PDP Engineer

Mit SIGUARD PDP Engineer konfigurieren Sie das komplette SIGUARD PDP-System. Dazu können Sie 
PMUs, berechnete Werte, die grafische Anzeige, Anwendungen und die Datenverteilung in jeweils separaten 
Fenstern konfigurieren. 

Bild 1-4 SIGUARD PDP, SIGUARD PDP Engineer
SIGUARD PDP Phasor Data Processing, Handbuch
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1.2 Leistungsmerkmale  
.

SIGUARD PDP ist eine eigenständige Software und läuft unabhängig von anderen Anwendungen.

Datenmenge

SIGUARD PDP verarbeitet die Daten von bis zu 4000 Messkanälen (zum Beispiel Phasoren, analoge/digitale 
Messwerte) und 1000 berechneten Größen. 

Die Messwerte können von PMU-Geräten oder von PMUs von Fremdherstellern stammen. Die Geräte müssen 
das Kommunikationsprotokoll IEEE C37.118 beherrschen. An den SIGUARD PDP-Rechner können maximal 
100 PMUs angeschlossen werden.

Eine freie Festplattenkapazität für das Ringarchiv von ca. 14 GB ist bei folgender Konfiguration erforderlich: 

• 64 Kanälen (zum Beispiel 8 PMUs mit je 8 Kanälen)

• Einer Wiederholrate von 10 Werten pro Sekunde (Reporting rate)

• Einer Speicherdauer von 7 Tagen

Für die Speicherung von Ereignissen, Warnmeldungen und Zeitbereichen ist eine zusätzliche Festplattenka-
pazität erforderlich.

Die Performance von SIGUARD PDP kann verbessert werden, indem das Archiv auf einer separaten Festplat-
te auf dem SIGUARD PDP Server eingerichtet wird. Die Performance kann noch weiter verbessert werden, 
indem Sie das Ringarchiv und das Permanentarchiv auf unterschiedlichen Festplatten einrichten.

Das Archiv ist als Ringarchiv konzipiert und kann die Daten über einen Zeitraum von zum Beispiel 7 Tagen 
speichern. Nach Ablauf der 7 Tage werden die ältesten Daten überschrieben. Archivierte Daten können Sie 
dauerhaft im Permanentarchiv speichern oder in eine CSV-Datei exportieren und anschließend weiterverarbei-
ten.

SIGUARD PDP UI

An einem SIGUARD PDP Server können bis zu 8 SIGUARD PDP UI betrieben werden. Die zugehörigen Li-
zenzen müssen vorliegen.

Zeitsynchronisation

Für die Zuordnung von simultan an weit voneinander entfernten Orten erfassten Messwerten müssen die 
Messwerte über einen genauen Zeitstempel verfügen. Deshalb müssen alle angeschlossenen Geräte über 
eine genaue Zeitbasis verfügen. Für SIGUARD PDP selbst ist keine hochgenaue Zeitbasis erforderlich. Sie 
können den SIGUARD PDP-Rechner aber zum Beispiel mittels GPS-/DCF77-Zeitzeichenempfänger der Firma 
Hopf oder NTP (Network Time Protocol) synchronisieren. Damit sind dann auch die vom SIGUARD PDP-
Rechner über NTP vergebenen Zeitstempel, zum Beispiel der Kommunikationsüberwachung, zeitlich hochge-
nau. Weiterhin können zeitlich falsch synchronisierte Messgeräte, zum Beispiel Messgeräte mit Lokalzeit statt 
UTC (Universal Time Coordinated), erkannt werden.

Schnittstellen

Die PMUs sind über Ethernet (wahlweise TCP oder UDP User Datagram Protocol) und das Kommunikations-
protokoll IEEE C37.118 mit dem SIGUARD PDP-Rechner verbunden.
SIGUARD PDP Phasor Data Processing, Handbuch
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Funktionsüberwachung

SIGUARD PDP überwacht: 

• die Kommunikation zwischen den SIGUARD PDP-Software-Komponenten

• die Kommunikation zu den Geräten

• die Funktion wichtiger Software-Komponenten

Ereignisse und Warnmeldungen werden gespeichert und können als Listen angezeigt werden (siehe 
2.7.1 Übersicht).
SIGUARD PDP Phasor Data Processing, Handbuch
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1.3 Konfigurationsbeispiel 
.

Das unten gezeigte Konfigurationsbeispiel enthält die Komponenten:

• PMU
Die PMU-Geräte sind an den strategisch wichtigen Punkten des Energienetzes installiert und liefern die 
Messwerte.

• SIGUARD PDP Server
SIGUARD PDP Server sammelt die Daten der PMU-Geräte, legt sie in einem Archiv ab und stellt sie z.B. 
dem SIGUARD PDP UI zur Verfügung. 

• SIGUARD PDP UI (User Interface)

Mit SIGUARD PDP UI stellen Sie die archivierten Daten dar und analysieren sie. Auf einen SIGUARD 
PDP Server können gleichzeitig mehrere SIGUARD PDP UI zugreifen. 

In dem Beispiel befinden sich die PMU-Geräte in 2 lokalen Netzwerken (LAN - Local Area Network). Über ein 
WAN (Wide Area Network) sind diese mit einem lokalen Netzwerk auf Büroebene verbunden.

Bild 1-5 Systemkonfiguration mit SIGUARD PDP, Beispiel
SIGUARD PDP Phasor Data Processing, Handbuch
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1.4 Power System Status berechnen

1.4.1 Übersicht
.

Alle Messwerte eines Systems werden von SIGUARD PDP UI durch einen Algorithmus ausgewertet und in 
einer Weise analysiert, die es erlaubt, den Zeitpunkt einer Störung zu erkennen. Die Messwerte werden gra-
fisch durch die Power System Status-Kurve (PSS-Kurve) dargestellt. Der Zeitbereich für die Analyse kann be-
liebig gewählt werden.

Bild 1-6 PSS-Kurve mit kritischen Messwerten (rote Kurve)

Der Algorithmus kombiniert die Messwerte nach bestimmten Kriterien und errechnet daraus die Anzeigenhöhe.

Der Algorithmus bewertet dazu folgende Fragestellungen:

• Wie groß ist der Abstand der einzelnen Messwerte zum eingestellten Grenzwert?

• Wie viele Messwerte sind bis zu einer bestimmten Grenze an den Grenzwert herangekommen?

• Wie ist die Wichtigkeit der Messwerte im Vergleich zu anderen Messwerten definiert (PSS-Faktor)?

• Wie viele Messwerte weichen vom eingestellten Grenzwert ab?

Wenn der eingestellte Grenzwert von der Kurve überschritten wird, wird sie als kritisch angezeigt (rote Kurve, 
rot hinterlegt).

Weitere Informationen zur Berechnung der PSS-Kurve erhalten Sie im Kapitel 1.4.3 Berechnungen.

1.4.2 Konfiguration der Messwertbewertung
.

Die Parameter der Messstellen sind für die Berechnung der PSS-Kurve erforderlich. Diese können mit dem 
SIGUARD PDP Engineer konfiguriert werden:

• Betrag eines Phasors oder eines analogen Wertes

• Nennwert

• 1 bis 3 obere Grenzwerte (H1 bis H3)

• 1 bis 3 untere Grenzwerte (L1 bis L3)

• Gewichtung (PSS-Faktor)

 HINWEIS

Um die Berechnung der PSS-Kurve durchführen zu können, müssen mindestens der Nennwert und ein Grenz-
wert angegeben sein. Hierbei muss gelten: H1 < H2 < H3 und L3 < L2 < L1.

 

Die Angabe der Grenzwerte bezieht sich auf den Nennwert. Die aktuellen Messwerte werden mit den Grenz-
werten verglichen.
SIGUARD PDP Phasor Data Processing, Handbuch
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Die verschiedenen Grenzwerte haben bezüglich des Nennwertes unterschiedliche Bedeutung:

Bild 1-7 Grenzwerte und kritische Bereiche
(1) Grenzwert H3
(2) Grenzwert H2
(3) Grenzwert H1
(4) Nennwert
(5) Grenzwert L1
(6) Grenzwert L2
(7) Grenzwert L3

• Messwerte zwischen H1 und L1 befinden sich im normalen Arbeitsbereich

• Messwerte zwischen H1 und H2 oder L1 und L2 befinden sich im bedenklichen Arbeitsbereich

• Messwerte zwischen H2 und H3 oder L2 und L3 befinden sich im kritischen Arbeitsbereich.

 HINWEIS

Immer nur 1 Alarm steht an. Wenn der Wert die Grenze von H1 nach H2 überschreitet, gibt es 2 Ereignisse: 
H1 gehend und H2 kommend.

 

SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

16

http://siemens-russia.com/


SIGUARD PDP Systemübersicht
1.4 Power System Status berechnen
1.4.3 Berechnungen
.

Die Berechnung der PSS-Kurve erfolgt nach einem bestimmten Algorithmus in 5 Schritten.

Schritt 1: Normierung der gemessenen Werte auf ihren Grenzwert

Ein Messwert wird auf seine oberen und unteren Grenzwerte (Bänder) normiert. Dieser normierte Wert wird als 
Prozentzahl dargestellt. Die Prozentzahl gibt an, wie hoch das entsprechende Band belastet ist.

• Für Messwerte größer dem Nennwert gilt: 

0 % = aktueller Messwert liegt unterhalb des Bandes. 

100 % = aktueller Messwert ist größer oder gleich der Obergrenze des Bandes

Normierter Wert X = (Aktueller Wert – Banduntergrenze)/(Bandobergrenze – Banduntergrenze)

• Für Messwerte kleiner dem Nennwert gilt:

 0 % = aktueller Messwert liegt oberhalb des Bandes. 

100 % = aktueller Messwert ist kleiner oder gleich der Untergrenze des Bandes

Normierter Wert X = (Aktueller Wert – Bandobergrenze)/(Bandobergrenze – Banduntergrenze) 

Beispiel: 

Der PSS-Wert soll aus den drei Messwerten M1, M2 und M3 gebildet werden. Dabei sind die momentanen 
Werte M1 = 157, M2 = 120 und M3 = 135. 

Tabelle 1-1 Normierung der gemessenen Werte auf ihren Grenzwert

In diesem Beispiel sind nur der Nennwert und 3 obere Grenzwerte H1 bis H3 definiert. Mit den Messwerten M1 
bis M3 wird der normierte Wert XM1 bis XM3 als Prozentwert dargestellt.

• Der 1. Messwert M1 (157) liegt zwischen den oberen Grenzwerten H2 (150) und H3 (160). Da der nor-
mierte Wert XM1 größer ist als der Nennwert berechnet er sich aus:

X = (Aktueller Wert – Banduntergrenze H2)/(Bandobergrenze H3 – Banduntergrenze H2) = (157 – 150) / 
(160 – 150) = 7 / 10 = 0,7000 

Das Band zwischen H2 und H3 ist belastet mit 70,00 %  

• Der 2. Messwert M2 (120) liegt zwischen dem Nennwert und dem oberen Grenzwert H1 (130). Da der 
normierte Wert XM2 größer ist als der Nennwert berechnet er sich aus:

X = (Aktueller Wert – Banduntergrenze N)/(Bandobergrenze H1 – Banduntergrenze N) = (120 – 100) / 
(130 – 100) = 20 / 30 = 0,6667 

Das Band zwischen dem Nennwert und H1 ist belastet mit 66,67 %

• Der 3. Messwert M3 (135) liegt zwischen den oberen Grenzwerten H1 (130) und H2 (150). Da der nor-
mierte Wert XM3 größer ist als der Nennwert berechnet er sich aus:

X = (Aktueller Wert – Banduntergrenze H1)/(Bandobergrenze H2 – Banduntergrenze H1) = (135 – 130) / 
(150 – 130) = 5 / 20 = 0,25 

Das Band zwischen H1 und H2 ist mit 25,00 % belastet.

Diese Prozentwerte gehen in die weitere Berechnung der PSS-Kurve ein.

 M1  XM1 M2  XM2 M3  XM3 GDB

H3 160 H3 - H2 70,00 % 160 < H2 0 % 160 < H2 0 % 23,33 %
H2 150 > H2 100 % 150 < H1 0 % 150 H2 - H1 25,00 % 41,67 %
H1 130 > H1 100 % 130 H1 - N 66,67 % 130 > H1 100 % 88,89 %
Nennwert 100   100   100    
Aktueller Messwert 157   120   135    
SIGUARD PDP Phasor Data Processing, Handbuch
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Schritt 2: Globaler Durchschnitt je Band (GDB)

GDB = Summe aller (WertB * Gewicht) / (Summe der Gewichte)

GDB = (XM1 + XM2 + XM3) / 3

Im Beispiel sind die Gewichte der Messwerte (PSS-Faktor) = 1.

In Tabelle 1-1 sind die drei Werte GDB für die drei Bänder berechnet, zum Beispiel im Band H3: GDB = (70 % 
+ 0 % + 0 %) / 3 = 23,33 %.

Schritt 3: Bestimmung des Lokalen Maximums (LM)

Der größte Wert im höchsten Band bestimmt das Lokale Maximum.

Im Beispiel: XM1

Tabelle 1-2 Bestimmung des Lokalen Maximums

 HINWEIS

Wenn im höchsten Band H3 alle Werte 0 % sind, bestimmt der höchste Wert (abweichend von 0%) im zweit-
höchsten Band H2 das Lokale Maximum.

 

Schritt 4: Berechnung des Durchschnitts zwischen GDB und LM

Eine einzelne Störung soll sich auch im globalen Maximum bemerkbar machen.

TB = (LMB + GDB) / 2

Tabelle 1-3 Bestimmung des Lokalen Maximums

Schritt 5: Berechnung des Globalen Indikators

Der Globale Indikator ist der Durchschnittswert der Summe von TB aller Bänder und berechnet sich wie folgt:

(TB(H1) + TB(H2) + TB(H3)) / 3 = 70,65 %

Bei Überschreitung des Grenzwertes von 60 %, wie im Beispiel, wird die PSS-Kurve rot dargestellt und mit 
einer roten Fläche hinterlegt. Die rote Einfärbung stellt den kritischen Bereich dar.

 HINWEIS

Der Algorithmus zur Berechnung der PSS-Kurve ist zum Patent angemeldet.

 

 XM1 XM2 XM3

H3 70,00 % 0 % 0 %
H2 100 % 0 % 25 %
H1 100 % 66,67 % 100 %

 XM1 GDB TB

H3 70,00 % 23,33 % 46,67 %
H2 100 % 41,67 % 70,84 %
H1 100 % 88,89 % 94,45 %
SIGUARD PDP Phasor Data Processing, Handbuch
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1.5 SIGUARD PDP Pendelerkennung (PSR)
.

Die SIGUARD PDP Pendelerkennung (PSR = power swing recognition) kann Wirkleistungspendelungen im 
Netz erkennen, bewerten und zur Anzeige bringen. Auf diese Weise werden kritische Pendelungen im Ener-
gieversorgungsnetz automatisch erkannt und gemeldet.

Die SIGUARD PDP Pendelerkennung kann gleichzeitig mehrere PSR-Aufträge (Jobs) ausführen. Es gibt  2 
verschiedene Auftragsarten, die sich hinsichtlich der Einganggrößen unterscheiden:

• Winkeldifferenz zweier Spannungsphasoren, die an 2 verschiedenen Stellen im Netz gemessen werden 
(s.a. UI: Phase Angle Difference). 

Für diese Variante sind 2 Phasor Measurement Units (PMU) erforderlich, die jeweils mindestens Span-
nungszeiger liefern.

• Wirkleistung, die an einer Stelle im Netz als Produkt von Spannungsphasor und Stromphasor gemessen 
wird (s.a. UI: Active Power).
Dafür ist eine PMU erforderlich, die Spannungs- und Stromzeiger liefert.

Je nach der gewählten Eingangsgröße und der zugehörigen PMU-Kombination werden verschiedene Jobs zur 
Pendelerkennung definiert. Die PSR führt diese Jobs zeitgleich aus.

Die als Winkeldifferenz oder als Wirkleistung bestimmten Eingangssignale werden zum Vergleich mit den spä-
teren Ergebnissen der Pendelerkennung kontinuierlich zum PDP-Server zurückgeschrieben, um sie zur spä-
teren Analyse von Pendelvorgängen im SIGUARD PDP UI anzeigen zu können. Innerhalb der PSR werden 
diese Werte über vorgewählte Zeitbereiche akkumuliert. Diese Werte werden bei Vollständigkeit der Daten in 
den Frequenzbereich transformiert, um hier die für den beobachteten Pendelvorgang charakteristischen Fre-
quenzen zu erkennen. Da gleichzeitig mehrere Frequenzen angeregt sein können, kann die PSR mehrere 
Moden gleichzeitig identifizieren und berechnen. Die maximale Anzahl der erwarteten Moden und ihre typi-
schen Frequenzbereiche werden im SIGUARD Engineer definiert.

Für jede Anregungsfrequenz wird der aktuelle Wert der Amplitude berechnet. Je nach Pendelfrequenz muss 
über einen längeren Zeitraum gemessen werden. Daher können bei den für Pendelungen typischen auf- oder 
abklingenden Verläufen Fehler entstehen.

Eine für die möglichen Auswirkungen wesentliche Kenngröße ist der auf die Pendelfrequenz bezogene Dämp-
fungsfaktor ξ (zeta), im Folgenden vereinfachend als Dämpfung bezeichnet. Die Größe ist dimensionslos und 
nachfolgend in Prozent angegeben. Sie gibt – unabhängig von der Frequenz der Pendelung – ein relatives Maß 
für die Amplitudenänderung der Pendelung von einem beliebigen Maximum zum nächsten wieder.

Eine negative Dämpfung ξ ist hierbei charakteristisch für eine in der Amplitude abklingende Pendelung. Das 
folgende Bild zeigt zur Veranschaulichung einen entsprechenden Zeitverlauf der Amplitude.

Bild 1-8 Anregung einer nachfolgend abklingenden Pendelung für einen Job vom Typ Active Power
SIGUARD PDP Phasor Data Processing, Handbuch
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Die Dämpfung ξ der gezeigten Pendelung liegt bei -10 %. Die Frequenz liegt bei 1,2 Hz.

Eine Leistungspendelung mit einer Dämpfung ξ unterhalb von -5 % wird bei nicht zu großer Amplitude als un-
kritisch betrachtet.

 HINWEIS

Achten Sie besonders auf Pendelereignisse mit einer Dämpfung oberhalb von -3 %, da weitere Anregungen 
im Netz zu einem schnellen Anwachsen der Amplitude führen können.

 

Ungedämpfte Pendelungen sind besonders kritisch. Eine Dämpfung von 0 % entspricht hierbei einer zeitlich 
unverändert anstehenden Amplitude. Zunehmend positive Werte gehen mit einem immer steiler über die Zeit 
ansteigenden Verlauf der Amplitude einher. Das folgende Bild zeigt beispielhaft eine Pendelung für dieses Ver-
halten.

Bild 1-9 Aufklingende Pendelung für einen Job vom Typ Phase Angle Difference

Die Dämpfung ξ der gezeigten Pendelung liegt bei +10 %. Die Frequenz liegt bei 0,2 Hz.

Um die Auswirkungen eines Pendelereignisses zu beurteilen, wird aus der Dämpfung ξ (Damping Ratio) unter 
Berücksichtigung der aktuellen Pendelamplitude Â (Magnitude) eine Kenngröße ermittelt, die das Gefähr-
dungspotenzial charakterisiert. Diese Kenngröße wird im Folgenden als DOE (Degree of Exposure) bezeich-
net. Mit der Zunahme von Dämpfungsfaktor und Pendelamplitude geht eine Gefährdung einher. Diese Gefähr-
dung zeigt sich in einem ebenfalls ansteigenden Wert des DOE. Das folgende Bild zeigt die Ermittlung des 
DOE-Wertes.
SIGUARD PDP Phasor Data Processing, Handbuch
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1.5 SIGUARD PDP Pendelerkennung (PSR)
Bild 1-10 Berechnung des DOE

Der Berechnung des DOE liegen Grenzen von Dämpfung (Damping Ratio Limits) und Amplitude (Magnitude 
Limits) zugrunde. Diese Grenzen werden im SIGUARD Engineer (siehe Kapitel 4.7.3 Schwingungserkennung 
(Power Swing Recognition PSRs)) für jeden Job festgelegt.

■
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E50417-H1000-C419-A3, Ausgabe 11.2011

21

http://siemens-russia.com/


SIGUARD PDP Systemübersicht
1.5 SIGUARD PDP Pendelerkennung (PSR)
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2.1 Übersicht
2.1 Übersicht
.

Die Programmoberfläche von SIGUARD PDP besteht aus folgenden Oberflächenkomponenten:

• Menü und Symbolleiste
Über das Menü und die Symbolleiste können Sie allgemeine Funktionen aufrufen (siehe 2.2 Menü und 
Symbolleiste).

• PSS Curve
In dieser Oberflächenkomponente wird der zusammengefasste Status des gesamten gemessenen oder 
beobachteten Energienetzes als Power System Status dargestellt.

• SIGUARD PDP UI - Map
In dieser Oberflächenkomponente wird die Topologie des Energienetzes auf einer Landkarte dargestellt.

• Chart View
In dieser Oberflächenkomponente werden die detaillierten Kurven einzelner Messwerte oder berechneter 
Werte über einen definierten Zeitbereich dargestellt.

• Measurements, applications and formulas
In dieser Oberflächenkomponente sind folgende ein- und ausblendbare Listen vorhanden:

- Verwendete Messstellen

- Alle verfügbaren Messstellen

- Vordefinierte Formeln

- Spannungsstabilitätskurven

- Statistiken

Weitere Informationen hierzu erhalten Sie im Kapitel Messwerte, Anwendungen und Formeln.

• Event list, Alarm list
In dieser Oberflächenkomponente werden Ereignisse und Warnmeldungen aufgelistet.

• PSR Analysis
In dieser Oberflächenkomponente werden PSR-Aufträge für die Stationen im Netz mit den dazugehören-
den Phasenwinkel und PSR-Modi aufgelistet.

Die Größe und Anordnung der Oberflächenkomponenten können Sie nach Ihren Bedürfnissen verändern, 
siehe 2.8 Programmoberfläche gestalten. 
SIGUARD PDP Phasor Data Processing, Handbuch
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2.1 Übersicht
Bild 2-1 Schematische Darstellung der Benutzeroberfläche
SIGUARD PDP Phasor Data Processing, Handbuch
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2.2 Menü und Symbolleiste
2.2 Menü und Symbolleiste

Menüeinträge

Über das Menü können Sie folgende Funktionen aufrufen:

• File > Save to CSV...
Mit diesem Menüeintrag speichern Sie die Messwerte des aktuellen Zeitbereichs als CSV-Datei, siehe 
2.10 Berichterstellung.

• File > Save time range...
Mit diesem Menüeintrag speichern Sie die Messwerte des aktuellen Zeitbereichs im Permanentarchiv, 
siehe 3.4.1 Export von Zeitbereichen. 

• File > Load time range...
Mit diesem Menüeintrag laden Sie die Messwerte eines zuvor gespeicherten Zeitbereichs aus dem Per-
manentarchiv, siehe 3.4.2 Import von Zeitbereichen. 

• File > Delete time range...
Mit diesem Menüeintrag löschen Sie die Messwerte eines zuvor gespeicherten Zeitbereichs im Perma-
nentarchiv, siehe 3.4.3 Löschen von Zeitbereichen.

• File > Exit
Mit diesem Menüeintrag beenden Sie SIGUARD PDP UI.

• Help > Contents...
Mit diesem Menüeintrag rufen Sie das Online-Handbuch auf.

• Help > Index
Mit diesem Menüeintrag rufen Sie die Online-Hilfe auf. In ihr ist die Funktionalität von SIGUARD PDP be-
schrieben. Außerdem enthält Sie Anleitungen zur Arbeit mit den verschiedenen Komponenten von 
SIGUARD PDP.

• Help > About SIGUARD PDP UI...
Mit diesem Menüeintrag fragen Sie die aktuelle SIGUARD PDP UI-Programmversion ab. 

Symbolleiste

Über die Symbolleiste des Hauptfensters können Sie folgende Funktionen aufrufen: 

Tabelle 2-1 Symbolleiste Hauptfenster

Symbol Erklärung
Klicken Sie auf dieses Symbol, um eine neue Diagrammansicht (Chart 
View) zu öffnen.

Klicken Sie auf dieses Symbol, um die Landkarte SIGUARD PDP UI - 
Map anzuzeigen.

Klicken Sie auf dieses Symbol, um eine neue Ereignisliste zu öffnen.

Klicken Sie auf dieses Symbol, um eine neue Warnmeldeliste zu 
öffnen.

Klicken Sie auf dieses Symbol, um die Oberflächenkomponente Power 
Swing Analysis zu öffnen. 

Klicken Sie auf dieses Symbol, um die aktuelle Benutzeroberfläche als 
Favorit zu speichern.
SIGUARD PDP Phasor Data Processing, Handbuch
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2.2 Menü und Symbolleiste
Status der Grenzwerte 

Unterhalb der Menüleiste befindet sich eine Leiste mit der Bezeichnung PSS Curve. Die Einfärbung dieser 
Leiste zeigt den Status der Grenzwerte an.

• Grau
Alle eingegebenen Grenzwerte sind wirksam und werden bei der Anzeige berücksichtigt.

• Orange
Mindestens ein Grenzwert wurde geändert. Die Änderung ist auf dem lokalen Rechner, aber nicht im Ge-
samtsystem wirksam. Informationen zur Eingabe von Grenzwerten finden Sie in Abschnitt 2.9 Limit Editor.

• Pink
SIGUARD PDP UI hat die Verbindung zum SIGUARD PDP Server verloren. Warten Sie auf Wiederher-
stellung der Verbindung oder kontaktieren Sie den Administrator des Servers.

Im Texteingabefeld wird der gewählte Favorit angezeigt. Die Auswahl-
liste zeigt alle gespeicherten Favoriten an. 

Klicken Sie auf dieses Symbol, um einen Favoriten zu löschen.

Symbol Erklärung
SIGUARD PDP Phasor Data Processing, Handbuch
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2.3 Power System Status
2.3 Power System Status
.

Im Fensterbereich Power System Status sehen Sie eine Kurve, die den Zustand des kompletten Energienet-
zes anzeigt. Die Kurve kann aus allen zur Verfügung stehenden Messwerten, für die Grenzwerte definiert sind, 
errechnet werden, siehe 1.4.1 Übersicht. Sie können im Tool SIGUARD PDP Engineer parametrieren, welche 
Messwerte in die Berechnung eingehen, siehe 4.4 Phasor Measurement Unit (PMU). Die Kurve wird aus den 
gewichteten Abständen der Messwerte zu ihren Grenzwerten berechnet.

Den dargestellten Zeitbereich der Kurve können Sie festlegen. Er ist in definierte Zeitschritte, zum Beispiel 
Stunden, unterteilt. Am rechten Ende des Diagramms ist der aktuelle Wert dargestellt.

Aktuelle Werte darstellen 

So stellen Sie die aktuellen Werte dar:

✧ Klicken Sie rechts neben dem Diagramm auf die Schaltfläche Go online.

Die Kurve wird laufend durch aktuelle Werte ergänzt.

Bild 2-2 Power System Status, aktuelle Werte (Online-Modus)

Der eingestellte Zeitbereich, zum Beispiel Tag, wird als Kurve dargestellt und laufend aktualisiert. Dabei 
werden bereits dargestellte Werte nach links verschoben. Den neuesten Wert sehen Sie auf der rechten Seite.

Wenn noch nicht genügend Werte zur Verfügung stehen, zum Beispiel in der Startphase, ist die linke Seite der 
Kurve leer. Sie wird durch neu eintreffende Werte vervollständigt.

Werte aus der Vergangenheit darstellen 

Zur nachträglichen Analyse können Sie Werte aus der Vergangenheit (Archivwerte) als Kurven in den Fens-
terbereichen PSS Curve und Chart View darstellen.

So stellen Sie Werte aus der Vergangenheit dar:

✧ Klicken Sie rechts neben dem Diagramm auf die Schaltfläche Go offline. 

Die Kurve wird nicht mehr durch aktuelle Werte ergänzt. 

Das Schalten in den Offline-Modus hat nur Auswirkung auf SIGUARD PDP UI. SIGUARD PDP archiviert die 
eingehenden Werte weiter, sie werden in diesem SIGUARD PDP UI aber nicht angezeigt. Sie können auf dem-
selben Rechner eine 2. Instanz von SIGUARD PDP UI starten und damit online bleiben.
SIGUARD PDP Phasor Data Processing, Handbuch
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2.3 Power System Status
Bild 2-3 Power System Status, Offline-Werte

Der ausgewählte Zeitabschnitt wird durch 2 Begrenzungslinien eingestellt. Innerhalb des Zeitabschnittes wird 
ein Cursor angezeigt. Die Begrenzungslinien und den Cursor können Sie mit dem Mauszeiger auf der Zeit-
achse verschieben.

Ausgewählte Werte, zum Beispiel Spannung oder Leistung dieses Zeitabschnitts können Sie im Fensterbe-
reich Chart View vergrößert darstellen.

Die Lage des Cursors im Zeitabschnitt hat folgende Auswirkungen:

• Seine zeitliche Lage wird automatisch auf die Cursors in den Liniendiagrammen übertragen. 

• Sowohl Phasoren in Vektordiagrammen als auch Stabilitätskurven werden für den mit dem Cursor be-
stimmten Zeitpunkt angezeigt.

• In der Oberflächenkomponente SIGUARD PDP UI - Map wird der Zustand der Objekte abhängig von der 
Lage des Cursors angezeigt. 

• In der Ereignisliste wird eine schwarze horizontale Linie angezeigt, die den Bereich der bereits einge-
gangenen Ereignisse von den Ereignissen abtrennt, die vom Cursor aus gesehen in der Zukunft eintreffen 
werden.

• In der Warnmeldeliste werden die  Ereignisse angezeigt, die zu diesem Zeitpunkt anstehend waren.

Einstellmöglichkeiten/Anzeigen 

✧ Ändern Sie die Darstellung der Kurve im Fensterbereich PSS Curve mithilfe der Schaltflächen und Aus-
wahllisten. 

 

In der folgenden Tabelle sind die Einstellmöglichkeiten und Anzeigen des Fensterbereiches PSS Curve erläu-
tert.

Tabelle 2-2 Fensterbereich PSS Curve

Element Erklärung
Aus einem Kalender können Sie das Datum auswählen. 

Aus einer Liste können Sie den Zeitbereich auswählen, der als Kurve 
dargestellt werden soll, zum Beispiel:
• Month (Monat)
• Week (Woche)
• Day (Tag)
• Quarter Day (6 Stunden)
• Hour (Stunde)
• 10 Minutes (10 Minuten)
• Minute
• 10 Seconds (10 Sekunden)

Den dargestellten Zeitbereich können Sie auch mit einem Klick auf die 
Zeitleiste ändern, siehe unten.
SIGUARD PDP Phasor Data Processing, Handbuch
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Mit einem Klick auf die obere Zeile der Zeitleiste vergrößern Sie den dargestellten Zeitbereich, zum Beispiel 
von 1 Minute auf 10 Minuten. 

Mit einem Klick auf die untere Zeile der Zeitleiste verkleinern Sie den dargestellten Zeitbereich, zum Beispiel 
von 1 Stunde auf 10 Minuten.

Bild 2-4 Power System Status, Zeitbereich ändern

1) Mithilfe der oberen Pfeile können Sie bei Offline-Darstellung seiten-
weise vor- und rückwärts durch das Wertearchiv blättern.  
2) Mithilfe der unteren Pfeile können Sie sich in kleinen Schritten vor- 
und rückwärts durch das Archiv bewegen.
Mit dieser Schaltfläche schalten Sie in den Online-Modus. Die aktuellen 
Werte werden als Kurve angezeigt.
Mit dieser Schaltfläche schalten Sie in den Offline-Modus. Werte aus 
dem Archiv werden als Kurve angezeigt. Mit den Pfeilen können Sie 
durch das Archiv blättern.
Nicht kritische Werte des Energienetzes werden im unteren Bereich der 
Anzeige als schwarze Kurve dargestellt.
Kritische Werte des Energienetzes werden im oberen Bereich der 
Anzeige als rote Kurve dargestellt. Je höher der Wert auf der y-Achse 
dargestellt wird, desto kritischer ist er. 
Der kritische Zeitbereich ist hellrot hinterlegt. 
Mit dieser Schaltfläche stellen Sie den Cursor an den Beginn des aus-
gewählten Zeitbereiches. Diese Funktion steht nur im Offline-Modus 
zur Verfügung.
Mit dieser Schaltfläche starten Sie den Ablauf. Die Cursors in den 
Charts bewegen sich automatisch mit. Zusätzlich wird auf der Landkar-
te der Status der Objekte zum jeweiligen Zeitpunkt dargestellt. Diese 
Funktion steht nur im Offline-Modus zur Verfügung.
Mit dieser Schaltfläche stoppen Sie den Ablauf. Diese Funktion steht 
nur im Offline-Modus bei gestartetem Ablauf zur Verfügung.

Mit dieser Schaltfläche starten Sie die Simulation der PSS-Kurve. 
Diese Funktion steht nur zur Verfügung, wenn:
• eine Verbindung zum SIGUARD PDP Server hergestellt ist
• der Offline-Modus eingestellt ist
• Grenzwerte lokal geändert wurden

Element Erklärung
SIGUARD PDP Phasor Data Processing, Handbuch
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Simulation der PSS Curve

Wenn Sie testen möchten, wie sich geänderte Grenzwerte der Messwerte auf die PSS-Kurve auswirken, so 
können Sie eine Simulation der PSS-Kurve dafür durchführen. Damit können Sie die Einstellungen der Grenz-
werte so optimieren, dass die PSS-Kurve die geeignete Empfindlichkeit für Ihr Netz zeigt. Bei der Simulation 
wird angezeigt, wie sich eine Änderung der Grenzwerte auf die PSS-Kurve auswirkt. Die simulierte PSS-Kurve 
wird als rote Linie auf die aktuelle PSS-Kurve (schwarze Linie) gelegt.

Voraussetzungen für die Simulation der PSS-Kurve (Schaltfläche Start simulation ist aktiv):

• Verbindung zum SIGUARD PDP Server ist hergestellt (Statuszeile: Online)

• Offline-Modus ist eingestellt

• Grenzwerte wurden lokal geändert

So simulieren Sie eine PSS-Kurve:

✧ Wählen Sie aus der Liste All measurements einen beliebigen Messwert, z.B. eine Frequenz, aus und 
stellen diese als Diagramm dar.

✧ Zeigen Sie die Grenzwerte für das angezeigte Diagramm an.

✧ Ändern Sie einen oder mehrere Grenzwerte.

 HINWEIS

Speichern Sie Änderungen nicht mit Save limits, da sonst die bisherige PSS-Kurve im System geändert 
würde.

 

✧ Für die Simulation der PSS-Kurve schließen Sie den Dialog zum Ändern der Grenzwerte mit Close.

Die Farbe der PSS-Leiste ändert sich von grau auf orange.

✧ Starten Sie die Simulation durch Klicken auf die Schaltfläche Start Simulation.

Die simulierte PSS-Kurve wird berechnet. Die Original-PSS-Kurve wird als schwarze Linie, die simulierte PSS-
Kurve mit den geänderten Grenzwerten wird als rote Kurve dargestellt.
SIGUARD PDP Phasor Data Processing, Handbuch
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Bild 2-5 PSS-Kurve (Original und simulierte Kurve)
SIGUARD PDP Phasor Data Processing, Handbuch
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2.4 Map
2.4 Map
.

Im Fensterbereich SIGUARD PDP UI - Map ist die Topologie des Energienetzes auf einer Landkarte darge-
stellt. Die einzelnen Objekte/Messstellen des Energienetzes, wie zum Beispiel Generatoren und Leitungen, 
werden durch Symbole gekennzeichnet.

Das auf der Landkarte dargestellte Energienetz können Sie im Tool SIGUARD PDP Engineer parametrieren, 
siehe 4.6.1 Übersicht.

Die Landkarte ist Google Earth entnommen, die Objekte des Energienetzes sind eingeblendet.  Die Navigation 
und die Zoom-Funktionen sind Standardfunktionen von Google Earth. Zusätzlich stehen weitere spezielle 
Funktionen zur Verfügung.

Bild 2-6 Map, Landkarte mit Topologie des Energienetzes

✧ Falls noch keine Landkarte geöffnet ist, klicken Sie auf die Schaltfläche , um die Landkarte anzuzei-
gen.

Google Earth wird gestartet und im Fensterbereich SIGUARD PDP UI - Map eingeblendet.

Der aktuelle Status der Objekte wird farbig dargestellt. Die allgemeine Bedeutung der Farbe ist:

• Blau
Das Objekt befindet sich im Normalbetrieb, die Messwerte für dieses Objekt liegen im definierten Bereich, 
der Status ist ok.

• Gelb
Die Messwerte für dieses Objekt liegen oberhalb des Grenzwertes Max1 oder unterhalb des Grenzwertes 
Min1, der Status ist noch nicht kritisch.

• Rot
Die Messwerte für dieses Objekt liegen oberhalb des Grenzwertes Max2 oder unterhalb des Grenzwertes 
Min2, der Status ist kritisch.

• Grau
Es liegen keine aktuellen Messwerte für dieses graphische Objekt vor.
SIGUARD PDP Phasor Data Processing, Handbuch
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• Nur Umrandung
Es ist kein Messgerät vorhanden.

Eine detailliertere Beschreibung der Bedeutung finden Sie in der nachfolgenden Tabelle.

Einstellmöglichkeiten/Anzeigen  

✧ Ändern Sie die Darstellung der Landkarte im Fensterbereich SIGUARD PDP UI - Map mithilfe der Sym-
bole.

In der folgenden Tabelle sind die Einstellmöglichkeiten und Anzeigen des Fensterbereiches SIGUARD PDP 
UI - Map erläutert. 

Tabelle 2-3 Fensterbereich SIGUARD PDP UI - Map

Element Einstellmöglichkeiten
Klicken Sie in der Symbolleiste von SIGUARD PDP UI auf dieses 
Symbol, um Google Earth zu starten.

Klicken Sie auf dieses Symbol, um mit den Standardfunktionen von 
Google Earth zu navigieren. 
Klicken Sie auf dieses Symbol, um einen Bereich auf der Karte zu mar-
kieren.
Die Messstellen, die innerhalb des markierten Bereiches liegen, 
werden unter Selected measurements aufgelistet.
Klicken Sie auf dieses Symbol, um ein Objekt in die Mitte des Landkar-
tenausschnittes zu bringen.
Durch einen Klick mit dem Mauszeiger auf ein Objekt wird dieses in der 
Mitte des Kartenausschnittes angezeigt.
Wenn Sie in diesem Modus mit dem Mauszeiger auf ein Unterstations-
symbol zeigen, werden die zugehörigen Messwerte in einem Tooltipp 
eingeblendet.
Klicken Sie auf dieses Symbol, um einen ausgewählten Bereich der 
Karte zu vergrößern.

Zoom-Funktion: vergrößern

Zoom-Funktion: verkleinern

Klicken Sie auf dieses Symbol, um die Legende der Objekte aufzublen-
den.
Die Legende ist nachfolgend erklärt.
Leitung
Die angezeigten Farben bedeuten: 
Rot =Die Leitung ist überlastet. 
Gelb =Die Leitung ist stark belastet.  
Gestrichelt =Die Leitung ist außer Betrieb.  
Blau =Die Leitung befindet sich im Normalbetrieb. 
Grau =Die Werte der Leitung werden nicht erfasst. 
Generator
Die angezeigten Farben bedeuten:
Rot =Der Generator ist überlastet. 
Gelb =Der Generator ist stark belastet. 
Blau =Der Generator befindet sich im Normalbetrieb. 
Ungefüllt =Die Werte des Generators werden nicht erfasst.
SIGUARD PDP Phasor Data Processing, Handbuch
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Bild 2-7 Fensterbereich SIGUARD PDP UI - Map mit eingeblendeter Legende

Unterstation
Die angezeigten Farben bedeuten:
Rot =In der Unterstation wurde eine stark vom Nennwert abweichende 
Spannung gemessen. Der Grenzwert  Max2 oder Min2 wurde verletzt.
Gelb =In der Unterstation wurde eine erheblich vom Nennwert abwei-
chende Spannung gemessen.  Der Grenzwert Max1 oder Min1 wurde 
verletzt.
Blau =In der Unterstation wurde eine Spannung im Normalbereich ge-
messen.
Grau =Die Unterstation ist außer Betrieb. 
Ungefüllt =Die Werte der Unterstation werden nicht erfasst.
Kompensator
Die angezeigten Farben bedeuten:
Rot =Der Kompensator ist überlastet.
Gelb =Der Kompensator ist stark belastet. 
Blau =Der Kompensator befindet sich im Normalbetrieb. 
Grau =Der Kompensator ist außer Betrieb.
Gestrichelt =Die Werte des Kompensators werden nicht erfasst.

Element Einstellmöglichkeiten
SIGUARD PDP Phasor Data Processing, Handbuch
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Darstellung der Inselerkennung (ISD) 

Wenn es zu einer Inselbildung zwischen 2 oder mehreren Unterstationen kommt, dann werden erkannte Inseln 
in der Landkarte als farbige Flächen dargestellt. Die Farbskala entspricht der der Diagramme (1. Insel wird 
orange, 2. Insel blau usw. dargestellt).

✧ Öffnen Sie die Ereignisliste.

✧ Filtern Sie die Liste nach Island Detection.

✧ Markieren Sie ein Ereignis, um die dazugehörende Inselbildung darzustellen.

Bild 2-8 Inselbildung zu einem bestimmten Ereignis
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

36

http://siemens-russia.com/


SIGUARD PDP UI
2.4 Map
Darstellung der Schwingungserkennung (PSR) 

Eine erkannte Schwingung im Netz wird in der Landkarte durch rote kreisförmige Flächen um die Unterstatio-
nen dargestellt. Des Weiteren können die kreisförmigen Flächen durch rote rechteckige Flächen verbunden 
sein, falls die Schwingung sich auf mehrere Unterstationen auswirkt.

✧ Öffnen Sie die Ereignisliste.

✧ Filtern Sie die Liste nach Power Swing Recognition.

✧ Markieren Sie ein Ereignis, um die dazugehörende Schwingungserkennung darzustellen.

Bild 2-9 Schwingungserkennung zu einem bestimmten Ereignis

Weitere Informationen zur Analyse der Schwingungserkennung finden Sie im Kapitel 
2.11.3 Schwingungserkennung (Power Swing Recognition PSR).
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2.5 Chart View
.

Im Fensterbereich Chart View können Sie gleichzeitig mehrere Diagrammgruppen anzeigen. Die Diagramm-
gruppen sind durch horizontale Linien voneinander getrennt. Innerhalb einer Diagrammgruppe ist der ange-
zeigte Zeitbereich identisch, das heißt Werte eines Zeitpunktes stehen exakt untereinander. Um die Darstel-
lung der Messwerte zu gruppieren, können Sie mehrere Chart Views öffnen.

Damit die Vergleichbarkeit der Werte untereinander erhalten bleibt, werden die Zeitachsen der Diagramme 
einer Diagrammgruppe immer gleich skaliert. Diagramme in unterschiedlichen Diagrammgruppen können je 
nach Breite der y-Achsenbeschriftung aber leicht unterschiedlich skaliert sein.

Je nachdem, ob Sie eine Messstelle oberhalb oder unterhalb der horizontalen Linie fallen lassen, wird ein 
neues Diagramm innerhalb der Diagrammgruppe angelegt (wenn Sie das Objekt oberhalb der Linie platzieren) 
oder eine neue Diagrammgruppe erstellt (wenn Sie das Objekt unterhalb der Linie platzieren).

Jede Diagrammgruppe kann mehrere Liniendiagramme aber nur ein Vektordiagramm enthalten.

Der Diagrammtyp wird durch den Typ der ersten Kurve bestimmt. Eine analoge Kurve wird in einem Liniendi-
agramm dargestellt, ein Phasor in einem Vektordiagramm. Um den zeitlichen Verlauf des Betrages eines 
Phasor in einem Liniendiagramm ohne weiteren analogen Wert darzustellen, müssen Sie zuerst ein leeres Li-
niendiagramm erzeugen und den Phasor hineinziehen. Ein leeres Liniendiagramm erzeugen Sie mit der 

Schaltfläche .

In jedem Diagramm können Sie mehrere Kurven darstellen. Um in einem bestehenden Diagramm eine weitere 
Kurve darzustellen, ziehen Sie eine Messstelle in das Diagramm. Die Kurve passt sich dem Diagrammtyp an. 
In einem Liniendiagramm wird von einem Phasor nur die Amplitude dargestellt.

Bei Echtzeit-Darstellung bewegen sich die Kurven in einem Liniendiagramm nach links. Neue Werte werden 
auf der rechten Seite angefügt. 

Bild 2-10 Chart View, Darstellung mehrerer Kurven eines Zeitbereiches

In den Diagrammen wird der Zeitbereich dargestellt, der im Fensterbereich PSS Curve mit den Schiebern aus-
gewählt ist. Die Stellung des Cursors auf der Zeitachse entspricht der Stellung des Cursors im Fensterbereich 
PSS Curve.

Im Offline-Modus kann ein zurückliegendes Ereignis wiederholt abgespielt werden, um die zugrundeliegen-
den dynamischen Vorgänge zu analysieren. Dabei läuft ein Cursor durch die Liniendiagramme.
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Parameter der angezeigten Kurven 

Neben oder über dem Diagramm werden die angezeigten Messwerte mit den zugehörigen Einfärbungen auf-
gelistet. Über die Markierung der Kontrollkästchen kann die entsprechende Kurve ein-/ausgeblendet werden.

Durch einen Rechtsklick auf die Diagrammfläche wird ein Kontextmenü aufgeblendet. Die Menüeinträge be-
deuten:

• Signals
Mit diesem Menüeintrag können Sie einzelne Kurven ein-/ausblenden. 

• Copy to Clipboard ...
Mit diesem Menüeintrag können Sie das Diagramm in die Zwischenablage von Microsoft Windows kopie-
ren. 

• Show measure line (nur im Offline-Modus)

Mit diesem Menüeintrag können Sie für eine bestimmte Messstelle eine horizontale Linie einblenden, an 
deren Schnittpunkt mit dem Diagramm der genaue Messwert eingeblendet wird.

• Show second cursor (nur im Offline-Modus)

Mit diesem Menüeintrag können Sie einen 2. Cursor (vertikale Linie) einblenden, an dessen Schnittpunkt 
mit dem Diagramm die Differenz zum ersten Messwert eingeblendet wird.

• Edit limits
Mit diesem Menüeintrag können Sie den Limit Editor für dieses Signal öffnen. Die Grenzwerte werden an-
gezeigt. 

Alternativ können Sie die Grenzwerte einer Kurve durch einen Doppelklick auf den entsprechenden 
Eintrag in der Kurvenauflistung anzeigen. 

• Show average value (nur für Liniendiagramme, keine Formeln)

Mit diesem Menüeintrag wird für jeden Messpunkt der Kurve ein Mittelwert gebildet und die Kurve so ge-
glättet. Die geglättete Kurve wird im Namen mit [Avg] gekennzeichnet.

Einstellmöglichkeiten/Anzeigen  

In der folgenden Tabelle sind die Einstellmöglichkeiten und Anzeigen des Fensterbereiches Chart View erläu-
tert.

Tabelle 2-4 Fensterbereich Chart View

Element Erklärung
Klicken Sie auf dieses Element, um ein leeres Liniendiagramm zu er-
zeugen.

Durch einen Klick auf das linke Element wird die Höhe aller Diagramme 
schrittweise reduziert (für Überblick). 

Durch einen Klick auf das rechte Element wird die Höhe aller Diagram-
me schrittweise vergrößert (für Details).

Durch einen Klick auf dieses Element werden die Durchschnittswerte 
der Kurve angezeigt (glättende Mittelwertsbildung).

Dieses Element ist nur im Online-Betrieb aktiv. Klicken Sie auf dieses 
Element, um einen Dialog zu öffnen, indem Sie die Spur der Vektorspit-
ze ein-/ausschalten und die zeitliche Länge der Vektorspitze verändern 
können. 

Klicken Sie auf dieses Element, um den Editor für alle Grenzwerte zu 
starten.
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Klicken Sie im Limit Editor auf dieses Element, um geänderte Grenz-
werte im Gesamtsystem wirksam zu schalten. Die Farbe der Leiste  
PSS Curve ändert sich von orange auf grau.
Dieses Element ist nur sichtbar, wenn im Limit-Editor ein Grenzwert 
verändert wurde oder wenn der Grenzwert-Editor für eine Einzelkurve 
geöffnet ist. Sie öffnen ihn mit einem Doppelklick auf eine Kurve/einen 
Legendeneintrag.
Klicken Sie auf dieses Element, um den Maßstab der y-Achse zu 
ändern. 

• Achse
Für die ausgewählte Achse sind nachfolgende Eigenschaften einzu-
stellen:

• dynamic
Bei der Einstellung dynamic wird immer automatisch die Skalierung 
der y-Achse so gewählt, dass die dargestellten Kurven mit maxima-
lem Maßstab dargestellt werden.

• maximized
Bei der Einstellung maximized wird die Skalierung so korrigiert, 
dass die dargestellten Kurven mit maximalem Maßstab dargestellt 
werden

• manual
Bei der Einstellung manual wird die Skalierung der Kurven auf die 
eingegebenen Minimal- und Maximalwerte eingestellt.

• zero-alligned
Wird die Null-Ausrichtung markiert, wird die y-Achse ab dem Null-
punkt dargestellt und die Kurven entsprechend neu scaliert.

Dieses El.ement ist nur bei der Einstellung maximized aktiv.
Klicken Sie auf dieses Element, um die Skalierung einmalig so zu kor-
rigieren, dass die dargestellten Kurven mit maximalem Maßstab darge-
stellt werden.

Element Erklärung
SIGUARD PDP Phasor Data Processing, Handbuch
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Klicken Sie auf dieses Element, um das entsprechende Diagramm in-
klusive aller darin dargestellten Kurven zu löschen. Alle darunter be-
findlichen Diagramme rücken eine Reihe nach oben.
Dieses Element rufen Sie mit einem Doppelklick auf einen Messwert 
oberhalb des Diagramms auf.
Die Rahmenfarbe korreliert mit der Farbe der Kurve.
Das Element zeigt die aktuell gültigen Grenzwerte für die zugehörige 
Kurve an. Sie können die Grenzwerte ändern und aktivieren/deaktivie-
ren. Aktivierte Grenzwerte werden in Liniendiagrammen als horizontale 
Linie, bei Vektordiagrammen als Kreislinie dargestellt.
Wirksame Grenzwerte werden durch einen blauen Hintergrund ange-
zeigt. Geänderte, noch nicht wirksame Grenzwerte werden durch einen 
orangen Hintergrund angezeigt.
Bei einem Klick auf das Kreuz wird das Element geschlossen, die Än-
derungen lokal gespeichert.
Ein aktiver Grenzwert muss plausibel sein (zum Beispiel Max2 > Max1), 
sonst wird die Speicherung abgelehnt. 

Element Erklärung
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2.6 Messwerte, Anwendungen und Formeln

2.6.1 Übersicht
.

Im Fensterbereich Measurements, applications and formulas sehen Sie:

• Selected measurements
Die Liste enthält Messstellen, die zu den im Fensterbereich SIGUARD PDP UI - Map ausgewählten Ob-
jekten gehören.

• All measurements
Die Liste enthält alle Messstellen, die im Energienetz verfügbar sind. Auch hier können Sie festlegen, ob 
in alphabetischer Reihenfolge, nach Einheit oder nach Typ sortiert aufgelistet wird.

• Predefined formulas
Die Liste enthält alle vordefinierten Formeln.

Diese Formeln können Sie auf die Messwerte anwenden.

• Voltage stability curves
Die Liste enthält spezielle Kurven (Applications), wie zum Beispiel Spannungsstabilitätskurven.

• Statistics
Für jede PMU werden Werte gesammelt, die in Diagrammen dargestellt werden können.

Bild 2-11 Auflistungen der Messstellen, Messpunktanwendungen und Formeln

Sie können festlegen, ob in alphabetischer Reihenfolge, nach Einheit oder nach Typ sortiert aufgelistet wird, 
indem Sie ein- oder zweimal auf die entsprechende Spaltenüberschrift klicken.

Bis zu 10 Messstellen/Formeln/VSCs/Statistiken können in einem Diagramm anzeigt werden.

Ziehen Sie dazu die ausgewählte Messstelle in den Fensterbereich Chart View. Eine Messstelle vom Typ 
Phasor wird als Vektordiagramm dargestellt, es sei denn, Sie ziehen ihn in ein vorher angelegtes Liniendia-
gramm. Eine Messstelle vom Typ Analog wird immer als Liniendiagramm angezeigt. Sie können Messstellen 
in bestehende Diagramme vom gleichen Typ einfügen. Sie können mehrere Messstellen markieren und sie 
gleichzeitig in ein Diagramm ziehen. 

Durch einen Klick mit der rechten Maustaste auf eine  Messstelle vom Typ Phasor können Sie diesen als Re-
ferenz-Phasor festlegen oder löschen.

Alle im Fensterbereich Chart View dargestellten Phasoren beziehen sich auf den Referenzphasor. Das heißt, 
alle Phasenwinkel werden relativ zur Phase des Referenzphasors dargestellt.

Mit Hilfe der Pfeile können Sie den kompletten Fensterbereich oder eine Auflistung ein- oder ausblenden.
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Information zur Verwendung von vordefinierten Formeln finden Sie unter 3.3 Kurven anzeigen. 

2.6.2 Selected measurements
.

Die Liste Selected measurements enthält alle Messstellen, die in der Landkarte ausgewählt wurden. So lässt 
sich z.B. die Anzahl der Messstellen auf eine Unterstation begrenzen.

Bild 2-12 Auflistung der ausgewählten Messstellen
SIGUARD PDP Phasor Data Processing, Handbuch
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2.6.3 All measurements
.

Die Liste All measurements enthält alle Messstellen, die im Energienetz zur Verfügung stehen.

Bild 2-13 Auflistung aller Messstellen
SIGUARD PDP Phasor Data Processing, Handbuch
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2.6.4 Predefined formulas
.

Die Liste Predefined formulas enthält alle in SIGUARD PDP vordefinierte Formeln. Diese Formeln können in 
ein Chart View gezogen werden, um als Parameter entsprechende Messstellen in die Formel einzubinden und 
daraus eine Kurve berechnen zu lassen, das dann im Chart View angezeigt wird. Für die berechnete Kurve 
müssen Sie einen eindeutigen Namen vergeben.

 HINWEIS

Je nach der ausgewählten Kurve können Sie nur bestimmte Messwerte als Eingangsgrößen verwenden. Bei 
manchen Formeln können Sie konstante Werte verwenden.

 

Bild 2-14 Auflistung aller vordefinierten Formeln
SIGUARD PDP Phasor Data Processing, Handbuch
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2.6.5 Voltage stability curves
.

Die Liste Voltage stability curves enthält alle Messstellen im Energienetz, mit denen Spannungsstabilitäts-
kurven mit der Applikation VSC berechnet werden können.

Bild 2-15 Auflistung aller Messstellen zur Berechnung der VSCs
SIGUARD PDP Phasor Data Processing, Handbuch
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2.6.6 Statistics
.

Für jede PMU werden 6 statistische Werte gesammelt, die als Diagramme dargestellt werden können:

• count of receive errors
Anzahl der empfangenen Fehler pro parametrierter Zählperiode.

• count of received frames
Anzahl der Telegramme, die pro parametrierte Zählperiode von der PMU an den SIGUARD PDP Server 
übertragen werden (z.B. 600).

• count of telegram errors
Anzahl der PMU-Statusflags, die in einem Telegramm enthalten sind.

• count of timestamp errors
Anzahl von Fehlern, bei Abweichung der Regelmäßigkeit von Zeitstempeln je Wiederholrate.

• count of timestamp window error
Anzahl von Fehlern, bei Abweichung der Zeitstempel von einem Zeitfenster (Toleranz). Die Abweichung 
kann in der Vergangenheit oder in der Zukunft liegen.

• latency
Messung der maximalen Latenz. Die Latenz ist die Zeitdifferenz zwischen dem Absenden der Messwerte 
von der PMU bis zum Ankommen am SIGUARD PDP Server.

 HINWEIS

Beachten Sie, dass die absolute Latenz nur dann auswertbar ist, wenn der PDP Server zeitsynchronisiert ist. 
Wenn der Server nicht zeitsynchronisiert ist, dann können Sie nur die Differenz von Latenzen unterschiedlicher 
PMUs betrachten.

 

Bild 2-16 Auflistung von statistischen Messwerten
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2.7 Warnmeldeliste und Ereignisliste

2.7.1 Übersicht
.

In SIGUARD PDP UI können Meldungen in Form von Listen angezeigt werden:

• Warnmeldeliste
Die Warnmeldeliste (Alarm list) enthält nur kommende Meldungen.

• Ereignisliste
Die Ereignisliste (Event list) enthält alle Meldungen (kommende und gehende Meldungen).

Die Warnmeldeliste und die Ereignisliste werden im rechten unteren Fensterbereich innerhalb von 
SIGUARD PDP UI geöffnet. Das Fenster kann herausgelöst und vergrößert werden oder an einer anderen Po-
sition des SIGUARD-Programmfensters eingefügt werden (siehe 2.8 Programmoberfläche gestalten).

In der Warnmeldeliste oder Ereignisliste stehen Warnmeldungen oder Ereignisse, die im Zeitbereich stattge-
funden haben, der durch die linke und rechte Begrenzung der PSS Curve eingestellt ist.

2.7.2 Warnmeldeliste
.

In SIGUARD PDP öffnen Sie ein Fenster für eine Warnmeldeliste durch Klicken auf die Schaltfläche .

Bild 2-17 Warnmeldeliste

Die Warnmeldeliste ist vergleichbar mit einer EXCEL-Tabelle. Sie enthält folgende Spalten:
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Tabelle 2-5 Parameter der Warnmeldeliste

Hinweise zur Bearbeitung der Warnmeldeliste siehe 2.7.4 Bearbeitung von Meldungen.

2.7.3 Ereignisliste
.

In SIGUARD PDP UI öffnen Sie ein Fenster für eine Ereignisliste durch Klicken auf die Schaltfläche .

Bild 2-18 Ereignisliste

Eine horizontale Linie markiert den momentanen Zeitpunkt (offline-Betrieb). Ereignisse, die in der Zukunft 
liegen (aus Sicht des momentanen Zeit-Cursors), sind grau eingefärbt.

Der Zeit-Cursor (horizontale Linie) kann verschoben werden. Die entsprechende Zeile ist zu markieren und das 
Kontextmenü Move > locator aufzurufen.

Die Ereignisliste ist vergleichbar mit einer EXCEL-Tabelle. Sie enthält folgende Spalten:

Element Erläuterung
Time Zeitpunkt der Auslösung der Warnmeldung in Std:Min:Sek,1/1000 Sek. 

(Zeitstempel). Die Warnmeldungen können nach der Zeit aufsteigend 
oder abfallend sortiert werden, indem Sie mit der linken Maustaste auf 
die Überschrift Time klicken. Diese Spalte ist immer eingeblendet.

Date Datum der Auslösung der Warnmeldung im Format: Jahr-Monat-Tag 
(z.B. 2010-09-21)

Name Name der physikalischen PMU oder des Messkanals, der die Warnmel-
dung ausgelöst hat.

Event element Element, das die Warnmeldung ausgelöst hat (z.B. PMU device, Chan-
nel, Island Detection oder Power Swing Recognition)

Incidence Beschreibung des Ereignisses (z.B. Limit Low 1 violated (Grenzwert-
unterschreitung) oder PMU device communication failure oder 
License Error)

Message Zusatzinformationen (z.B. Größe des Messwerts: Value 379981 V, da 
der untere Grenzwert 1 von 380 000 V unterschritten wurde).
SIGUARD PDP Phasor Data Processing, Handbuch
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Tabelle 2-6 Parameter der Ereignisliste

Hinweise zur Bearbeitung der Ereignisliste siehe 2.7.4 Bearbeitung von Meldungen.

2.7.4 Bearbeitung von Meldungen
.

Zur besseren Übersicht der Warnmeldeliste und der Ereignisliste kann die Tabelle bearbeitet werden.

Bearbeitung von Spalten
• Ausblenden von Spalten

Alle Spalten mit Ausnahme der Spalte Time können ausgeblendet werden. Öffnen Sie das Kontextmenü 
in der Kopfzeile. Nur markierte Überschriften werden angezeigt (eingeblendet).

• Spaltenreihenfolge
Einzelne Spalten können durch horizontales Ziehen der Überschrift an eine andere Stelle in der Tabelle 
verschoben und so die Spaltenreihenfolge verändert werden.

• Spaltenbreite verändern
Alle Spalten können in der Breite durch ziehen des Spaltenrands verändert werden. 

Sortieren nach Spalteninhalten

Die Warnmeldeliste und die Ereignisliste kann nur nach der Zeit (aufsteigend oder absteigend) sortiert werden. 
Klicken Sie hierzu auf die Überschrift der Spalte Time.

Filtern nach Spalteninhalten

In der Spalte Name, Event element (Element, das den Alarm ausgelöst hat) und Incidence (Ereignis) stehen 
Auswahllisten zur Verfügung, nach deren Parameter die Listen gefiltert werden können.

Kopieren des Inhalts von Listen

Wählen Sie eine Zeile aus und drücken Sie <Strg-A>, um alle Zeilen auszuwählen und <Strg-C>, um die 
Zeilen in den Zwischenspeicher zu kopieren. Öffnen Sie eine entsprechende Anwendung (z.B. Microsoft Word 
Pad) und drücken Sie <Strg-V>, um den Inhalt des Zwischenspeichers in die Datei einzufügen.

Element Erläuterung
Time Zeitpunkt der Auslösung der Ereignismeldung in Std:Min:Sek,1/1000 

Sek. (Zeitstempel). Die Ereignismeldungen können nach der Zeit aufstei-
gend oder abfallend sortiert werden. Diese Spalte ist immer eingeblen-
det.

Date Datum der Auslösung der Ereignismeldung im Format: Jahr-Monat-Tag  
(z.B. 2010-09-21)

Name Name der physikalischen PMU oder des Messkanals, der die Ereignis-
meldung ausgelöst hat.

Event element Element, das die Ereignismeldung ausgelöst hat (z.B. PMU device, 
Channel, Island Detection oder Power Swing Recognition)

Incidence Beschreibung des Ereignisses (z.B. Limit Low 1 violated (Grenzwert-
unterschreitung) oder PMU device communication failure oder 
License Error)

Transition Anzeige, ob eine kommende (appearing) oder eine gehende (disappea-
ring) Ereignismeldung ansteht.

Message Zusatzinformationen (z.B. Größe des Messwerts: Value 379981 V, da 
der untere Grenzwert 1 von 380 000 V unterschritten wurde).
SIGUARD PDP Phasor Data Processing, Handbuch
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2.8 Programmoberfläche gestalten 
.

Die Programmoberfläche von SIGUARD PDP können Sie Ihren Bedürfnissen entsprechend gestalten. Sie 
können alle Oberflächenkomponenten in einem Fenster darstellen oder sie auf mehrere Fenster verteilen. 

Die Oberflächenkomponenten Menü, Symbolleiste und PSS Curve (Power system status) bilden das 
Hauptfenster, sie können nur einmal geöffnet werden.

Die Oberflächenkomponenten Chart View, Event List, Alarm List und PSRs lassen sich mehrfach öffnen. Die 
Oberflächenkomponente SIGUARD PDP UI - Map kann nur einmal geöffnet werden.

Alle Oberflächenkomponenten in einem Fenster

Beim erstmaligen Start von SIGUARD PDP UI wird die PSS-Kurve im Hauptfenster angezeigt. Weitere Kom-
ponenten öffnen Sie mit einem Klick auf die Symbole oben links. Die Komponenten, zum Beispiel die Landkarte 
und Listen, werden ebenfalls in das Hauptfenster eingefügt. 

Bild 2-19 Alle Oberflächenkomponenten in einem Fenster

Oberflächenkomponenten auf mehreren Monitoren

Bei Verwendung von 2 Monitoren können Sie die Oberflächenkomponenten auf diese, zum Beispiel in 2 Fens-
tern, verteilen. Sie können Oberflächenkomponenten aber auch auf weiteren Monitoren darstellen.

So verteilen Sie die Oberflächenkomponenten auf 2 Fenster:

✧ Selektieren Sie eine Oberflächenkomponente, zum Beispiel die Landkarte, mit der Maus und ziehen Sie 
diese aus dem Hauptfenster auf den zweiten Monitor. 

✧ Ziehen Sie weitere Oberflächenkomponenten in das Fenster am zweiten Monitor. 
SIGUARD PDP Phasor Data Processing, Handbuch
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✧ Arrangieren Sie die Oberflächenkomponenten in den beiden Fenstern nach Ihren Bedürfnissen. 

In den beiden Fenstern wird die gewünschte Darstellung angezeigt. Die 2 Fenster können Sie auf 2 Monitoren 
platzieren. 

Bild 2-20 Hauptfenster mit Chart View

Bild 2-21 Zweites Fenster mit Landkarte und Ereignisliste
SIGUARD PDP Phasor Data Processing, Handbuch
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Benutzeroberfläche speichern 

Beim Beenden speichert SIGUARD PDP UI die aktuelle Darstellung der Programmoberfläche als Favorit mit 
der Bezeichnung StartUpFavorite. Beim erneuten Öffnen wird die Programmoberfläche von SIGUARD PDP 
in der gespeicherten Darstellung angezeigt.

Außerdem können Sie weitere Darstellungen als Favoriten speichern. 

So speichern Sie eine Darstellung als Favorit:

✧ Klicken Sie in der Symbolleiste auf das Symbol Save Favorite. 

Der Dialog Save Favorite wird geöffnet.

Bild 2-22 Bezeichnung für Favoriten eingeben

✧ Geben Sie eine Bezeichnung für den Favoriten ein und schließen Sie den Dialog mit Save.

Der Favorit wird unter der eingegebenen Bezeichnung gespeichert.

 HINWEIS

Im Favoriten werden nicht gespeichert: 
• Die Liste der Messstellen unter Selected measurements
• Die mit einer vordefinierten Formel (unter Predefined formulas) erzeugten und angezeigten berechneten 

Werte

 

Gespeicherte Benutzeroberfläche aufrufen

So rufen Sie eine gespeicherte Benutzeroberfläche auf:

✧ Wählen Sie unter Favorite name die gewünschte Benutzeroberfläche aus. 

Die gespeicherte Benutzeroberfläche wird dargestellt.

Gespeicherte Benutzeroberfläche löschen

So löschen Sie eine gespeicherte Benutzeroberfläche:

✧ Wählen Sie unter Favorite name die gewünschte Benutzeroberfläche aus. 

Die gespeicherte Benutzeroberfläche wird dargestellt.

 HINWEIS

Eine gelöschte Benutzeroberfläche kann nach dem Löschen nicht wieder dargestellt werden.

 

✧ Klicken Sie in der Symbolleiste auf das Symbol Delete Favorite.
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2.9 Limit Editor 
.

Im Limit Editor definieren Sie die Grenzwerte/Schwellen, die bei der Bewertung berücksichtigt werden sollen. 
Alle konfigurierten Messstellen sind aufgelistet.

Die Grenzwerte/Schwellen können Sie auch im Tool SIGUARD PDP Engineer definieren, siehe 4.4 Phasor 
Measurement Unit (PMU).

Limit Editor starten 

So starten Sie den Limit Editor:

✧ Klicken Sie im Fensterbereich Chart View links oben auf die Schaltfläche .

Sie können für alle Messstellen Grenzwerte eingeben und diese nachträglich ändern (siehe 2.5 Chart View).

Pro Messstelle sind 3 Minimal- und 3 Maximalwerte möglich. Damit sie wirksam werden, müssen Sie die 
Grenzwerte aktivieren. Messstellen, für die keine Grenzwerte wirksam sind, werden bei der Berechnung des 
Systemzustandes (Power System Status) nicht berücksichtigt.

Bild 2-23 Limit Editor, Definition der Grenzwerte

Grenzwerte eingeben

✧ Geben Sie die Parameter für die Grenzwerte ein.

Zur Eingabe der Grenzwerte stehen 6 Spalten zur Verfügung:

• Min1, Min2, Min3
Geben Sie in diese Spalten die unteren Grenzwerte/Schwellen ein. Min3 ist der unterste/kritischste Wert. 
Min1 ist der oberste/unkritischste Wert.
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• Max1, Max2, Max3
Geben Sie in diese Spalten die oberen Grenzwerte/Schwellen ein. Max1 ist der unterste/unkritischste 
Wert. Max3 ist der oberste/kritischste Wert.

Grenzwerte und Aktivierungen kopieren

So kopieren Sie Grenzwerte und Aktivierungen:

✧ Markieren Sie durch Ziehen mit der Maus bei gedrückter linker Maustaste die Grenzwerte und Aktivierun-
gen.

✧ Klicken Sie mit der rechten Maustaste in die Markierung und wählen Sie aus dem Kontextmenü Copy.

✧ Klicken Sie mit der rechten Maustaste auf die Zelle, die der linken oberen Ecke des einzufügenden Berei-
ches entspricht und wählen Sie aus dem Kontextmenü Paste.

Wirkung von Grenzwerten:
• Die Grenzwerte wirken auf die Einfärbung im geografischen Übersichtsbild in Google Earth. Die Farbe der 

Stationen zeigt an, ob die Spannungen Grenzwerte verletzt haben. Die Farbe der Leitungen zeigt an, ob 
die Ströme Grenzwerte verletzt haben.

• Die Grenzwerte werden in die Linien- und Vektordiagramme eingezeichnet.

• Die Grenzwerte beeinflussen den Status der Kurve im Fensterbereich PSS Curve.

Einstellmöglichkeiten/Anzeigen  

✧ Nehmen Sie im Limit Editor mithilfe der Schaltflächen und Auswahllisten Einstellungen vor.

In der folgenden Tabelle sind die Einstellmöglichkeiten und Anzeigen des Limit Editor erläutert.

Tabelle 2-7 Fensterbereich Limit Editor

Element Erläuterung
Wählen Sie mit diesem Element aus, welche Messstellen aufgelistet 
werden sollen. 
• Selected measurements

Die in der Landkarte vorausgewählten Messstellen werden aufgelis-
tet.

• All measurements
Alle Messstellen werden aufgelistet.

• Application data
z.B. Daten von der Schwingungserkennung PSR

• Statistics
Messwerte von den PMUs.

Klicken Sie auf dieses Element, um geänderte Grenzwerte im Gesamt-
system wirksam zu schalten. Der Limit Editor wird geschlossen.

Geben Sie den Grenzwert ein und aktivieren Sie ihn mit einem Häk-
chen. Anschließend müssen Sie die Änderungen noch wirksam schal-
ten.
Klicken Sie auf dieses Element, um geänderte Grenzwerte im Gesamt-
system wirksam zu schalten. Der Limit Editor wird geschlossen.

Klicken Sie auf dieses Element, um die Änderungen lokal zu speichern 
und den Limit Editor zu verlassen. Die Änderungen sind nur auf dem 
lokalen Rechner wirksam.
Klicken Sie auf dieses Element, um die Änderungen zu verwerfen und 
den Limit Editor zu verlassen.
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2.10 Berichterstellung
.

Zur Dokumentation eines Ereignisses können Diagramme in der Zwischenablage abgelegt und von dort zum 
Beispiel in Microsoft Word eingefügt werden. 

Diagramm in die Zwischenablage kopieren

So kopieren Sie ein Diagramm in die Zwischenablage:

✧ Klicken Sie im Fensterbereich Chart View mit der rechten Maustaste auf das Diagramm.

✧ Wählen Sie aus dem Kontextmenü Copy to Clipboard ....

Bild 2-24 Export in Metafile

✧ Geben Sie die Bildgröße ein und bestätigen Sie mit OK. 

Werte exportieren

Sie können die Messwerte des mit den Schiebern ausgewählten Zeitbereiches aus dem SIGUARD-Archiv in 
eine CSV-Datei exportieren. Diese CSV-Datei bearbeiten Sie anschließend mit einem Tabellenkalkulations-
programm weiter.

So exportieren Sie Messwerte in eine CSV-Datei:

✧ Schalten Sie in den Offline-Modus.

✧ Stellen Sie im Fensterbereich PSS Curve mit den Schiebern den gewünschten Zeitbereich ein. 

✧ Wählen Sie den Menüeintrag File > Save to CSV.... 

✧ Geben Sie im Dialog Save Csv den Dateinamen ein.

✧ Klicken Sie auf Save.

Die Messwerte werden in eine CSV-Datei exportiert. Der Pfad und das Verzeichnis wurden bei der Installation 
von SIGUARD PDP festgelegt.

 HINWEIS

Beachten Sie, dass bei mehr als 255 Spalten und mehr als 65 536 Zeilen die Datei unter Umständen nicht mehr 
mit gängigen Tabellenkalkulationsprogrammen verarbeitet werden kann. Für jeden Phasor benötigen Sie 3 
Spalten, für jeden analogen Wert 2 Spalten, plus zusätzlich eine Spalte für den Zeitstempel. 65536 Zeilen ent-
sprechen 1 h 39 min bei 10 Werten pro Sekunde oder 21 min bei 50 Werten pro Sekunde.

 

Der CSV-Datei können Sie auch die Qualität der Messwerte entnehmen, siehe das folgende Beispiel. 
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Bild 2-25 Auszug aus einer CSV-Exportdatei
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Tabelle 2-8 Bedeutung der Qualitätscodes in einer CSV-Exportdatei

Abkürzung Bedeutung Quelle des Qualitätscodes
COE PMU-Kommunikationsfehler SIGUARD PDP Server
CTO Kollektor Zeitüberschreitung SIGUARD PDP Server
SC1 Zeitsynchronisation 1 PMU
SC2 Zeitsynchronisation 2 PMU
COC Konfigurationswechsel PMU
TGR Übertragungstrigger PMU
CLF Uhrzeitfehler PMU
NSY PMU nicht synchronisiert PMU
ERR PMU-Fehler PMU
DAI PMU-Daten ungültig PMU
DAM PMU-Daten fehlen PMU
OOS Außer Betrieb SIGUARD PDP Server
L3V Grenzwertüberschreitung Minimum 3 SIGUARD PDP Server
L2V Grenzwertüberschreitung Minimum 2 SIGUARD PDP Server
L1V Grenzwertüberschreitung Minimum 1 SIGUARD PDP Server
H1V Grenzwertüberschreitung Maximum 1 SIGUARD PDP Server
H2V Grenzwertüberschreitung Maximum 2 SIGUARD PDP Server
H3V Grenzwertüberschreitung Maximum 3 SIGUARD PDP Server
DNF Daten im Archiv nicht gefunden SIGUARD PDP Server
PCE Berechnungs-Bibliothek-Fehler SIGUARD PDP Server
ADI Applikationsdaten ungültig SIGUARD PDP Server
DAS Daten fehlerverdächtig SIGUARD PDP Server
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2.11 Applikationen

2.11.1 Übersicht
.

In SIGUARD PDP UI können verschiedene Anwendungen ausgeführt werden:

• Inselerkennung in Netzwerken (ISD)

• Erkennung von Schwingungen im Netzwerk (PSR)

• Anzeige der Spannungsstabilitätskurve (VSC)

Für die einzelnen Anwendungen erfolgt die Konfiguration und Parametrierung in SIGUARD PDP Engineer, 
siehe 4.7.1 Übersicht.

2.11.2 Inselerkennung (Island State Detection ISD)
.

Die Inselerkennung in SIGUARD PDP verwendet die in jeder PMU vorhandenen Messwerte Frequenz (f) und 
Frequenzänderungsgeschwindigkeit (df/dt). 

Es sind zwei Teilapplikationen vorhanden:

• Statische Inselerkennung
Hier werden alle Frequenzwerte miteinander verglichen. Es werden 3 verschiedene Zustände unterschie-
den:

- Wenn die Differenz von jeweils 2 Frequenzwerten unterhalb eines unteren Grenzwerts liegt, wird 
keine Inselbildung erkannt.

- Wenn die Differenz von mindestens 2 in der Größe benachbarten Frequenzwerten zwischen unterem 
und oberem Grenzwert liegt, wird eine potentielle Inselbildung gemeldet. Diese Meldung kann als 
Warnmeldung verstanden werden.

- Wenn die Differenz von mindestens 2 in der Größe benachbarten Frequenzwerten oberhalb eines 
oberen Grenzwerts liegt, so gilt eine Inselbildung als mit hinreichender Sicherheit erkannt und es wird 
eine entsprechende Meldung erzeugt. Diese Meldung kann als Alarmmeldung verstanden werden.

• Dynamische Inselerkennung
Hier werden alle Frequenzänderungsgeschwindigkeiten miteinander verglichen. Es werden 2 Zustände 
unterschieden:

- Wenn die Differenz von mindestens 2 in der Größe benachbarten Werte der Frequenzänderungsge-
schwindigkeiten unterhalb eines Grenzwerts liegt, so liegt keine Inselbildung vor.

- Wenn die Differenz von mindestens 2 in der Größe benachbarten Werte der Frequenzänderungsge-
schwindigkeiten oberhalb eines Grenzwerts liegt, so liegt möglicherweise eine Inselbildung vor oder 
sie entsteht gerade. Diese Meldung kann als Warnmeldung verstanden werden.

Für die Parametrierung der Applikation Inselerkennung siehe 4.7.2 Inselerkennung (Island State Detection 
ISD).
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Darstellung der Inselerkennung in Ereignis- oder Warnmeldeliste

Alle von SIGUARD PDP ISD erzeugten Meldungen sind in der Ereignisliste zu finden. Bei erkannten potentiel-
len oder sicheren Inselbildungen werden entsprechende Einträge in die Warnmeldeliste geschrieben.

Bild 2-26 Warnmeldeliste gefiltert nach dem Event element Island Detection

In der gefilterten Warnmeldeliste werden die erkannten Inseln mit dem Ereignis ISD network split oder ISD 
potential network split angezeigt. Ein sicheres Ereignis für eine Inselerkennung ist ein ISD network split, in 
dessen Spalte Message Zone 1, Zone 2 und Zone 3 eingetragen sind. Dies sagt aus, dass 3 Inseln erkannt 
wurden.

 HINWEIS

Die in dem jeweiligen ISD-Event gezeigten Werte für Frequenz und Frequenzanstieg sind Mittelwerte der 
PMU-Werte über einen in der SIGUARD-Konfigurationsdatei angegebenen Zeitraum (time constant). Daher 
weichen sie von den jeweiligen PMU-Werten zu dem im ISD-Event angegebenen Messzeitpunkt ab. Wenn 
mehrere PMUs oder Frequenzmessstellen in einer Zone liegen, dann erfolgt darüber hinaus eine weitere Mit-
telung über deren Mittelwerte.
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Darstellung der Inselerkennung in der Landkarte

Entsprechend der Anzahl der erkannten Inseln, werden verschieden farbige Flächen in der Landkarte darge-
stellt. Wenn in der Insel nur eine Unterstation enthalten ist, dann wird die Fläche als Quadrat um die Untersta-
tion dargestellt, Bei mehreren Unterstationen wird die Fläche als Vieleck dargestellt, mit den Unterstationen als 
Eckpunkte.

Die farbliche Darstellung korreliert mit den Farben der Chart Views (1. Insel = orange, 2. Insel = blau, 3. Insel 
= grün usw.).

Weitere Informationen zur Parametrierung finden Sie im Kapitel 4.7.2 Inselerkennung (Island State Detection 
ISD).

Bild 2-27 Landkarte mit erkannten Inseln
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2.11.3 Schwingungserkennung (Power Swing Recognition PSR)
.

Im User Interface (UI) wird eine erkannte Wirkleistungspendelung in verschiedenen Oberflächenkomponenten 
angezeigt:

Darstellung der Schwingungserkennung in der Map

Wenn eine auf die Winkeldifferenz bezogene Pendelung vorliegt, werden die Standorte der beiden beteiligten 
PMUs mit einem Kreis umschlossen und die Verbindungslinie dazwischen eingezeichnet (siehe Verbindung 
Mülheim – Nürnberg im folgenden Bild). Wenn eine in der Wirkleistung gemessene Pendelung vorliegt, dann 
wird die der Messung zugrunde liegende PMU mit einem Kreis gekennzeichnet (siehe Copenhagen im folgen-
den Bild). Die Farbe des Symbols richtet sich dabei nach der Farbe im vorhergehenden Bild.

Bild 2-28 Pendelungen in der Map
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Darstellung der Schwingungserkennung in Power Swing Analysis

Alle von SIGUARD PDP PSR erzeugten Meldungen sind in der Ereignisliste zu finden. Bei erkannten Schwin-
gungen werden entsprechende Einträge in die Warnmeldeliste geschrieben.

Bild 2-29 Warnmeldeliste gefiltert nach dem Event element Power Swing Recognition

In der gefilterten Warnmeldeliste werden die erkannten Schwingungen mit dem entsprechenden Ereignis an-
gezeigt. 

In dieser Oberflächenkomponente Power Swing Analysis werden alle mit dem SIGUARD Engineer konfigu-
rierten Jobs und ihre entsprechenden Moden aufgelistet. Angeregte Moden werden mit farblich gekennzeich-
neten Symbolen dargestellt. Die Farben der Symbole entsprechen der Farbe in Bild 1-10.

Bild 2-30 Oberflächenkomponenten für Power Swing Analysis 
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Tabelle 2-9 Oberflächenkomponenten für Power Swing Analysis 

Darstellung der Schwingungserkennung in Power Swing Recognition Overview

Dieses Diagramm kann per Drag & Drop aus der Power Swing Analysis in der Chart View-Oberflächenkom-
ponente angezeigt werden. Das Diagramm zeigt alle für den aktuellen Zeitpunkt erkannten Schwingungen als 
Punkt im Frequenz-Dämpfungsdiagramm.

Bild 2-31 Erkannte Pendelungen im Diagramm Power Swing Recognition overview (Frequenz über 
Dämpfung)

Darstellung der Eingangskurven in der Chart View

Aus der Power Swing Analysis-Oberflächenkomponente können die Eingangskurven (Active Power oder 
Phase Angle) und die daraus bestimmten Kenngrößen eines erkannten Modus (Frequenz, Amplitude, Dämp-
fungsverhältnis und DOE) in der Chart View-Oberflächenkomponente angezeigt werden.

Element Erläuterung
Power Swing Recognition over-
view

Klicken Sie auf dieses Element und ziehen es in ein Chart View, um ein 
PSR Overview zu erzeugen.
Klicken Sie auf dieses Element, um die komplette PSR-Baumstruktur 
zu schließen.

Klicken Sie auf dieses Element, um die 1. Hierarchie der PSR-Baum-
struktur zu öffnen.

Klicken Sie auf dieses Element, um die komplette PSR-Baumstruktur 
zu öffnen.

Klicken Sie auf dieses Element, um in der PSR-Baumstruktur die 
Namen der Messstellen anzuzeigen oder wieder auf die Anzeige der 
Parameternamen umzuschalten.
Graue Markierung
Es wurde keine Schwingung erkannt.
Gelbe Markierung (1)
PSR notified power swing
Eine erkannte Schwingung wurde gemeldet.
Hell-orange Markierung (2)
PSR distinct power swing
Eine eindeutige Schwingung wurde erkannt und gemeldet.
Dunkel-orange Markierung (3)
PSR critical power swing
Eine kritische Schwingung wurde erkannt und gemeldet.
Rote Markierung (4)
PSR undamped critical power swing
Eine kritische ungedämpfte Schwingung wurde erkannt und gemeldet.
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 HINWEIS
Beachten Sie Folgendes:
• Für die Applikation PSR ist eine gesonderte Lizenz notwendig. Wenn Sie keine PSR-Lizenz erworben 

haben, dann ist diese Applikation nicht ablauffähig.
• Um den Server nicht zu überlasten, kontrollieren Sie den Rechenzeitbedarf von PSR.exe, bevor Sie weitere 

PSR Jobs definieren. Sie können den prozentualen Rechenzeitbedarf mit dem Windows Task Managers, 
Registerkarte Prozesse beobachten. Die Applikation sollte nicht mehr als 50 % eines Rechenkerns (also 
ca. 12,5 % bei einem Vier-Kern-Prozessor) verbrauchen.

• Die Algorithmen der PSR sind zum Patent angemeldet.

 

Weitere Informationen zur Parametrierung der PSR finden Sie im Kapitel 4.7.3 Schwingungserkennung (Power 
Swing Recognition PSRs).

2.11.4 Spannungsstabilitätskurve (Voltage-Stability Curve VSC)
.

SIGUARD PDP bietet die Möglichkeit, eine Spannungsstabilitätskurve (P-V-Kurve) am SIGUARD PDP UI zu 
berechnen und auszugeben.

Zwei verschiedene Modi werden unterstützt:

• Messung der Spannungsstabilitätskurve einer Leitung mit je einer PMU am Anfang und Ende der Leitung 
(Spannungs- und Strommessung)

• Messung der Spannungsstabilitätskurve einer Leitung mit einer PMU am Anfang der Leitung (Spannungs- 
und Strommessung) und den zugehörigen Zweitorparametern.

Wenn die Leitung mit nur einer PMU ausgestattet ist, werden für die Berechnung von Spannung und Strom am 
Ende der Leitung die Zweitorparameter der Leitung (Resistanz R [Ω], Reaktanz X [Ω], Konduktanz G [µS], Sus-
zeptanz B [µS]) verwendet, siehe folgendes Bild.

Bild 2-32 Zweitor-Ersatzschaltbild einer Übertragungsleitung
(1) R = Resistanz (Wirkwiderstand)
(2) X = Reaktanz (Blindwiderstand)
(3) G = Konduktanz (Wirkleitwert)
(4) B = Suszeptanz (Blindleitwert)

Mit den gemessenen oder berechneten Spannungen und Strömen im Endknoten der Leitung wird die aktuelle 
Lastadmittanz berechnet. Die entsprechende Belastung der Leitung wird als Arbeitspunkt auf der Kurve (rotes 
Kreuz) dargestellt (siehe folgendes Bild). Die Spannungsstabilitätskurve selbst entsteht durch Variation der 
komplexen Lastadmittanz im Endknoten der Leitung von Null bis unendlich. Diese Neuberechnung der Kurve 
wird bei jedem Update des SIGUARD PDP UI durchgeführt.
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Bild 2-33 Beispiel einer Spannungsstabilitätskurve

In SIGUARD PDP UI sind unter Applications - Voltage stability curves im rechten unteren Fensterbereich 
alle parametrierten Spannungsstabilitätskurven (VSCs) aufgelistet. Durch Ziehen einer Spannungsstabilitäts-
kurve, zum Beispiel MlhM -> NbgH, mit der Maus in den Fensterbereich Chart View unterhalb des Zeitver-
laufsdiagramms, wird die Spannungsstabilitätskurve angezeigt (siehe 3.3 Kurven anzeigen).

Ein rotes Kreuz markiert den aktuellen Arbeitspunkt. Im Bild oben ist der kritische Punkt fast erreicht. Bei einer 
geringfügig höheren Leistung werden die Stabilitätskriterien verletzt und es kann zu einer Netzabtrennung 
kommen.

 HINWEIS

Wenn im Endknoten der Leitung oder in seiner Nähe regelbare Blindleistungsquellen vorhanden sind, ist die 
Kurvenform der Spannungsstabilitätskurve nicht konstant, sondern variiert mit der Höhe der eingespeisten 
Blindleistung. Deshalb kann aus dem Diagramm keine quantitative Aussage gewonnen werden, wie viel zu-
sätzlich übertragbare Leistung über die Leitung transportiert werden kann. Trotzdem ist eine qualitative Bewer-
tung der Spannungsstabilitätskurve hilfreich, indem sie dem Anwender die Möglichkeit bietet, den Abstand zum 
Leistungsmaximum zu bewerten.

 

Für die Parametrierung der Spannungsstabilitätskurven siehe 4.7.4 Spannungsstabilitätskurve (Voltage-Stabi-
lity Curve VSC).

■
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3.1 Beispielereignis 
.

Anhand eines einfachen Beispiels wird Ihnen der Umgang mit SIGUARD PDP UI nähergebracht.

In diesem Beispiel wird ein Zeitbereich aus dem Archiv ausgewählt, der im Fensterbereich PSS Curve als kri-
tisch angezeigt wird. Für diesen Zeitbereich sollen die wesentlichen Kurven dargestellt und analysiert werden. 
Die Analyse wird im Offline-Modus durchgeführt. Ziel der Analyse ist es, herauszufinden, warum die PSS-
Kurve immer wieder in den roten Bereich kommt.

Vorgehensweise

Die vorgeschlagene Vorgehensweise verdeutlicht die einzelnen Schritte zur Untersuchung und Beurteilung 
eines Ereignisses.

Gehen Sie in folgenden Schritten vor:

• Wählen Sie den Zeitbereich aus, in dem sich das zu untersuchende Ereignis befindet.

• Zeigen Sie die für das Ereignis wesentlichen Kurven an.

• Exportieren Sie den Zeitbereich in das Permanentarchiv.

• Importieren Sie den Zeitbereich aus dem Permanentarchiv. 

• Erstellen und drucken Sie einen Bericht.
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3.2 Zeitbereich auswählen 
.

Die Analyse eines Zeitabschnittes können Sie nur im Offline-Modus durchführen. Die Informationen von den 
Geräten werden im Offline-Modus weiterhin im Archiv abgelegt und können später angesehen und analysiert 
werden. 

Im Fensterbereich PSS Curve wählen Sie den Zeitbereich, den Sie anzeigen und analysieren möchten.

Den zeitlichen Ablauf des ausgewählten Bereiches können Sie im Fensterbereich SIGUARD PDP UI - Map 
verfolgen.

Offline-Modus einschalten 

✧ Schalten Sie mit einem Klick auf die Schaltfläche Go offline in den Offline-Modus.

Die Statuskurve mit mehreren kritischen Bereichen wird angezeigt. Diese sind rot dargestellt.

Bild 3-1 Power System Status, Kurve mit kritischen Bereichen

Zeitbereich markieren 

✧ Stellen Sie mit der Auswahlliste  die Länge des sichtbaren Zeitbereiches ein.

✧ Blättern Sie mit den Pfeilen an die gewünschte Stelle im Archiv.

✧ Ziehen Sie mit der Maus die Schieber auf der Zeitachse an die gewünschten Stellen.

Der Zeitbereich zwischen den Schiebern wird in den Diagrammen dargestellt.

In den Feldern From und To wird der gewählte Zeitbereich angezeigt.

Bild 3-2 Power System Status, Zeitbereich markieren
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Ablauf starten 

✧ Klicken Sie auf die Schaltfläche , um den Cursor an dem linken Rand des ausgewählten Zeitberei-
ches zu positionieren.

✧ Klicken Sie auf die Schaltfläche , um den Zeitbereich abzuspielen.

Auf der Landkarte (Fensterbereich SIGUARD PDP UI - Map) sehen Sie das projektierte Beispielprojekt. Es 
besteht aus 4 Unterstationen/Messpunkten und zugehörigen Hochspannungsleitungen. Die Einfärbung der 
Objekte verändert sich je nach Zustand zu den verschiedenen Zeitpunkten. 

Die Standardeinfärbung der Objekte ist blau. Eine Überschreitung des ersten Grenzwertes wird gelb, die des 
zweiten Grenzwertes rot dargestellt. 

Im Bild ist die Leitung zwischen den Messstellen Mülheim und Paris als kritisch zu erkennen. Die Ursache wird 
nachfolgend gesucht. 

Bild 3-3 SIGUARD PDP UI - Map, Ablauf verfolgen

Ablauf stoppen 

✧ Klicken Sie auf die Schaltfläche , um den Ablauf zu stoppen.

Bestimmten Zeitpunkt auswählen 

✧ Klicken Sie mit der Maus im gewählten Zeitbereich auf eine Stelle, um den Zustand zu diesem Zeitpunkt 
anzuzeigen.

Auf der Landkarte sehen Sie die Objekte je nach Zustand zu diesem Zeitpunkt eingefärbt.
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3.3 Kurven anzeigen 

Landkarte mit Objekten

Im Fensterbereich SIGUARD PDP UI - Map sehen Sie eine Landkarte mit dem eingezeichneten Energienetz. 
Das Energienetz ist aus Objekten, zum Beispiel Generatoren, Leitungen, aufgebaut. Für die einzelnen Objekte 
können Sie Tooltipps anzeigen. Außerdem steht eine Legende zur Verfügung.

Tooltipps anzeigen 

Zu den einzelnen Objekten auf der Landkarte können Sie Tooltipps aufrufen. Messwerte zu den jeweiligen Ob-
jekten werden angezeigt.

✧ Klicken Sie auf die Schaltfläche , um Tooltipps anzuzeigen.

✧ Gehen Sie mit dem Mauszeiger über ein Objekt, um den Tooltipp anzuzeigen. 

Die verfügbaren Informationen zu diesem Objekt werden angezeigt.

Bild 3-4 SIGUARD PDP UI - Map, Tooltipp anzeigen
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

71

http://siemens-russia.com/


Mit SIGUARD PDP UI arbeiten
3.3 Kurven anzeigen
Legende anzeigen 

Die Objekte der Landkarte und deren Einfärbung sind in einer Legende beschrieben.

✧ Klicken Sie auf die Schaltfläche Legend, um sie anzuzeigen. 

Die Legende wird eingeblendet.

Bild 3-5 SIGUARD PDP UI - Map, Legende anzeigen

Weitere Information zu den Objekten der Landkarte siehe 2.4 Map
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Objekte markieren 

Auf der Landkarte markieren Sie die Objekte, für die Sie Kurven anzeigen wollen.

✧ Klicken Sie auf die Schaltfläche .

✧ Markieren Sie im Fensterbereich SIGUARD PDP UI - Map einen Bereich um die Objekte, für die Sie eine 
Analyse machen wollen.

Die Markierung wird eingeblendet. 

Bild 3-6 SIGUARD PDP UI - Map, Objekte markieren

✧ Klicken Sie auf der rechten Fensterseite auf den Pfeil über Measurements, applications and formulas. 

Die Liste der Messwerte wird aufgeblendet.

Für die markierten Objekte werden unter Selected measurements die zur Verfügung stehenden Messwerte 
aufgelistet. Für diese Messwerte können Sie im folgenden Schritt Kurven anzeigen. 
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Bild 3-7 Measurements, aufgelistete Messwerte

Kartenausschnitt vergrößern 

Sie können einen Kartenausschnitt vergrößert darstellen. In der vergrößerten Darstellung sind Einzelheiten 
des Energienetzes erkennbar. Zum Beispiel werden Mehrfachleitungen sichtbar, die vorher nur als einzelner 
Strich dargestellt wurden.

Die Einzelheiten werden nur dann dargestellt, wenn sie vorher parametriert wurden.

✧ Klicken Sie auf die Schaltfläche , um den Kartenausschnitt zu vergrößern. 

Die Landkarte wird vergrößert dargestellt.

Bild 3-8 SIGUARD PDP UI - Map, vergrößerter Kartenausschnitt
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✧ Klicken Sie auf die Schaltfläche , um die Vergrößerung wieder rückgängig zu machen.

Kurven anzeigen 

Die zur Verfügung stehenden Messwerte können Sie nun als Kurven in Diagrammen darstellen.

Zur Analyse des Ereignisses erstellen Sie folgende Diagramme:

• Ein Zeitverlaufsdiagramm mit Strömen

• Ein Vektordiagramm mit Spannungen

• Ein Diagramm mit einer Spannungsstabilitätskurve

✧ Klicken im Fensterbereich Chart View auf die Schaltfläche , um ein leeres Liniendiagramm zu erzeu-
gen.

✧ Ziehen Sie mit dem Mauszeiger 2 Strommesswerte, zum Beispiel NbgH/I1 und MlhM/I1, in das erzeugte 
Diagramm.

Sie können in der Liste mehrere Messwerte markieren und diese gleichzeitig in ein Diagramm ziehen.

Diese Messwerte sind Stromphasoren der Messstellen Nürnberg und Mülheim. In dem Zeitverlaufsdiagramm 
wird der zeitliche Verlauf des Betrages der Ströme, nicht aber ihre Phase dargestellt. 

Als Zeitbereich wird der im Fensterbereich PSS Curve gewählte Zeitbereich angezeigt. 

Bild 3-9 Zeitverlaufsdiagramm, Ströme

In dem Bild sind starke Änderungen der Stromstärke und gedämpfte Schwingungen zu erkennen. Die Ände-
rungen der Stromstärke entstehen durch die Zu- und Abschaltung einer großen Last. Die Schwingungen 
deuten auf eine Pendelung hin.

Zur weiteren Untersuchung erstellen Sie ein Diagramm mit Spannungsphasoren.

Um weitere Diagramme einzufügen und anzuzeigen, können Sie im Fensterbereich Chart View nach unten 
scrollen. 

✧ Ziehen Sie einen Spannungsphasor, zum Beispiel NbgH/U1, mit der Maus in den Fensterbereich Chart 
View unterhalb des Zeitverlaufsdiagramms.

Ein Vektordiagramm mit einem Spannungsvektor wird angezeigt.

✧ Ziehen Sie zusätzlich einen Spannungs-Phasor, zum Beispiel MlhM/I1, in das Vektordiagramm.  
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Bild 3-10 Vektordiagramm, Spannungen

Im Vektordiagramm sehen Sie, wie die Phasenwinkel der Spannungen sich gegeneinander verhalten, das 
heißt, ob eine Phasenverschiebung besteht und wie groß diese ist. Außerdem ist zu sehen, ob sich die Phase 
zwischen den Spannungen vergrößert oder verkleinert oder gleich bleibt. Daraus kann zum Beispiel abgeleitet 
werden, ob 2 Generatoren gegeneinander oszillieren.

Weitere Hinweise kann eine Spannungsstabilitätskurve liefern.

Unter Application sind die Spannungsstabilitätskurven aufgelistet.

✧ Ziehen Sie eine Spannungsstabilitätskurve, zum Beispiel  MlhM -> NbgH, mit der Maus in den Fenster-
bereich Chart View unterhalb des Zeitverlaufsdiagramms.

Ein Diagramm mit der Spannungsstabilitätskurve wird angezeigt. 

Bild 3-11 Diagramm mit Spannungsstabilitätskurve

Die Spannungsstabilitätskurve zeigt die Spannung über der Leistung zu einem bestimmten Zeitpunkt an. Im 
Bild ist der kritische Punkt fast erreicht. Bei einer geringfügig höheren Leistung werden Stabilitätskriterien ver-
letzt und es kann zu einer Netzabtrennung kommen.

Messwerte im Diagramm anzeigen

Die Messwerte können nur im Offline-Modus angezeigt werden.

✧ Bewegen Sie den Mauszeiger über das Diagramm.

✧ Wählen Sie im Kontextmenü Show measure line > <Messwert>
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Bild 3-12 Einblenden einer Messlinie (horizontalen Linie)

Es wird eine horizontale Linie in der Farbe des Diagramms eingeblendet, an dessen Schnittstelle mit dem 
Diagram der aktuelle Messwert angezeigt wird. In der Zeitachse werden an der Cursorposition das Datum und 
die Uhrzeit eingeblendet.

✧ Wählen Sie im Kontextmenü Show second cursor.

Bild 3-13 Einblenden eines 2. Cursors (vertikale Linie)

Ein 2. Cursor (graue vertikale Linie) und eine zusätzliche horizontale Messlinie werden eingeblendet. Am 
Schnittpunkt mit dem Diagramm wird der Differenzwert zum 1. Messwert angezeigt. In der Zeitachse wird an 
der Position des 2. Cursors die Zeitdifferenz zum 1. Messwert angezeigt.
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Durchschnittswerte eines Diagramms anzeigen

Die Mittelwertsbildung kann nur für Liniendiagramme durchgeführt werden.

✧ Zeigen Sie eine Kurve an, z.B.:

Bild 3-14 Diagramm ohne glättender Mittelwertsbildung

✧ Wählen Sie im Kontextmenü Show average value.

Bild 3-15 Diagramm mit glättender Mittelwertsbildung

Das Liniendiagramm wird geglättet dargestellt. Der Name der Messstelle wird mit[Avg] (= Average) ergänzt.
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Landkarte ausblenden 

✧ Klicken Sie auf das X rechts oben im Fenster SIGUARD PDP UI - Map, um die Landkarte auszublenden. 
Der Fensterbereich Chart View wird vergrößert dargestellt. 

Sie können die Komponente Chart View auch aus dem Hauptfenster herausziehen und irgendwo auf dem 
Desktop positionieren und vergrößern.

Bild 3-16 Chart View, ausgeblendete Landkarte
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Grenzwerte ändern 

Rechts neben dem Diagramm können Sie die Grenzwerte einblenden und bearbeiten.

✧ Doppelklicken Sie oberhalb des Diagramms auf einen Messwert, um dessen Grenzwerte anzuzeigen.

✧ Ändern Sie einen Grenzwert.

Bild 3-17 Geänderter/konfigurierter Grenzwert

Die alten Grenzwerte werden als Tooltipp angezeigt. Nach der Änderung eines Grenzwertes wird der Hinter-
grund des Grenzwertes orange dargestellt. 

✧ Klicken Sie auf die Schaltfläche , um den geänderten Grenzwert zu speichern und wirksam zu schal-
ten.

Der Hintergrund des Grenzwertes wird blau.
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Limit Editor öffnen  

✧ Öffnen Sie den Limit Editor mit einem Klick auf die Schaltfläche .

Bild 3-18 Limit Editor

Er listet alle Messwerte mit den zugehörigen Grenzwerten auf. Sie können die Grenzwerte ändern sowie akti-
vieren/deaktivieren.

✧ Geben Sie neue Grenzwerte ein.

✧ Aktivieren Sie die neuen Grenzwerte mit einem Häkchen.

✧ Schalten Sie die geänderten Grenzwerte mit Save Limits wirksam. 

Der Editor wird beendet.
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Vordefinierte Formel verwenden 

Unter Formulas stehen eine Anzahl von vordefinierten Formeln zur Verfügung. Diese Formeln können Sie auf 
Messwerte anwenden.

So verwenden Sie vordefinierte Formeln:

✧ Ziehen Sie die gewünschte Formel, zum Beispiel ActivePower, in den Fensterbereich Chart View.

Ein Dialog, in den Sie die für die neue Kurve benötigten Parameter eingeben müssen, wird eingeblendet.

Bild 3-19 Vordefinierte Formel einfügen 

✧ Geben Sie unter Measurement name eine beliebige Bezeichnung für die neue Kurve ein. 

✧ Ziehen Sie Messstellen (Spannungs-Phasor und zugehörigen Strom-Phasor) aus dem Fensterbereich 
Measurements in die Eingabefelder Measurement 1 und Measurement 2.

✧ Geben Sie unter Factor einen Dezimalwert ein.

Mit diesem Wert wird die Kurve multipliziert. Typischerweise ist dieser Wert 1. Bei Berechnung von Leistungen 
kann dieser Faktor abweichen, da er von der Messung abhängt (Leiter-Leiter-Spannung oder Leiter-Erde-
Spannung).

Bild 3-20 Parameter für Formel eingeben

✧ Drücken Sie nach der Eingabe des letzten Parameters auf der Tastatur die Taste Eingabe.  

Das Diagramm mit der berechneten Kurve wird angezeigt.
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Bild 3-21 Diagramm mit berechneter Kurve
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3.4 Export und Import von Zeitbereichen

3.4.1 Export von Zeitbereichen
.

In SIGAUARD PDP UI werden Messdaten ständig in einem Ringarchiv gespeichert. Ist das Ringarchiv voll, 
werden frühere Messdaten überschrieben und gehen verloren. Um dies zu verhindern, können Zeitbereiche 
und die darin enthaltenen Messwerte in einem Permanentarchiv gespeichert werden. Diese Daten können 
auch wieder geladen werden und stehen zu Auswertungszwecken zur Verfügung.

Zusätzlich können Zeitbereiche und die darin enthaltenen Messwerte im CSV-Format (comma separated 
value) gespeichert werden. Dieses Format kann z.B. in einer Tabellenkalkulation geöffnet und weiter bearbeitet 
werden.

Ein Import ist hier nicht möglich. Es kann jedoch ein CSV-Export aus einem Permanentarchiv vorgenommen 
werden.

Gehen Sie in folgenden Schritten vor.

Permanentes Speichern von Zeitbereichen

✧ Wählen Sie das Menü File > Save time range....

Der Dialog Save Time range wird angezeigt.

Bild 3-22 Dialog Save Time range

Der Anfangszeitpunkt Locator left und der Endzeitpunkt Locator right werden automatisch im Dialog ange-
zeigt und können nicht verändert werden.

Eine Änderung des Zeitbereiches ist nur im Fensterbereich PSS Curve möglich.

✧ Geben Sie in das Eingabefeld Time range den Namen des Zeitbereiches ein (z.B. TimeSlice_01), den 
Sie speichern wollen.

✧ Klicken Sie auf die Schaltfläche Save, um den Zeitbereich zu speichern.

Der Zeitbereich wird ggf. als mehrere Dateien und Verzeichnisse abgelegt.

 HINWEIS

Das Speichern kann mehrere Minuten dauern, obwohl das Fenster bereits geschlossen wurde. Die Dauer des 
Speicherns hängt von der Anzahl der Daten ab, die in das Permanentarchiv geschrieben werden müssen, und 
von der Länge des von Ihnen ausgewählten Zeitbereichs.
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Speichen von Zeitbereichen im CSV-Format

✧ Wählen Sie das Menü File > Save to CSV....

Der Dialog Save Csv wird angezeigt.

Bild 3-23 Dialog Save Csv

Der Anfangszeitpunkt Locator left und der Endzeitpunkt Locator right werden automatisch im Dialog ange-
zeigt und können nicht verändert werden.

Eine Änderung des Zeitbereiches ist nur im Fensterbereich PSS Curve möglich.

✧ Geben Sie den Dateinamen in das Eingabefeld File name ein.

✧ Klicken Sie auf die Schaltfläche Save, um den Zeitbereich im CSV-Format zu speichern.

Das Export-Verzeichnis befindet sich auf dem Server und wurde bei der Installation festgelegt. Von einem UI 
aus können Sie dieses Verzeichnis unter dem Pfad \\<servername>\SIGUARD_Export erreichen, um von 
dort aus die Exportdateien zu kopieren bzw. weiterzubearbeiten.

 HINWEIS

Das Speichern kann mehrere Minuten dauern, obwohl das Fenster bereits geschlossen wurde. Die Dauer des 
Speicherns hängt von der Anzahl der Daten ab, die in das Permanentarchiv geschrieben werden müssen, und 
von der Länge des von Ihnen ausgewählten Zeitbereichs.
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3.4.2 Import von Zeitbereichen
.

Zeitbereiche können wieder angewählt werden und stehen dann erneut zur Auswertung zur Verfügung. Sie 
werden nicht mehr in das Ringarchiv geladen.

Laden von Zeitbereichen

✧ Wählen Sie das Menü File > Load time range....

Der Dialog Load Time range wird angezeigt.

Bild 3-24 Dialog Load Time range

Alle verfügbaren Zeitbereiche werden mit Name, Anfangs- und Endzeit in Listenform angezeigt. Das Fenster 
kann in der Größe verändert werden.

 HINWEIS

Der Zeitbereich wird erst dann in der Liste angezeigt, wenn der Export vom Ringarchiv in das Permanentarchiv 
vollständig beendet wurde.

 

✧ Markieren Sie den Zeitbereich, den Sie betrachten/auswerten möchten.

✧ Bestätigen Sie Ihre Auswahl mit Klicken auf die Schaltfläche Ok.

Der geladene Zeitbereich mit den entsprechenden Messwerten wird im Fensterbereich PSS Curve angezeigt.

Diese Anzeige aus dem Permanentarchiv verlassen Sie durch das Anwählen neuer Daten oder durch Darstel-
lung aktueller Werte im Online-Modus.
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

86

http://siemens-russia.com/


Mit SIGUARD PDP UI arbeiten
3.4 Export und Import von Zeitbereichen
3.4.3 Löschen von Zeitbereichen
.

Zeitbereiche und die darin enthaltenen Messwerte, die im Permanentarchiv gespeichert wurden, können 
gezielt gelöscht werden.

Löschen eines Zeitbereiches

✧ Wählen Sie das Menü File > Delete time range....

Der Dialog Delete Time range wird angezeigt.

Bild 3-25 Dialog Delete Time range

Alle verfügbaren Zeitbereiche werden mit Name, Anfangs- und Endzeit in Listenform angezeigt. Das Fenster 
kann in der Größe verändert werden.

✧ Markieren Sie den Zeitbereich, den Sie löschen möchten.

 HINWEIS

Zeitbereiche können nur einzeln gelöscht werden. 

Gelöschte Zeitbereiche können nicht wiederhergestellt werden.

 

✧ Bestätigen Sie Ihre Auswahl mit Klicken auf die Schaltfläche Delete.

Der Zeitbereich mit den entsprechenden Messwerten wird gelöscht und der Dialog geschlossen.
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3.5 Schlussfolgerung aus der Analyse
.

Die Analyse des Beispielereignisses führt zu folgendem Ergebnis:

• Die PSS Curve ist aufgrund von überschrittenen Stromgrenzwerten im roten Bereich, siehe Bild 3-1.

• Ursache für die Überschreitung ist die periodische Zuschaltung einer hohen Last.

• Die periodische Zuschaltung einer hohen Last verursacht Leistungspendelungen, die gut gedämpft sind, 
siehe Bild 3-21.

• Der Stromgrenzwert wird nur kurzfristig überschritten, siehe Bild 3-9.

• Damit es nicht zu ungewollten Auslösungen kommt, müssen die Schutzeinstellungen der Leitung über-
prüft werden. 
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3.6 Bericht erstellen und drucken 
.

Mit der Funktion In Zwischenablage kopieren können Sie Berichte erstellen, abspeichern und ausdrucken. 
Sie fügen dazu die Diagramme zum Beispiel in Microsoft Word ein und kommentieren diese.

✧ Klicken Sie im Fensterbereich Chart View mit der rechten Maustaste auf das Diagramm. 

✧ Wählen Sie aus dem Kontextmenü Copy to Clipboard.

Bild 3-26 Einstellungen für das Metafile

✧ Geben Sie im nächsten Dialog die Bildgröße ein und bestätigen Sie mit OK.

✧ Öffnen Sie mit einem beliebigen Text-Editor ein leeres Dokument oder eine selbst vorbereitete Berichts-
vorlage.

✧ Fügen Sie den Inhalt der Zwischenablage mit <STRG> + <V> in das Dokument ein.

✧ Öffnen Sie die Ereignis- oder die Warnmeldeliste.

✧ Markieren Sie die relevanten Meldungen (einzeln anklicken oder mit Strg-A alle auswählen) und kopieren 
Sie die Meldungen mit Strg+C in die Zwischenablage. 

✧ Fügen Sie die Ereignisse oder Warnmeldungen mit Strg+V in das Dokument ein.

✧ Fügen Sie eigenen Text als Kommentar hinzu. Benutzen Sie dazu die Standardmittel des Text-Editors. 

✧ Speichern Sie das Dokument und drucken Sie es aus.

■
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3.6 Bericht erstellen und drucken
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4.1 Übersicht

Anwendung von SIGUARD PDP Engineer

SIGUARD PDP Engineer ist das Parametrier- und Einstellwerkzeug für SIGUARD PDP. Sie können damit die 
Funktion von SIGUARD PDP einrichten und verändern. Die folgenden Registerkarten stehen für die Bearbei-
tung zur Verfügung:

• PMU
Hinzufügen, duplizieren, ändern oder löschen von physikalischen und logischen PMUs

Hinzufügen oder ändern von Messstellen zu bestehenden oder neuen PMUs

• Calculation
Hinzufügen, duplizieren, ändern oder löschen von berechneten Werten.

Parametrieren von berechneten Werten mittels Faktor und Formel, die Eingangsmesswerte aus den ge-
messenen und berechneten Werten verwendet

• Graphics
Hinzufügen, duplizieren oder löschen von Elementen zur grafischen Darstellung von Stromnetzen

Verwendung von Google-Earth-Funktionen

• Application
Hinzufügen, duplizieren, löschen und parametrieren von verschiedenen Anwendungen:

- Spannungsstabilitätskurve - Voltage-stability curve VSC

- Inselerkennung in Netzwerken (Island State Detection ISD)

- Schwingungserkennung in Netzwerken (Power Swing Recognition PSR)

• Communication
Hinzufügen, duplizieren, löschen und parametrieren der Kommunikation über verschiedenen Schnittstel-
len:

- C37.118

Anlegen von PDC-Servern und logischen PMUs und Konfiguration der Messkanäle

- ICCP

Parametrierung der Kommunikationsparameter, Zuordnung und Parametrierung der Messstellen und 
Zuordnung von Ereignisobjekten.

- OPC

Parametrierung des OPC-Servers und Zuordnung und Parametrierung der Messstellen.

Installation

Das Tool SIGUARD PDP Engineer ist auf DVD verfügbar und wird auf dem Zielrechner zusammen mit dem 
SIGUARD PDP UI installiert (siehe Administrator-Handbuch, Systeminstallation).

Programmfenster

Das Hauptfenster von SIGUARD PDP Engineer gliedert sich in folgende Fensterbereiche:
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E50417-H1000-C419-A3, Ausgabe 11.2011

92

http://siemens-russia.com/


SIGUARD PDP Engineer
4.1 Übersicht
Bild 4-1 Schematische Darstellung des Programmfensters von SIGUARD PDP Engineer

 HINWEIS

Die einzelnen Fensterbereiche verändern Sie in Pfeilrichtung durch Ziehen der Begrenzungslinie.

 

• Menü
Über das Menü rufen Sie allgemeine Funktionen auf (siehe 4.2 Menü).

• Symbolleiste
Über die Symbolleiste rufen Sie Funktionen auf, die innerhalb eines Projekts verwendet werden können 
(siehe 4.3 Symbolleiste).

• Registerkarten
Über die Registerkarten wählen Sie die verschiedenen Konfigurations- und Parametriermöglichkeiten 
aus.

Je nach ausgewählter Registerkarte stehen Ihnen entsprechende Fensterbereiche und Funktionen zur 
Verfügung (siehe 4.4 Phasor Measurement Unit (PMU) bis 4.8.4 OPC).

• Übersicht
Im linken Fensterbereich wird die Baumstruktur der existierenden Elemente für die ausgewählte Register-
karte angezeigt.

• Parameter/Eigenschaften
Im mittleren Fensterbereich werden die Parameter und/oder Eigenschaften des ausgewählten Elements 
angezeigt.

• Listen
Im rechten Fensterbereich werden je nach gewählter Registerkarte Listen angezeigt (z.B. gemessene und 
berechnete Werte oder Elementtypen).
SIGUARD PDP Phasor Data Processing, Handbuch
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4.1 Übersicht
• Fehlermeldungen nach Validierung
Im unteren Fensterbereich Project validation - Errors werden Fehlermeldungen auf Grund der Validie-
rung angezeigt, z.B.:

- Info (Registername): Beschreibung

- Error (Registername): Fehlerbeschreibung

Weitere Informationen siehe 4.9 Gemeinsame Funktionen.

• Aktuelle Fehlermeldungen

Zu jedem Element, das mit einem Warnsymbol  markiert ist, kann eine Kurzinfo (Tooltipp) angezeigt 
werden. Zeigen Sie mit dem Cursor auf das Element. Die Kurzinfo enthält den Elementtyp und eine Be-
schreibung der aufgetretenen Fehler.

Weitere Informationen siehe 4.9 Gemeinsame Funktionen.
SIGUARD PDP Phasor Data Processing, Handbuch
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4.2 Menü
.

Das Menü besteht aus folgenden Menügruppen:

Menügruppe Project

Innerhalb der Menügruppe Project können Sie folgende Funktionen aufrufen:

• Project > New...
Legt ein neues Projekt an

• Project > Open...
Öffnet ein bestehendes Projekt

Sie können nur ein Projekt gleichzeitig öffnen. Wenn Sie ein anderes Projekt öffnen wollen oder ein neues 
Projekt erstellen wollen, müssen Sie den Engineer schließen.

• Project > Save
Speichert Änderungen eines bestehenden Projekts

• Project > Validate
Prüft ein Projekt auf Validierung und zeigt Informationen oder evtl. Fehler im Fensterbereich Project va-
lidation Errors an.

• Project > Print...
Druckt alle Daten eines Projekts (auch als PDF-Format) auf Ihren Drucker.

• Project > Activate
Aktiviert ein bearbeitetes, auf Validierung geprüftes und gespeichertes Projekt für den Runtime-Prozess

• Project > Exit
Beendet das geöffnete Projekt

Wenn das Projekt noch nicht gespeichert wurde, wird eine Sicherheitsabfrage ausgegeben, ob das 
Projekt vor dem Beenden gespeichert werden soll.

Menügruppe Edit

Innerhalb der Menügruppe Edit können Sie folgende Funktionen aufrufen, die auch in der Symbolleiste imple-
mentiert sind:

• Edit > Undo
Macht eine aufgeführte Funktion rückgängig

• Edit > Redo
Stellt eine rückgängig gemachte Funktion wieder her

 HINWEIS

Sie können bis zu 500 Änderungen rückgängig machen.

 

Menügruppe Help

Innerhalb der Menügruppe Help können Sie folgende Funktionen aufrufen:

• Help > Engineer...
Ruft die Hilfefunktion von SIGUARD PDP UI und SIGUARD PDP Engineer auf

• Help > About...
Informiert über die Programmversion von SIGUARD PDP Engineer
SIGUARD PDP Phasor Data Processing, Handbuch
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4.3 Symbolleiste

Schaltflächen

Über die Schaltflächen der Symbolleiste können Sie folgende Funktionen ausführen:

Tabelle 4-1 Symbolleiste von SIGUARD PDP Engineer

Element Erläuterung
Klicken Sie auf die Schaltfläche New, um ein neues Projekt anzulegen.

Klicken Sie auf die Schaltfläche Open, um ein bestehendes Projekt zu 
öffnen.
Klicken Sie auf die Schaltfläche Save, um Änderungen eines bestehen-
den Projekts zu speichern.
Klicken Sie auf die Schaltfläche Validate, um das geöffnete Projekt auf 
Validierung zu prüfen.

Klicken Sie auf die Schaltfläche Undo, um eine ausgeführte Funktion 
rückgängig zu machen.
Klicken Sie auf die Schaltfläche Redo, um eine rückgängig gemachte 
Funktion wiederherzustellen.
Klicken Sie auf die Schaltfläche Print, um alle Daten eines Projekts aus-
zudrucken.
Klicken Sie auf die Schaltfläche Activate, um ein bearbeitetes, auf Vali-
dierung geprüftes und gespeichertes Projekt für den Laufzeitprozess zu 
aktivieren.
SIGUARD PDP Phasor Data Processing, Handbuch
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4.4 Phasor Measurement Unit (PMU)
.

Zum Parametrieren einer PMU müssen folgende Voraussetzungen erfüllt sein:

• Ein existierendes Projekt oder ein neues Projekt muss geöffnet sein.

• Die Registerkarte PMU muss ausgewählt sein.

Registerkarte PMU ist ausgewählt

Wenn Sie die Registerkarte PMU ausgewählt haben, wird das Layout zum Hinzufügen und Bearbeiten von 
physikalischen und logischen PMUs angezeigt.

Bild 4-2 Ausgewählte Registerkarte PMU

• Available PMUs
In linken Fensterbereich wird die Übersicht aller verfügbaren PMUs im Verzeichnis All PMUs angezeigt.

• Selected PMU details
Im mittleren Fensterbereich werden die Parameterdaten der ausgewählten PMU angezeigt. Ist keine PMU 
angelegt oder ausgewählt, ist dieser Fensterbereich grau eingefärbt.

In oberen Teil werden die Parameter der ausgewählten PMU, im unteren Teil die für diese PMU angeleg-
ten Messstellen in Form einer Tabelle angezeigt.

Funktionen

Folgende Funktionen können bei ausgewählter Registerkarte PMU ausgeführt werden:
SIGUARD PDP Phasor Data Processing, Handbuch
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4.4 Phasor Measurement Unit (PMU)
Tabelle 4-2 Funktionen für PMUs

Parameter einer physikalischen PMU

Wenn Sie eine physikalische PMU im Fensterbereich Available PMUs ausgewählt haben, wird folgender 
rechter Fensterbereich angezeigt.

Bild 4-3 Parameter einer physikalischen PMU

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter einer physikalischen 
PMU erläutert.

Tabelle 4-3 Parameter einer physikalischen PMU

Element Erläuterung
Klicken Sie auf die Schaltfläche New, um im markierten Verzeichnis All 
PMUs eine neue physikalische PMU oder innerhalb einer markierten 
physikalischen PMU eine logische PMU anzulegen.
Klicken Sie auf die Schaltfläche Duplicate, um eine markierte physikali-
sche PMU mit gleichem Namen und untergeordneten logischen PMUs 
oder eine markierte logische PMU zu duplizieren.
Klicken Sie auf die Schaltfläche Delete, um eine markierte logische PMU 
oder eine markierte physikalische PMU mit allen untergeordneten logi-
schen PMUs zu löschen.

Element Erläuterung
PMU device name Der Name der physikalischen PMU kann frei gewählt werden.

z.B.: Munich
Hinweis
Achten Sie darauf, dass alle Namen im Gesamtsystem eindeutig sind, 
damit Meldungen in der Ereignis- und Warnmeldeliste eindeutig zuge-
ordnet werden können. Die Eindeutigkeit wird im Rahmen der Validie-
rung überprüft.

PMU device ID ID der angeschlossenen physikalischen PMU
Die Daten müssen aus der Konfiguration der physikalischen PMU über-
nommen werden.
z.B.: 30

IP address IP-Adresse der angeschlossenen physikalischen PMU
Die Daten müssen aus der Konfiguration der physikalischen PMU über-
nommen werden.
z.B.: 192.168.0.109

Port Port, an dem die physikalische PMU angeschlossen ist.
Die Daten müssen aus der Konfiguration der physikalischen PMU über-
nommen werden.
z.B.: 4712
SIGUARD PDP Phasor Data Processing, Handbuch
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4.4 Phasor Measurement Unit (PMU)
Weitere Informationen finden Sie im Literaturverzeichnis unter /1/.

 HINWEIS

Bei fehlender oder fehlerhafter Eingabe ist das Eingabefeld rot hinterlegt.

 

Parameter einer logischen PMU

Wenn Sie eine logische PMU im Fensterbereich Available PMUs ausgewählt haben, wird folgender rechter 
Fensterbereich angezeigt.

Bild 4-4 Parameter einer logischen PMU

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter einer logischen 
PMU erläutert.

Reporting rate Anzahl der Telegramme (Frames), die pro Sekunde von der physikali-
schen PMU übertagen werden.
Die Daten müssen aus der Konfiguration der physikalischen PMU über-
nommen werden.
Sie können den Wert über eine Auswahlliste von 10 Frames/Sekunde bis 
60 Frames/Sekunde einstellen.
Wenn der Wert nicht mit der Konfiguration der physikalischen PMU über-
einstimmt, wird ein Fehler gemeldet und es findet keine Übertragung 
statt.

Timeout Zeit in Sekunden, wie lange auf ein verspätetes Telegramm von der PMU 
gewartet wird.

Communication type Sie können den Kommunikationstyp tcp oder udp über eine Auswahllis-
te auswählen.

UDP port Anzeige nur bei ausgewähltem Kommunikationstyp udp.
z.B.: 4713

Element Erläuterung
SIGUARD PDP Phasor Data Processing, Handbuch
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Tabelle 4-4 Parameter einer logischen PMU

 HINWEIS

Die übrigen Parameterfelder sind nicht aktiv (grau eingefärbt).

 

Messstellen bearbeiten
• Messstellen hinzufügen

Um eine Messstelle hinzuzufügen, klicken Sie in die letzte Zeile der Spalte Name. Geben Sie hier einen 
Namen für die neue Messstelle ein. Eine zusätzliche Leerzeile wird eingefügt, über die eine weitere Mess-
stelle definiert werden kann.

Der Name PMU device der physikalischen PMU und die Logical PMU ID werden automatisch eingetra-
gen. Die Parameter Index, Type und Unit tragen Sie entsprechend der Konfiguration der physikalischen 
PMU ein. Fügen Sie die weiteren Parameter hinzu.

• Messstellen kopieren/einfügen
Zum Kopieren von Messstellen markieren Sie eine oder mehrere Messstellen (Zeilen) in der Tabelle und 
wählen das Kontextmenü Copy.

Zum Einfügen der kopierten Messstellen markieren Sie die Zeile, an der diese eingefügt werden sollen 
und wählen das Kontextmenü Paste. Es werden immer so viele Zeilen inklusive der markierten Zeile über-
schrieben, wie Zeilen eingefügt werden.

• Spaltenreihenfolge
Sie können einzelne Spalten durch horizontales Ziehen der Überschrift an eine andere Stelle in der 
Tabelle verschieben und so die Spaltenreihenfolge verändern.

• Messstellen löschen
Zum Löschen von Messstellen markieren Sie eine oder mehrere Messstellen (Zeilen) in der Tabelle und 
drücken die Taste <Entf>.

 HINWEIS

Achten Sie darauf, dass Sie genau die Messstellen anlegen, die die anzuschließenden PMUs auch wirklich im 
späteren Betrieb verwenden. Ein Vergleich mit den Parametrierdaten der PMUs wird empfohlen.

 

Element Erläuterung
Logical PMU name Der Name der logischen PMU kann frei gewählt werden.

z.B.: Munich DAU1
Hinweis
Achten Sie darauf, dass alle Namen im Gesamtsystem eindeutig sind, 
damit Meldungen in der Ereignis- und Warnmeldeliste eindeutig zuge-
ordnet werden können. Die Eindeutigkeit wird im Rahmen der Validie-
rung überprüft.

Logical PMU ID ID der angeschlossenen logischen PMU
Die Daten müssen aus der Konfiguration der physikalischen PMU über-
nommen werden.
z.B.: 31
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4.4 Phasor Measurement Unit (PMU)
Parameter einer Messstelle

Für jede logische PMU werden im Fensterbereich unter den PMU-Parametern die angelegten Messstellen in 
Form einer Tabelle angezeigt. Sie können nur bei ausgewählter logischer PMU bearbeitet werden.

Bild 4-5 Parameter der Messstellen

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Messstellen er-
läutert.

Tabelle 4-5 Parameter der Messstellen

Element Erläuterung
Name Der Name einer Messstelle kann frei vergeben werden.

z.B.: MchP/400/NbgH/U1
PMU dev name Name des physikalischen PMU

Die Daten werden automatisch übernommen.
z.B.: Munich

Log PMU ID ID der logischen PMU
Die Daten werden automatisch übernommen.
z.B.: 31

Index Der Index ist ein Zeiger auf das von der PMU übertragene Protokoll, um 
die entsprechende Messung zu identifizieren.
Die Daten müssen aus der Konfiguration der physikalischen PMU über-
nommen werden.
z.B.: 7

Type Der Messtyp kann über eine Auswahlliste eingegeben werden.
Zur Auswahl stehen: Phasor, Analog oder Digital.
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

101

http://siemens-russia.com/


SIGUARD PDP Engineer
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Speichern eines Projekts

Nach jeder Änderung oder Neukonfiguration sollten die Daten eines Projekts gespeichert werden. Sie können 
ein Projekt auch dann speichern, wenn die Validierung noch nicht erfolgreich war.

 HINWEIS

Nach dem Speichern eines Projektes werden neu angelegte Messstellen in die Liste Available measure-
ments eingetragen, gelöschte Messstellen werden auch aus dieser Liste gelöscht.

 

Weitere Informationen zum Speichern eines Projektes siehe 4.9 Gemeinsame Funktionen.

Validierung

Aktuelle Fehler können während der Eingabe in Kurzinfos (Tooltipps) angezeigt werden. Eine komplette Vali-

dierung erfolgt über das Menü Projekt > Validate oder über das Symbol . Wenn Fehlermeldungen ange-
zeigt werden, dann müssen Sie die Konfiguration nachbearbeiten. Wenn die Validierung fehlerfrei ist, kann das 
Projekt für den Laufzeitprozess aktiviert werden.

Weitere Informationen zur Validierung eines Projektes siehe 4.9 Gemeinsame Funktionen.

Aktivierung eines Projekts

Nach erfolgreicher Validierung kann ein geöffnetes und gespeichertes Projekt dem Laufzeitprozess zur Verfü-

gung gestellt werden. Dies erfolgt über das Menü Projekt > Activate oder über das Symbol .

Weitere Informationen zur Aktivierung eines Projektes siehe 4.9 Gemeinsame Funktionen.

Unit Die Einheit des Messwertes, der an dieser Messstelle gemessen wird, 
kann je nach Messtyp über eine Auswahlliste eingegeben werden.
z.B.: A für Strom, V für Spannung, W für Wirkleistung, VA für Scheinleis-
tung, VAr für Blindleistung, Degree für den Phasenwinkel, Hz für Fre-
quenz oder Hz/s für die Frequenzänderungsgeschwindigkeit.

Archive Wenn das Kontrollkästchen markiert ist, werden die Messwerte an dieser 
Messstelle im Archiv gespeichert.

Nominal Eingabe des Nennwertes des zu messenden Wertes.
z.B.: 400000
Wenn das Kontrollkästchen markiert ist, wird der Nennwert bei der 
Messung mit einbezogen.

Min1 ... Min3 Definition von bis zu 3 unteren Grenzwerten bezogen auf den Nennwert.
z.B.: 380000, 360000 und 340000.

Max1 ... Max3 Definition von bis zu 3 oberen Grenzwerten bezogen auf den Nennwert.
z.B.: 420000, 430000 und 440000.
Wenn das jeweilige Kontrollkästchen markiert ist, wird der entsprechen-
de Grenzwert bei der Messung mit einbezogen.

Factor PSS Der PSS-Faktor gibt den Einfluss der Messung auf die PSS-Kurve an.
Je höher der PSS-Faktor gewählt wird, umso größer ist der Einfluss auf 
die PSS-Kurve.
Standard = 1

Element Erläuterung
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4.5 Berechnete Werte (Calculated measurements)
.

Zum Anlegen und Bearbeiten von berechneten Werten müssen folgende Voraussetzungen erfüllt sein:

• Ein Projekt muss angelegt oder ein bestehendes Projekt geöffnet sein.

• Die Registerkarte Calculation muss ausgewählt sein.

Registerkarte Calculation ist ausgewählt

Wenn Sie die Registerkarte Calculation ausgewählt haben, wird das Layout zum Hinzufügen und Bearbeiten 
von berechneten Werten angezeigt.

Bild 4-6 Ausgewählte Registerkarte Calculation

• Calculated measurements
Im linken Fensterbereich wird die Übersicht aller bestehenden berechneten Werte im Verzeichnis All cal-
culated objects angezeigt.

• Selected calculated measurements
Im mittleren Fensterbereich werden die Parameterdaten (Name, Factor und Formula) eines ausgewähl-
ten berechneten Wertes angezeigt.

• Available measurements
Im rechten Fensterbereich werden alle verfügbaren Werte Available measurements mit Name, Typ und 
Einheit angezeigt, die für die Eingangsmessgrößen der Formel verwendet werden.
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

103

http://siemens-russia.com/


SIGUARD PDP Engineer
4.5 Berechnete Werte (Calculated measurements)
Funktionen

Folgende Funktionen können bei ausgewählter Registerkarte Calculation und markiertem Element in der Bau-
mansicht über Schaltflächen ausgeführt werden.

Tabelle 4-6 Funktionen für berechnete Werte

Parameter eines berechneten Wertes

Wenn Sie einen berechneten Wert im Fensterbereich Calculated measurements ausgewählt haben, wird fol-
gender mittlerer Fensterbereich angezeigt.

Bild 4-7 Parameter eines berechneten Wertes

Ein berechneter Wert besteht aus dem Namen, der sich aus dem Faktor und der Formel zusammensetzt.

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter des berechneten 
Wertes erläutert.

Element Erläuterung
Klicken Sie auf die Schaltfläche Create a new calculation, um einen 
neuen berechneten Wert im markierten Verzeichnis All calculated 
objects anzulegen.
Klicken Sie auf die Schaltfläche Duplicate a selected calculation, um 
einen markierten berechneten Wert für eine weitere Bearbeitung zu du-
plizieren.
Klicken Sie auf die Schaltfläche Delete the selected calculation oder 
drücken Sie die Taste Entf, um einen markierten berechneten Wert zu 
löschen.
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Tabelle 4-7 Parameter des berechneten Wertes

 HINWEIS

Leere Eingabefelder werden rot hinterlegt. Sie müssen einen Wert eingeben.

 

Berechnete Werte definieren

Wenn ein neu angelegter berechneter Wert noch nicht definiert ist, d.h. noch keine Formel hinterlegt ist, steht 
in der Auswahlliste undefined.

Definieren Sie eine Formel mit den entsprechenden Eingangsmessgrößen. Über die 1. Eingangsmessgröße 
wird der Typ des berechneten Wertes bestimmt (Phasor, Analog oder Digital) und mit der entsprechenden 
Einheit in der Übersicht versehen, sofern die Formel variable Eingangsgrößen erlaubt. Andere Formeln verlan-
gen Eingangsmessgrößen eines genau definierten Typs.

Formeln definieren

Es stehen folgende Formelfunktionen zur Verfügung.

Tabelle 4-8 Übersicht der Formeln für einen berechneten Wert

Element Erläuterung
Name In diesem Feld wird der Name des berechneten Wertes eingegeben, ge-

ändert oder bei einem bestehenden Wert angezeigt. Der Name kann frei 
vergeben werden.
Wenn keine Eingabe erfolgt, wird ein Name automatisch vergeben.

Factor Multiplikator für berechnete Werte
Nur numerische Eingaben mit einem Punkt als Kommastelle sind gültig.

Formula Sie können verschiedene Formelfunktionen auswählen. Hierfür sind ent-
sprechende Eingangsmessgrößen Input measurements erforderlich, 
die über die gemessenen und berechneten Werte definiert werden 
können.

Save results to archive Wenn das Kontrollkästchen markiert ist, wird dieser Wert im Archiv ge-
speichert.
Das Speichern ist nicht unbedingt erforderlich, da der Wert auch aus den 
Eingangsmessgrößen wiederhergestellt werden kann.
Allerdings müssen Sie mit einer längeren Aufrufzeit rechnen, da mehr 
Datenmengen aus dem Archiv geholt werden müssen.

Input measurements Eingangsmessgrößen für die Berechnung, die aus den gemessenen und 
berechneten Werten Available measurements übernommen werden.
Für bestimmte Formeln ist es auch möglich, Konstanten einzugeben.

Element Formel Erläuterung
Active power (six inputs) P = Re{V1*conj(I1)} + 

Re{V2*conj(I2)} + Re{V3*conj(I3)}
Berechnung der Wirkleistung mit 6 
Eingangsmessgrößen

Active power (substation usage) P = Re{(bb1*V1 + bb2*V2 + 
bb3*V3) *conj(I)}

Berechnung der Wirkleistung basie-
rend auf den Sammelschienen-
spannungen (V1 bis V3) und dem 
Strom im Schaltfeld (i) unter Be-
rücksichtigung der Position der 
Sammelschienentrenner (bb1 bis 
bb3)

Active power (two inputs) P = Re{V*conj(I)} Berechnung der Wirkleistung mit 2 
Eingangsmessgrößen

Add two analogs x = a + b Addition von 2 analogen Werten
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Add two phasors X = A + B Addition von 2 Phasoren (jeweils 2 
Spannungen oder 2 Ströme)

Angle difference between two 
phasors

x = deg(A) - deg(B) Berechnung des Phasenwinkels 
zwischen 2 Phasoren

Apparent power (six inputs) S = IV1*conj(I1)I + IV2*conj(I2)I + 
IV3*conj(I3)I

Berechnung der Scheinleistung mit 
6 Eingangsmessgrößen

Apparent power (substation usage) S = I(bb1*V1 + bb2*V2 + bb3*V3) 
*conj(I)I

Berechnung der Scheinleistung ba-
sierend auf den Sammelschienen-
spannungen (V1 bis V3) und dem 
Strom im Schaltfeld (i) unter Be-
rücksichtigung der Position der 
Sammelschienentrenner (bb1 bis 
bb3)

Apparent power (two inputs) S = IV*conj(I)I Berechnung der Scheinleistung mit 
2 Eingangsmessgrößen

Conductance from V and I G = Re{[(V1*I1 - V2*I2) + (V1*I2 - 
V2*I1)] / (V2**2 - V1**2)}

Wirkleitwert (Konduktanz) G einer 
Leitung durch Spannungs- und 
Strommessung am Anfang und 
Ende

Conjugate a phasor X = conj(A) Konjugation eines Phasors (Span-
nung oder Strom)

Divide two analogs x = a/b Division von 2 analogen Werten 
(Zahlen)

Logical AND x = AND(a,b) Logische UND-Verknüpfung zweier 
Digitaleingänge

Logical NOT x = NOT(a) Logische Invertierung eines Digi-
taleingangs

Logical OR x = OR(a,b) Logische ODER-Verknüpfung 
zweier Digitaleingänge

Logical XOR x = XOR(a,b) Logische EXKLUSIV-ODER-Ver-
knüpfung zweier Digitaleingänge

Multiply two analogs X = a*b Multiplikation von 2 analogen 
Werten (Zahlen)

Negative sequence Xneg = (A + a**2*B + a*C)/3 Berechnung der Systemkomponen-
te Gegensystem

Positive sequence Xpos = (A + a*B + a**2*C)/3 Berechnung der Systemkomponen-
te Mitsystem

Power factor lambda = P/S = Re{V*conj(I)} / 
IV*conj(I)I

Berechnung des Leistungsfaktors 
aus Wirkleistung und Scheinleis-
tung und den Eingangsmessgrößen 
Spannung und Strom

Reactance from V and I X = Im{1/Yq} = Im{V1**2 - V2**2) / 
(V1*I2 - V2*I1)}

Blindwiderstand (Reaktanz) X einer 
Leitung durch Spannungs- und 
Strommessung am Anfang und 
Ende

Reactive power (six inputs) Q = Im{V1*conj(I1)} + 
Im{V2*conj(I2)} + Im{V3*conj(I3)}

Berechnung der Blindleistung mit 6 
Eingangsmessgrößen

Reactive power (substation usage) Q = Im{(bb1*V1 + bb2*V2 + 
bb3*V3) *conj(I)}

Berechnung der Scheinleistung ba-
sierend auf den Sammelschienen-
spannungen (V1 bis V3) und dem 
Strom im Schaltfeld (i) unter Be-
rücksichtigung der Position der 
Sammelschienentrenner (bb1 bis 
bb3)

Element Formel Erläuterung
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Eingangsgrößen zuordnen

Je nach Formel wird eine entsprechende Anzahl von Eingabefeldern für die Eingangsmessgrößen Input 
measurements dargestellt. Vor jedem Feld wird der Typ/Einheit des gemessenen oder berechneten Wertes 
Available measurements angezeigt, der diesem Feld zugeordnet werden muss.

Beispiel:

Wird ein Phasor mit einem analogen Wert multipliziert, muss als 1. Eingangsmessgröße ein Phasor zugeordnet 
werden. Der 2. Eingangsmessgröße darf nur ein analoger Wert zugeordnet werden. Andere Zuordnungen sind 
nicht gültig und können auch nicht ausgeführt werden.

Formeln übernehmen

Bei duplizierten berechneten Werten gibt es 2 Möglichkeiten, Formeln und die entsprechenden Eingangsmess-
größen zu definieren:

• Auswahl einer Formel über das Auswahlfeld und Neuzuordnung der Eingangsmessgrößen aus den ge-
messenen und berechneten Werten Available measurements

• Markieren des Inhalts der Auswahlliste durch zweimaliges Anklicken. Dadurch wird die Gruppenfunktion 
aktiviert und die Auswahl der Formel kann über die Tasten <Pfeil nach oben> oder <Pfeil nach unten> 
erfolgen, wobei bereits existierende Eingangsmessgrößen erhalten bleiben und nicht neu zugeordnet 
werden müssen.

 HINWEIS

Die alten Eingangsmessgrößen werden nur übernommen, wenn die Auswahlliste aufgeklappt ist und eine 
Funktion exakt mit gleichen Eingangstypen gewählt wird.

 

Reactive power (two inputs) Q = Im{V*conj(I)} Berechnung der Blindleistung mit 2 
Eingangsmessgrößen

Resistance from V and I R = Re{1/Yq} = Re{(V1**2 - V2**2) / 
(V1*I2 - V2*I1)}

Wirkwiderstand (Resistanz) R einer 
Leitung durch Spannungs- und 
Strommessung am Anfang und 
Ende

Rotate a phasor X = A * Power(e,x) Drehen eines Phasors
Scaling of analog x = m * a + c Skalierung eines analogen Wertes 

a mit Hilfe einer Steigung m und 
eines konstanten Summanden c

Subtract two analogs x = a - b Subtraktion von 2 analogen Werten 
(Zahlen)

Subtract two phasors X = A - B Subtraktion von 2 Phasoren (je-
weils 2 Spannungen oder 2 Ströme)

Susceptance from V and I B = Im{[(V1*I1 - V2*I2) + (V1*I2 - 
V2*I1)] / [V2**2 - V1**2)}

Blindleitwert (Suszeptanz) B einer 
Leitung durch Spannungs- und 
Strommessung am Anfang und 
Ende

Zero sequence Xzero = (A + B + C) / 3 Berechnung der Systemkomponen-
te Nullsystem

Element Formel Erläuterung
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Speichern eines Projekts

Nach jeder Änderung oder Neukonfiguration sollten die Daten eines Projekts gespeichert werden. Sie können 
ein Projekt auch dann speichern, wenn die Validierung noch nicht erfolgreich war.

Weitere Informationen zum Speichern eines Projektes siehe 4.9 Gemeinsame Funktionen.

Validierung

Aktuelle Fehler können während der Eingabe in Kurzinfos (Tooltipps) angezeigt werden. Eine komplette Vali-

dierung erfolgt über das Menü Projekt > Validate oder über das Symbol . Wenn Fehlermeldungen ange-
zeigt werden, dann müssen Sie die Konfiguration nachbearbeiten. Wenn die Validierung fehlerfrei ist, kann das 
Projekt für den Laufzeitprozess aktiviert werden.

Weitere Informationen zur Validierung eines Projektes siehe 4.9 Gemeinsame Funktionen.

Aktivierung eines Projekts

Nach erfolgreicher Validierung kann ein geöffnetes und gespeichertes Projekt dem Laufzeitprozess zur Verfü-

gung gestellt werden. Dies erfolgt über das Menü Projekt > Activate oder über das Symbol .

Weitere Informationen zur Aktivierung eines Projektes siehe 4.9 Gemeinsame Funktionen.
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4.6 Grafische Darstellung von Stromnetzen (Graphics)

4.6.1 Übersicht
.

Zum Anlegen und Bearbeiten von grafischen Darstellungen von Netzwerken müssen folgende Voraussetzun-
gen erfüllt sein:

• Ein Projekt muss angelegt oder ein bestehendes Projekt geöffnet sein.

• Die Registerkarte Graphics muss ausgewählt sein.

Registerkarte Graphics ist ausgewählt

Wenn Sie die Registerkarte Graphics ausgewählt haben, wird das Layout zum Erstellen von Netzwerkgrafiken 
angezeigt.

Bild 4-8 Ausgewählte Registerkarte Graphics

• Elements
Im linken Fensterbereich wird die Übersicht aller bereits bestehenden Elemente im Verzeichnis root an-
gezeigt (z.B. Layer1 für die komplette Grafik oder Teile einer Grafik und Unterelemente für Stationen, Lei-
tungen u.a.). Die Übersicht stellt eine Organisation der grafischen Elemente für ein Netzwerk dar.

• Graphics view
Im oberen Teil des mittleren Fensterbereiches wird Google Earth als Hintergrund geöffnet. Aus den Ele-
menttypen kann ein Netzwerk grafisch über die Landkarte gelegt werden.
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• Element properties
Im unteren Teil des mittleren Fensterbereiches werden die Eigenschaften des markierten Elementes an-
gezeigt.

Die Eigenschaften sind unterteilt in:

- Allgemeine Eigenschaften, Registerkarte Properties

- Eigenschaften der Koordinaten, Registerkarte Coordinates

- Einstellungen für die Kamera, Registerkarte Camera

- Liste der zugeordneten Messungen, Registerkarte Measurements

• Element types
Im oberen Teil des rechten Fensterbereiches wird eine Bibliothek von grafischen Elementen angezeigt. 
Diese Elemente stehen zum Zeichnen einer grafischen Netzstruktur im Fensterbereich Graphics view 
zur Verfügung.

• Available measurements
Im unteren Teil des rechten Fensterbereiches werden alle verfügbaren Messungen Available measure-
ments mit Name, Typ und Einheit angezeigt, die für die Konfiguration der Elementeigenschaften heran-
gezogen werden und je nach Qualität des Messwerts eine Einfärbung bewirken.

Funktionen für Elemente

Folgende Funktionen können zum Bearbeiten der Elemente über Schaltflächen ausgeführt werden.

Tabelle 4-9 Funktionen für Elemente

Element Erläuterung
Klicken Sie auf die Schaltfläche New, um eine neue Grafik New layer im 
Verzeichnis root oder ein Element im markierten Grafikordner anzule-
gen.
Klicken Sie auf die Schaltfläche Duplicate, um eine bestehende Grafik 
oder ein bestehendes Grafikelement zu duplizieren. Die Grafik oder das 
Grafikelement wird am Ende der jeweiligen Gruppe eingefügt.
Klicken Sie auf die Schaltfläche Delete, um eine Grafik oder ein Grafik-
element zu löschen.
Klicken Sie auf die Schaltfläche KML, um Koordinaten für ein Grafikele-
ment im KML-Format zu importieren.
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Funktionen für die grafische Bearbeitung

Die Darstellung eines Netzwerks in der Landkarte ist vergleichbar mit zwei Ebenen aufgebaut, die übereinan-
der liegen:

• Google Earth-Ebene

Darstellung der Landkarte mit den entsprechenden Google Earth-Funktionen

• Benutzer-Ebene

Darstellung des Netzwerks mit den Parametern, die in SIGUARD PDP Engineer in der Registerkarte Gra-
phics definiert werden.

Folgende Funktionen können zur grafischen Bearbeitung der Elemente im Fensterbereich Graphics view über 
Schaltflächen ausgeführt werden.

Bild 4-9 Oberfläche für die Bearbeitung von grafischen Elementen
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Tabelle 4-10 Funktionen für grafische Elemente

Element Erläuterung

Google Earth-Ebene

Klicken Sie auf die Schaltfläche Navigate in map, um innerhalb der 
Landkarte zu navigieren und die Funktion von Google Earth zu nutzen.

Benutzer-Ebene

Klicken Sie auf die Schaltfläche Drag mode, um die Position eines Ele-
ments festzulegen oder zu verändern.
• Element positionieren

- Klicken Sie auf die Schaltfläche Drag mode.
- Markieren Sie einen Layer in der Baumstruktur, unter dem das 

neue Element angelegt werden soll.
- Markieren Sie ein Element im Fenster Element types.
- Ziehen Sie das Element mit Drag & Drop an die gewünschte Posi-

tion in Graphics view.
Das neu positionierte Element erscheint in der Baumstruktur. 
Hierfür können jetzt die Eigenschaften unter Properties definiert 
werden.

• Elementposition verändern
- Klicken Sie auf die Schaltfläche Drag mode.
- Markieren Sie das Element in der Baumstruktur.
- Ziehen Sie das markierte Element mit Drag & Drop in Graphics 

view auf die neue Position.
Das grafische Symbol verändert seine Position.

Benutzer-Ebene

Klicken Sie auf die Schaltfläche Zoom to area, um ein Rechteck zu 
ziehen, dessen Inhalt auf die Größe des Fensterbereiches vergrößert 
wird.

Google Earth-Ebene

Klicken Sie auf die Schaltfläche Zoom in, um die Landkarte stufenweise 
zu vergrößern.

Google Earth-Ebene

Klicken Sie auf die Schaltfläche Zoom out, um die Landkarte stufenwei-
se zu verkleinern.
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4.6.2 Eigenschaften der Elemente
.

Die Parametrierung der Eigenschaften eines Elements ist auf folgende Registerkarten verteilt.

Properties

Auf der Registerkarte Properties stehen folgende Parameter zur Verfügung.

Bild 4-10 Parameter Properties

Tabelle 4-11 Parameter der Registerkarte Properties

Coordinates

Auf der Registerkarte Coordinates stehen folgende Funktionen zur Verfügung.

Bild 4-11 Parameter Coordinates

Element Erläuterung
Internal Name Name des Elements, der in der Übersicht angezeigt wird (Technischer 

Name)
Displayed Name des Elements, der in der Landkarte angezeigt wird (z.B. Berlin)
Description Beschreibung des Elements
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Tabelle 4-12 Funktionen der Registerkarte Coordinates

Element Erläuterung
Klicken Sie auf die Schaltfläche Add Coordinate und in die Landkarte, 
um eine neue Koordinate für dieses Element hinzufügen. Die neue Ko-
ordinate wird unter der markierten Zeile eingefügt.
Die Parameter einer Koordinate werden in einer Tabelle angezeigt. Ein 
Bearbeiten ist hier nicht möglich.
• Longitude

Parameter für die geografische Länge in Grad (Längengrad)
• Latitude

Parameter für die geografische Breite in Grad (Breitengrad)
• Height

Parameter für die Höhe über NN
Klicken Sie auf die Schaltfläche Change Coordinate, um die Position 
eines Elements zu verändern.
• Markieren Sie das Element in der Baumstruktur, dessen Position ver-

ändert werden soll.
• Klicken Sie auf die Schaltfläche Change Coordinate.

Der Cursor erscheint als + -Symbol in Graphics view
• Positionieren Sie den Cursor auf die neue Position und doppelklicken 

Sie die linke Maustaste.
Die neuen Koordinaten werden in die Tabelle übernommen.

Klicken Sie auf die Schaltfläche Fly to coordinate, um eine gespeicherte 
Kameraposition auf ein neues Element zu übertragen und um einzelne 
Koordinaten mit der gespeicherten Kameraposition anzufliegen.
• Doppelklicken Sie auf das Element in der Baumstruktur, dessen Ka-

meraposition (Blickwinkel und Höhe) übernommen werden soll.
Die gewählte Kameraposition wird in Graphics view angezeigt.

• Klicken Sie auf das Element in der Baumstruktur, für das die Kamera-
position (Blickwinkel und Höhe) übernommen werden soll.
Die bisherigen Koordinaten werden angezeigt.

• Klicken Sie auf diese Schaltfläche Fly to coordinate.
Die Kameraposition (Blickwinkel und Höhe) wird auf das neue 
Element übertragen und in Graphics view angezeigt.

Die einzelnen Koordinaten (z.B. einer Leitung) können nun ausgewählt 
werden und die entsprechende Kameraposition angezeigt werden:
• Markieren Sie eine Koordinate und klicken Sie auf die Schaltfläche 

Fly to coordinate
• Doppelklicken Sie auf eine Koordinate (Zeile).

Die Kameraposition (Blickwinkel und Höhe) der markierten Koordinate 
wird in Graphics view angezeigt.
Während des Abfahrens der Leitung kann die Kamerahöhe über die 
Google-Funktion angepasst werden. Das nächste Betätigen der Schalt-
fläche Fly to Coordinate wird sich das merken.
Klicken Sie auf die Schaltfläche Remove Coordinate, um eine markierte 
Koordinate für dieses Element zu löschen.
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Camera

Die Kameraposition ist die Blickweise auf ein Element in Google Earth. Die Einstellung erfolgt durch einen Dop-
pelklick auf das Element und Scrollen in horizontale oder vertikale Richtung.

Auf der Registerkarte Camera stehen folgende Funktionen für die Konfiguration der Kameraposition eines Ele-
ments zur Verfügung.

Bild 4-12 Einstellungen für die Kameraposition

Tabelle 4-13 Funktionen der Registerkarte Camera

Measurements

Auf der Registerkarte Measurements werden die Messstellen angezeigt, die für dieses Element definiert 
wurden. Damit stellen Sie die Verknüpfung des grafischen Elements zu den Messkanälen her.

Bild 4-13 Parameter Measurements

Element Erläuterung
Klicken Sie auf die Schaltfläche Set, um die eingestellte Kameraposition 
für ein Element zu speichern.
Um diese Kameraposition wieder in Graphics view anzuzeigen, dop-
pelklicken Sie auf das Element in der Baumstruktur.
Klicken Sie auf die Schaltfläche Clear, um die eingestellte Kameraposi-
tion für ein Element zu löschen.
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Tabelle 4-14 Funktionen der Registerkarte Measurements

Um Messstellen zu löschen, markieren Sie eine Messstelle (Zeile) und klicken auf die entsprechende Schalt-

fläche .

4.6.3 Elementtypen
.

Im rechten oberen Fensterbereich Element types der Registerkarte Graphics stehen Ihnen verschiedene 
Typen von Elementen für die Erstellung einer grafischen Netzwerkstruktur zur Verfügung.

Bild 4-14 Übersicht der Elementtypen

Tabelle 4-15 Funktionen der Registerkarte Measurements

Speichern eines Projekts

Nach jeder Änderung oder Neukonfiguration sollten die Daten eines Projekts gespeichert werden. Sie können 
ein Projekt auch dann speichern, wenn die Validierung noch nicht erfolgreich war.

Weitere Informationen zum Speichern eines Projektes siehe 4.9 Gemeinsame Funktionen.

Element Erläuterung
MeasurementName Zuordnung der Messstellen

Die Messstellen werden aus Available measurements in die Spalte 
MeasurementName übernommen und so für dieses Grafikelement defi-
niert. Die Qualität der Messwerte ist verantwortlich für die Einfärbung der 
Elemente in SIGUARD PDP UI. Die Messstellen können hier nicht bear-
beitet werden.

MeasurementType Typ der Messstelle (z.B. Phasor, analoger oder digitaler Messwert, be-
rechneter analoger oder digitaler Messwert).

Element Erläuterung
Layer Ordner für Grafikelemente
Substation Element für eine Station
PMU Element für eine Phasor Measuring Unit (PMU)
Generator Element für einen Stromerzeuger
Compensator Element für einen Static Var Compensator SVC
Line (5 pixel) Element für eine dicke Leitung (Sammeldarstellung von parallelen Sys-

temen)
Line (3 pixel) Element für eine dünne Leitung (Einzelleitung)
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Validierung

Aktuelle Fehler können während der Eingabe in Kurzinfos (Tooltipps) angezeigt werden. Eine komplette Vali-

dierung erfolgt über das Menü Projekt > Validate oder über das Symbol . Wenn Fehlermeldungen ange-
zeigt werden, dann müssen Sie die Konfiguration nachbearbeiten. Wenn die Validierung fehlerfrei ist, kann das 
Projekt für den Laufzeitprozess aktiviert werden.

Weitere Informationen zur Validierung eines Projektes siehe 4.9 Gemeinsame Funktionen.

Aktivierung eines Projekts

Nach erfolgreicher Validierung kann ein geöffnetes und gespeichertes Projekt dem Laufzeitprozess zur Verfü-

gung gestellt werden. Dies erfolgt über das Menü Projekt > Activate oder über das Symbol .

Weitere Informationen zur Aktivierung eines Projektes siehe 4.9 Gemeinsame Funktionen.
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4.7 Applikationen (Applications)

4.7.1 Übersicht
.

Zum Konfigurieren und Parametrieren von Applikationen müssen folgende Voraussetzungen erfüllt sein:

• Ein existierendes Projekt oder ein neues Projekt muss geöffnet sein.

• Die Registerkarte Application muss ausgewählt sein.

Registerkarte Application ist ausgewählt

Wenn Sie die Registerkarte Application ausgewählt haben, wird das Layout zum Hinzufügen und Bearbeiten 
von Applikationen angezeigt.

Bild 4-15 Ausgewählte Registerkarte Application

• Existing Applications
Im linken Fensterbereich werden alle verfügbaren Applikationen als Ordner angezeigt:

- Inselerkennungen (ISDs)

- Schwingungserkennungen (PSRs)

- Spannungsstabilitätskurven (VSCs)

• Selected Application
Im mittleren Fensterbereich werden die Parameterdaten der ausgewählten Applikation angezeigt.
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• Available measurements
Im rechten Fensterbereich werden alle verfügbaren Messungen Available measurements mit Name, 
Typ und Einheit angezeigt, die für Messgrößen innerhalb der Konfiguration der Applikationen verwendet 
werden.

4.7.2 Inselerkennung (Island State Detection ISD)
.

Für die Konfiguration der Inselerkennung wird der Ordner ISDs markiert und ein Name für den Ordner ISDs 
definiert:

Bild 4-16 Name für Ordner ISDs vergeben

Jetzt wird der Ordner ISDs geöffnet und eine Inselerkennung ausgewählt.

 HINWEIS

Beachten Sie, dass Sie für die Funktion von ISD eine entsprechende SIGUARD PDP-Lizenz benötigen. Die 
Existenz dieser Lizenz wird im SIGUARD PDP Engineer nicht abgefragt.
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Funktionen

Folgende Funktionen können bei markiertem Ordner ISDs oder markierter Inselerkennung über Schaltflächen 
ausgeführt werden.

Tabelle 4-16 Symbolleiste der Applikation ISDs

Parameter einer Applikation ISDs

Wenn Sie den Ordner ISDs geöffnet und eine Inselerkennung ausgewählt haben, wird folgender mittlerer 
Fensterbereich Application - Island detection angezeigt:

Bild 4-17 Parameter der Applikation ISDs

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Applikation ISDs 
erläutert.

Element Erläuterung
Klicken Sie auf die Schaltfläche New Island Detection, um ein Konfigu-
rationsschema für eine neue Applikation Inselerkennung im Ordner 
ISDs anzulegen.
Klicken Sie auf die Schaltfläche Duplicate Island Detection, um eine 
Konfiguration einer bestehenden Applikation Inselerkennung für eine 
weitere Bearbeitung zu duplizieren.
Klicken Sie auf die Schaltfläche Delete Island Detection, um die Konfi-
guration für eine Applikation Schwingungserkennung zu löschen.
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Tabelle 4-17 Parameter der Applikation ISDs

Konfiguration von Sites

Eine Site ist die Zusammenfassung von Messstellen einer PMU.

Sie besteht aus den Messstellen für eine Frequenz (f) und eine Frequenzänderungsgeschwindigkeit (df/dt). Um 
Frequenzen oder Frequenzänderungsgeschwindigkeiten vergleichen zu können, müssen deshalb mindestens 
zwei Sites pro Applikation Inselerkennung angelegt und aktiv geschaltet werden.

Element Erläuterung
Name In diesem Feld wird der Name der Applikation Inselerkennung eingege-

ben, geändert oder für eine bestehende Applikation angezeigt.
Active Wenn das Kontrollkästchen markiert ist, wird die Applikation aktiv ge-

schaltet.
Time constant Zeitkonstante für die statische (Standard = 1) und dynamische Inseler-

kennung (Standard = 0.2) in Sekunden
Limit for Network Split Oberer Grenzwert in Hz für die statische Inselerkennung

Wenn der Frequenzunterschied von mindestens 2 in der Größe benach-
barten Frequenzen größer als der obere Grenzwert 
(Standard = 0.05 Hz) ist, wird eine Insel erkannt.

Limit for Potential Network Split 
(statische Inselerkennung)

Unterer Grenzwert in Hz für statische Inselerkennung
Wenn der Frequenzunterschied von mindestens 2 in der Größe benach-
barten Frequenzen kleiner als der untere Grenzwert 
(Standard = 0.01 Hz) ist, wird keine Insel erkannt. 
Wenn der Frequenzunterschied von mindestens 2 in der Größe benach-
barten Frequenzen zwischen dem unteren und dem oberen Grenzwert 
liegt, besteht ein möglicher Netzzerfall.
Wenn das Kontrollkästchen markiert ist, wird bei Überschreitung des 
Grenzwertes eine Meldung ausgelöst.

Limit for Potential Network Split (dy-
namische Inselerkennung)

Grenzwert in Hz für dynamische Inselerkennung
Wenn der Unterschied von mindestens 2 benachbarten Werten der Fre-
quenzänderungsgeschwindigkeit größer als der Grenzwert 
(Standard = 0.001 Hz/s) ist, liegt ein möglicher Netzzerfall vor (Inseler-
kennung). 
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Bild 4-18 Konfiguration von Sites für die Inselerkennung

 HINWEIS

Leere Eingabefelder werden rot hinterlegt. Hier müssen Messstellen per Drag & Drop eingefügt werden.

 

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Sites erläutert.

Tabelle 4-18 Parameter der Sites

Element Erläuterung
Site Die Nummerierung erfolgt automatisch.
f Sortieren Sie die Liste Available measurements nach dem Typ.

Fügen Sie eine Messstelle für die Frequenz (f) aus Available measure-
ments ein.
Es wird geprüft, ob auch eine Messstelle für die Frequenz eingefügt wird. 
Die Messstelle kann von verschiedenen PMUs kommen.

df/dt Sortieren Sie die Liste Available measurements nach dem Typ.
Fügen Sie eine Messstelle für die Frequenzänderungsgeschwindigkeit 
(df/dt) aus Available measurements ein.
Es wird geprüft, ob auch eine Messstelle für die Frequenzänderungsge-
schwindigkeit eingefügt wird. Die Messstelle kann von verschiedenen 
PMUs kommen.

Active Wenn das Kontrollkästchen markiert ist, erfolgt die Berücksichtigung der 
entsprechenden Messstelle für die Auswertung zur Inselerkennung.
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4.7.3 Schwingungserkennung (Power Swing Recognition PSRs)
.

Für die Konfiguration der Schwingungserkennung wird der Ordner PSRs markiert und ein Name für den Ordner 
PSRs definiert:

Bild 4-19 Name für Ordner PSRs vergeben

Jetzt wird der Ordner PSRs geöffnet und eine Schwingungserkennung ausgewählt.

 HINWEIS

Beachten Sie, dass Sie für die Funktion von PSR eine entsprechende SIGUARD PDP-Lizenz benötigen. Die 
Existenz dieser Lizenz wird im SIGUARD PDP Engineer nicht abgefragt.

 

Funktionen

Folgende Funktionen können bei markiertem Ordner PSRs oder markierter Schwingungserkennung über 
Schaltflächen ausgeführt werden.

Tabelle 4-19 Symbolleiste der Applikation PSRs

Element Erläuterung
Klicken Sie auf die Schaltfläche New Power Swing Recognition, um ein 
Konfigurationsschema für eine neue Applikation Schwingungserken-
nung im Ordner PSRs und einen untergeordneten Job anzulegen.
Klicken Sie auf die Schaltfläche Duplicate Power Swing Recognition, 
um eine Konfiguration einer bestehenden Applikation Schwingungser-
kennung für eine weitere Bearbeitung zu duplizieren.
Klicken Sie auf die Schaltfläche Delete Power Swing Recognition, um 
eine Konfiguration für eine Applikation Inselerkennung zu löschen.
SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

123

http://siemens-russia.com/


SIGUARD PDP Engineer
4.7 Applikationen (Applications)
Parameter einer Applikation PSRs

Wenn Sie den Ordner PSRs geöffnet und eine neue Schwingungserkennung geöffnet haben, wird folgender 
mittlerer Fensterbereich Application Power Swing Recognition angezeigt:

Bild 4-20 Parameter der Applikation PSRs

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Applikation 
PSRs erläutert.

Tabelle 4-20 Parameter der Applikation PSRs

Parameter eines PSR-Auftrags

Wenn Sie den PSR-Auftrag ausgewählt haben, wird folgender mittlerer Fensterbereich Application Power 
Swing Recognition angezeigt:

Element Erläuterung
PSR Name In diesem Feld wird der Name der Applikation Schwingungserkennung 

eingegeben, geändert oder für eine bestehende Applikation angezeigt.
Active Wenn das Kontrollkästchen markiert ist, wird die Applikation aktiv ge-

schaltet.
ISD Wenn das Kontrollkästchen markiert ist, werden Ergebnisse der Applika-

tion ISD (Island State Detection) verwendet, indem Berechnungen von 
Jobs, deren Eingangsgrößen in 2 verschiedenen Inseln liegen, unter-
drückt werden.
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Bild 4-21 Parameter des PSR-Auftrags

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter eines PSR-Auf-
trags erläutert.

Tabelle 4-21 Parameter eines PSR-Auftrags

Element Erläuterung
Job Name In diesem Feld wird der Name des PSR-Auftrags eingegeben, geändert 

oder für einen bestehenden PSR-Auftrag angezeigt.
Active Wenn das Kontrollkästchen markiert ist, wird der PSR-Auftrag aktiv ge-

schaltet.
ISD Wenn das Kontrollkästchen markiert ist, wird die Bearbeitung dieses 

Jobs eingestellt, wenn die ISD erkannt hat, dass die Eingangswerte in 
verschiedenen Inseln liegen.
Nur wirksam bei Jobs im Job Mode Phase Angle.

Job Mode PSR kennt 2 verschiedene Job Modes:
• Active Power:

Es werden Spannung und Strom an einem PMU-Standort miteinander 
verknüpft. Die daraus berechnete Wirkleistung wird auf Schwingun-
gen untersucht.

• Phase Angle:
Es werden die Spannungen an 2 verschiedenen Standorten miteinan-
der verknüpft. Die daraus berechnete Spannungswinkeldifferenz wird 
auf Schwingungen untersucht.

Thresholds/Events, nominal Dieser Nennwert wird als Bezugsgröße für die unten angegebenen rela-
tiven Schwellwerte für die Warnung oder den Alarm basierend auf der 
Amplitude verwendet. Siehe auch Bild 1-10 in Kapitel 1.5 SIGUARD PDP 
Pendelerkennung (PSR).

Threshold - Magnitude/Alarm Wenn dieser Relativwert für die Amplitude überschritten wird, dann wird 
diese Schwingung in die 1. Zeile der DOE-Tabelle eingestuft. Bezugs-
größe ist der Nennwert, siehe oben. Siehe auch Bild 1-10 in Kapitel 
1.5 SIGUARD PDP Pendelerkennung (PSR).
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Eingangsparameter

Nachdem die allgemeinen Parameter für den PSR-Auftrag festgelegt wurden, müssen im mittleren Fenster-
bereich Application Power Swing Recognition die Inputs (Messwerte für Spannung und Strom) für jede 
Phase definiert werden.

Bild 4-22 Eingangsparameter für die Phasen

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Inputs erläutert.

Threshold - Magnitude/Warning Wenn dieser Relativwert für die Amplitude überschritten wird, dann wird 
diese Schwingung in die 2. Zeile der DOE-Tabelle eingestuft. Bezugs-
größe ist der Nennwert, siehe oben. Siehe auch Bild 1-10 in Kapitel 
1.5 SIGUARD PDP Pendelerkennung (PSR).

Threshold - Damping Ratio/Alarm Wenn dieser Wert für den Dämpfungsfaktor überschritten wird, dann wird 
diese Schwingung in die 3. Spalte der DOE-Tabelle eingestuft. Beachten 
Sie, dass dieser Wert negativ sein muss. Siehe auch Bild 1-10 in Kapitel 
1.5 SIGUARD PDP Pendelerkennung (PSR).

Threshold - Damping Ratio/War-
ning

Wenn dieser Wert für den Dämpfungsfaktor überschritten wird, dann wird 
diese Schwingung in die 2. Spalte der DOE-Tabelle eingestuft. Beachten 
Sie, dass dieser Wert negativ sein muss. Siehe auch Bild 1-10 in Kapitel 
1.5 SIGUARD PDP Pendelerkennung (PSR).

Element Erläuterung
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Tabelle 4-22 Parameter der Eingangsgrößen

Modes für den Job festlegen

Nach der Definition der Eingangsgrößen, müssen im mittleren Fensterbereich Application Power Swing Re-
cognition die Modes 1 definiert werden.

Hierzu wird ein Mode-Name definiert. Die dazugehörenden Outputs werden automatisch angelegt.

Bild 4-23 Definition der Mode-Namen/Outputs

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Modes erläutert.

Element Erläuterung
Inputs L1 - L3 Für jede Phase werden aus den Available measurements folgende 

Messstellen definiert:
• Eine Messstelle Voltage 1 und eine Messstelle Current für den Job 

Mode Active Power
• Eine Messstelle Voltage 1 und Voltage 2 für den Job Mode Phase 

Angle

Diese Werte werden per Drag & Drop aus den Available measure-
ments in die Tabelle gezogen. Felder, in denen Werte stehen müssen, 
werden rot markiert.

Only one Phase Wenn das Kontrollkästchen markiert ist, werden die Phasen 2 und 3 aus-
geblendet. Es ist nur Phase 1 aktiv.

1. Vorhandene Schwingungen können aus Teilschwingungen unterschiedlicher Frequenz zusammengesetzt sein. Diese 
Teilschwingungen werden auch als Schwingungsmode bezeichnet.
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Tabelle 4-23 Parameter der Eingangsgrößen

Modes selektieren

Um bei mehreren Modes die Übersicht zu behalten, kann die komplette Zeile für einen Mode markiert werden, 
z.B. Mode2. Somit werden nur noch die Outputs für Mode2 angezeigt.

Bild 4-24 Selektierter Mode/Outputs

Element Erläuterung
Name Wenn ein Name für den Mode, z.B. Mode4 eingegeben wird, werden 

hierfür die entsprechenden Outputs angelegt (Einträge für die Typen:
• Frequenz
• Magnitude
• Damping Ratio
• Degree of Exposure

Frequency band Wenn das Kontrollkästchen markiert ist, werden die Felder für Maximum 
frequency und Minimum frequency für die maximale und minimale 
Frequenz freigegeben.

Minimum frequency Minimale Frequenz
Schwingungen mit einer Eigenfrequenz größer als diese minimale Fre-
quenz und kleiner als die maximale Frequenz Maxf werden bevorzugt 
diesem Mode zugewiesen.

Maximum frequency Maximale Frequenz
Schwingungen mit einer Eigenfrequenz größer als die minimale Fre-
quenz Minf und kleiner als diese maximale Frequenz werden bevorzugt 
diesem Mode zugewiesen.
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Tabelle 4-24 Parameter der Ausgangsgrößen

Weitere Informationen zum Speichern, Validieren und Aktivieren eines Projektes finden Sie im Kapitel 
4.9 Gemeinsame Funktionen.

4.7.4 Spannungsstabilitätskurve (Voltage-Stability Curve VSC)
.

Für die Konfiguration zur Darstellung einer Spannungsstabilitätskurve wird der Ordner VSCs markiert und ein 
Name für den Ordner VSCs definiert:

Bild 4-25 Name für Ordner VSCs vergeben

Jetzt wird der Ordner VSCs geöffnet und eine Kurve ausgewählt.

Element Erläuterung
Mode Wenn ein Name für den Mode, z.B. Mode4 markiert wird, werden hierfür 

die entsprechenden Outputs angezeigt mit dem Namen des Modes.
Type Typ der Ausgangsgröße (z.B. Frequenz, Amplitude, Dämpfung)
Name Name der Ausgangsgröße
Archive Markierung, damit die Ausgangsgröße im Archiv gespeichert wird.
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Funktionen

Folgende Funktionen können bei markiertem Ordner VSCs oder markierter Spannungsstabilitätskurve über 
Schaltflächen ausgeführt werden.

Tabelle 4-25 Symbolleiste der Applikation VSCs

Parameter einer Applikation VSCs

Folgende Konfigurationen zur Darstellung einer Spannungsstabilitätskurve sind möglich:

• Konfiguration mit Eingangsmessgrößen und Leitungsparameter (1 PMU)

• Konfiguration mit Eingangsmessgrößen und Ausgangsmessgrößen (2 PMU)

Wenn Sie den Ordner VSCs im Fensterbereich Existing Applications geöffnet, eine Spannungsstabilitätskur-
ve ausgewählt und das Kontrollkästchen 1 PMU markiert haben, wird folgender mittlerer Fensterbereich 
Voltage-stability curves angezeigt:

Bild 4-26 Parameter der Applikation VSCs mit Eingangsmessgrößen (1 PMU) und Leitungsparameter

Element Erläuterung
Klicken Sie auf die Schaltfläche New Voltage Stability Curve, um ein 
Konfigurationsschema für eine neue Spannungsstabilitätskurve im 
Ordner VSCs anzulegen.
Klicken Sie auf die Schaltfläche Duplicate Voltage Stability Curve, um 
eine Konfiguration einer bestehenden Spannungsstabilitätskurve für 
eine weitere Bearbeitung zu duplizieren.
Klicken Sie auf die Schaltfläche Delete Voltage Stability Curve, um 
eine Konfiguration für eine bestehende Spannungsstabilitätskurve zu lö-
schen.
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 HINWEIS

Leere Eingabefelder werden rot hinterlegt. Sie müssen einen Wert eingeben.

 

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Applikation 
VSCs mit Eingangsmessgrößen erläutert.

Tabelle 4-26 Parameter der Applikation VSCs

Wenn Sie die Applikation VSCs im Fensterbereich Existing Applications ausgewählt und das Kontrollkäst-
chen 2 PMU markiert haben, wird folgender mittlerer Fensterbereich angezeigt.

Element Erläuterung
1 PMU Dieses Kontrollkästchen ist ausgewählt, wenn die Spannungsstabilitäts-

kurve mit einer Eingangsmessgröße und den Leitungsparametern be-
rechnet werden soll.

Name In diesem Feld wird der Name der Spannungsstabilitätskurve eingege-
ben, geändert oder für eine bestehende Spannungsstabilitätskurve an-
gezeigt.

Pmax Eingabe der maximalen Wirkleistung für die betrachtete Leitung in Me-
gawatt (MW).

Vmax Eingabe der maximalen Spannung für die betrachtete Leitung in Kilovolt 
(kV)

Vin Messgröße der Spannung am Eingang der Leitung aus Available 
measurements

Iin Messgröße des Stroms am Eingang der Leitung aus Available measu-
rements

R Wirkwiderstand der Leitung in Ohm
X Blindwiderstand der Leitung in Ohm
G Wirkleitwert der Leitung in Mikro-Siemens
B Blindleitwert der Leitung in Mikro-Siemens
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Bild 4-27 Parameter der Applikation VSCs mit Ein- und Ausgangsmessgrößen (2 PMU)

 HINWEIS

Leere Eingabefelder werden rot hinterlegt. Eine Eingabe wird erwartet.

 

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Applikation 
VSCs mit Ein- und Ausgangsmessgrößen erläutert.

Tabelle 4-27 Parameter der Applikation VSCs

Element Erläuterung
2 PMU Dieses Kontrollkästchen ist ausgewählt, wenn die Spannungsstabilitäts-

kurve mit einer Ein- und Ausgangsmessgröße berechnet werden soll.
Name In diesem Feld wird der Name der Spannungsstabilitätskurve eingege-

ben, geändert oder für eine bestehende Spannungsstabilitätskurve an-
gezeigt.

Pmax Eingabe der maximalen Wirkleistung für die betrachtete Leitung in Me-
gawatt (MW).

Vmax Eingabe der maximalen Spannung für die betrachtete Leitung in Kilovolt 
(kV)

Vin Messgröße der Spannung am Eingang der Leitung aus Available 
measurements

Iin Messgröße des Stroms am Eingang der Leitung aus Available measu-
rements
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Vout Messgröße der Spannung am Ausgang der Leitung aus Available 
measurements

Iout Messgröße des Stroms am Ausgang der Leitung aus Available measu-
rements

Element Erläuterung
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4.8 Kommunikation (Communication)

4.8.1 Übersicht
.

Zum Konfigurieren und Parametrieren von Kommunikationsschnittstellen müssen folgende Voraussetzungen 
erfüllt sein:

• Ein existierendes Projekt oder ein neues Projekt muss geöffnet sein.

• Die Registerkarte Communication muss ausgewählt sein.

Registerkarte Communication ist ausgewählt

Wenn Sie die Registerkarte Communication ausgewählt haben, wird das Layout zum Hinzufügen und Bear-
beiten von Kommunikationsschnittstellen angezeigt.

Bild 4-28 Ausgewählte Registerkarte Communication

• Available communication interfaces
Im linken Fensterbereich werden alle verfügbaren Kommunikationsschnittstellen als Ordner angezeigt:

- C37.118

- ICCP

- OPC

• Selected Application
Im mittleren Fensterbereich werden die Parameterdaten der ausgewählten Kommunikationsschnittstellen 
angezeigt.
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• Available measurements
Im rechten Fensterbereich werden alle verfügbaren Messungen Available measurements mit Name, 
Typ und Einheit angezeigt, die für Messgrößen innerhalb der Konfiguration der Applikationen verwendet 
werden.

4.8.2 Protokoll C37.118
.

Die Funktion des PDC-Servers ist die folgende: 

SIGUARD PDC sendet Daten im Protokoll IEEE C37.118 an andere PDCs. Damit können die Daten von 
SIGUARD PDP auch von anderen PDCs verwendet werden.

Für die Konfiguration von Kommunikationsschnittstellen wird der Ordner C37118 markiert und ein Name für 
den Ordner C37118 vergeben.

Bild 4-29 Name für Ordner C37118

Jetzt wird der Ordner C37118 geöffnet und eine Schnittstelle ausgewählt.
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Funktionen

Folgende Funktionen können bei ausgewähltem Ordner C37118 ausgeführt werden.

Tabelle 4-28 Funktionen für PDC-Server und logischen PMUs

Parameter des PDC-Servers

Wenn Sie einen PDC-Server im Fensterbereich PDCServers and log. PMUs ausgewählt haben, wird folgen-
der mittlerer Fensterbereich angezeigt.

Bild 4-30 Parameter eines PDC-Servers

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter eines PDC-Servers 
erläutert.

Element Erläuterung
Klicken Sie auf die Schaltfläche New, um einen neuen PDC-Server
oder
um bei markiertem PDC-Server hierfür eine untergeordnete logische 
PMU anzulegen.
Klicken Sie auf die Schaltfläche duplicate, um bei markiertem PDC-
Server ein Duplikat mit gleichem Namen und untergeordneten logischen 
PMUs anzulegen
oder
um eine markierte logische PMU zu duplizieren.
Klicken Sie auf die Schaltfläche del, um einen markierten PDC-Server 
mit den untergeordneten logischen PMUs
oder
um eine markierte logische PMU zu löschen.
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Tabelle 4-29 Parameter eines PDC-Servers

 HINWEIS

Bei fehlender Eingabe ist das Eingabefeld rot hinterlegt. Sie müssen einen Wert eingeben.

 

Element Erläuterung
PDCServer name Sie können den Namen des PDC-Servers frei wählen. Dieser Name wird 

als PDC Server Name in das Protokoll IEEE C37.118 eingetragen und 
wird mit dem Kommunikationspartner vereinbart. Er muss nicht eindeutig 
sein (vgl. Internal name).
z.B.: SIGUARD

PDCServer ID ID des angeschlossenen PDC-Servers
Diese ID wird als PDCID in das Protokoll IEEE C37.118 eingetragen und 
wird mit dem Kommunikationspartner vereinbart.
z.B.: 111

Local IP address IP-Adresse, unter welcher der PDC-Server von außen erreichbar ist. Mit 
Hilfe dieser IP-Adresse wird festgelegt, mit welcher LAN-Schnittstelle 
nach außen kommuniziert wird. Wenn nur eine Schnittstelle vorhanden 
ist, dann müssen Sie die IP-Adresse des Servers eintragen. z.B. 
55.26.213.186

Local port Port-Nummer, unter welcher der PDC-Server von außen erreichbar ist.
z.B.: 4712

Remote IP Address IP-Adresse des fremden PDC-Servers (Client aus Sicht des 
SIGUARD PDC Servers).
Nur ein PDC-Server mit dieser IP-Adresse kann eine Verbindung zum 
lokalen SIGUARD PDC Server aufnehmen.

Internal name Dieser Name muss eindeutig sein und darf nicht bei anderen Objekten 
(z.B. Messwert, Berechnung, etc.) vorkommen.

Reporting rate Anzahl der Telegramme, die pro Sekunde vom PDC-Server übertagen 
werden.
Die Reporting rate muss mit dem Kommunikationspartner vereinbart 
werden.
ACHTUNG 
Beachten Sie, dass nicht alle Kombinationen möglich sind. Welcher Wert 
erlaubt ist, hängt von der Reporting rate der zu übertragenden Werte 
ab.
Sie können den Wert über eine Auswahlliste von 10 bis 60 Werte pro 
Sekunde einstellen.
Wenn der Wert nicht mit der Konfiguration des PDC-Servers überein-
stimmt, wird ein Fehler gemeldet und es findet keine Übertragung statt.

Communication type Über eine Auswahlliste kann der Kommunikationstyp tcp oder udp aus-
gewählt werden.
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Parameter einer logischen PMU

Wenn Sie eine logische PMU im Fensterbereich PDCServers and log. PMUs ausgewählt haben, wird folgen-
der mittlerer Fensterbereich angezeigt.

Bild 4-31 Parameter einer logischen PMU und der Messkanäle

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter einer logischen 
PMU erläutert.

Tabelle 4-30 Parameter einer logischen PMU

 HINWEIS

Die übrigen Parameterfelder sind nicht aktiv (grau eingefärbt), weil sie hier nicht parametrierbar sind.

 

Element Erläuterung
Station name Sie können den Namen der logischen PMU kann frei wählen. Dieser 

Name wird als PDC Station Name in das Protokoll IEEE C37.118 einge-
tragen und wird mit dem Kommunikationspartner vereinbart. Er muss 
nicht eindeutig sein (im Gegensatz zu Internal name).
z.B.: SIGUARD PMU1

log. PMU ID ID der angeschlossenen logischen PMU
Diese ID wird als PMUID in das Protokoll IEEE C37.118 eingetragen und 
wird mit dem Kommunikationspartner vereinbart. 
z.B.: 112

Nominal frequency Nennfrequenz der Station
z.B.: 50 Hz
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Messkanäle bearbeiten
• Messkanal hinzufügen

Um einen Messkanal hinzuzufügen, fügen Sie in die letzte Zeile der Spalte Measurement eine Messstelle 
aus Available measurements ein. Eine zusätzliche neue Leerzeile wird eingefügt, über die ein weiterer 
Messkanal definiert werden kann.

• Messkanal löschen
Zum Löschen von Messkanälen markieren Sie einen Messkanal (Zeile) in der Tabelle und drücken die 
Taste <Entf> oder wählen Sie das Kontextmenü delete.

• Sortieren nach Spalteninhalten
Die Liste der Messkanäle kann nach den Inhalten einzelner Spalten sortiert werden. Durch Klicken auf die 
Überschrift wird aufsteigend oder absteigend sortiert.

• Spaltenreihenfolge
Einzelne Spalten können durch horizontales Ziehen der Überschrift an eine andere Stelle in der Tabelle 
verschoben werden und so die Spaltenreihenfolge verändert werden.

• Spaltenbreite verändern
Sie könne alle Spalten in der Breite durch Ziehen des Spaltenrands verändern.

Parameter eines Messkanals

Für jeden PMU-Server werden im mittleren Fensterbereich unter den Parametern des PMU-Servers und der 
markierten logischen PMU die hierfür angelegten Messkanäle in Form einer Tabelle angezeigt.

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/Parameter der Messkanäle er-
läutert.

Tabelle 4-31 Parameter eines Messkanals

Element Erläuterung
Channel name Sie können den Namen eines Messkanals frei vergeben. Da er in das 

Protokoll IEEE C37.118 eingetragen wird, darf der Channel name eine 
Länge von 16 Zeichen nicht überschreiten.
z.B.: MchP/400/NbgH/U1

Measurement Definition der Messstelle aus Available measurements. Die hier ge-
messenen Messwerte werden über diesen Messkanal übertragen.

Meas. Mode Definition des Messverfahrens für analoge Werte außer Frequenz und 
Frequenzänderungsgeschwindigkeit
Folgende Parameter werden auf Grund der Messstelle angezeigt:
• S (Single point)

Messung des Momentanwertes
• R (RMS = root mean square)

Messung des quadratischen Mittelwertes (Effektivwert)
• P (Peak)

Messung des Maximalwertes
Subst Magn Definition eines Ersatzwertes, der an Stelle des Originalmesswertes 

übertragen wird.
Wenn kein Wert parametriert ist, wird der Originalmesswert übertragen.

Subst Angle Definition eines Ersatzwertes, der an Stelle des Originalmesswertes 
übertragen wird.
Eine Eingabe ist nur bei Phasoren erlaubt. Wenn kein Wert parametriert 
ist, wird der Originalmesswert übertragen.
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 HINWEIS

Die Tabelle der Messkanäle muss nach der Spalte Meas. Mode sortiert sein, um gemäß dem Protokoll IEEE 
C37.118 eine ordnungsgemäße Übertragung zu gewährleisten.

Markierte Zeilen können hierfür über das Kontextmenü nach oben oder unten verschoben werden.

Weitere Details siehe Protokoll IEEE C37.118.

 

4.8.3 ICCP
.

Das Inter-Control Center Communications Protocol, auch als IEC 60870-6/TASE.2 bezeichnet, ist ein Kommu-
nikationsprotokoll für den Austausch von Daten zwischen Netzleitstellen. SIGUARD PDP ist in der Lage, mit 
diesem Kommunikationsprotokoll Daten an eine oder mehrere Leitstellen zu senden.

 HINWEIS

SIGUARD PDP kann keine Daten über ICCP empfangen.

 

 HINWEIS

Beachten Sie, dass Sie für die Funktion von ICCP eine entsprechende SIGUARD PDP-Lizenz benötigen. Die 
Existenz dieser Lizenz wird im SIGUARD PDP Engineer nicht abgefragt.

 

Für die Konfiguration von Kommunikationsprotokollen wird der Ordner ICCP markiert und ein Name für den 
Ordner ICCP vergeben:
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Bild 4-32 Name für den Ordner ICCP vergeben

Jetzt wird der Ordner ICCP geöffnet und ein Protokoll ausgewählt.

Funktionen

Folgende Funktionen können bei ausgewähltem Ordner ICCP ausgeführt werden.

Tabelle 4-32 Funktionen für ICCP

Element Erläuterung
Klicken Sie auf die Schaltfläche New, um ein neues Protokoll mit den da-
zugehörenden Unterverzeichnissen Measurements und Groupindica-
tion anzulegen.
Klicken Sie auf die Schaltfläche duplicate, um bei markiertem Protokoll 
ein Duplikat mit neuem Namen anzulegen.
Klicken Sie auf die Schaltfläche del, um ein markiertes Protokoll mit den 
dazugehörenden Unterverzeichnissen zu löschen.
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ICCP-Kommunikationsparameter

Wenn Sie ein ICCP_Main im Fensterbereich Available communication interfaces ausgewählt haben, wird 
folgender mittlerer Fensterbereich Communication - ICCP angezeigt.

Bild 4-33 ICCP-Kommunikationsparameter

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Eigenschaften/ICCP-Kommunikationsparame-
ter erläutert.

Tabelle 4-33 ICCP-Kommunikationsparameter

Element Erläuterung
Local Settings
Name Definition des Namens der ICCP-Schnittstelle.
initiator Wenn das Kontrollkästchen markiert ist, dann ist SIGUARD PDP der In-

itiator der Kommunikation.
Local Domain Name Definition des lokalen Domain-Namens
Local AR Name Lokaler Applikationsreferenzname 
Remote Settings
Remote Domain Name Domain-Name der Gegenstelle
1st Remote AR Name Erster Applikationsreferenzname der Gegenstelle

Bis zu 4 Namen (entsprechend 4 Rechnern auf der Gegenstelle) werden 
unterstützt.

2ndRemote AR Name 2. Applikationsreferenzname der Gegenstelle
Bis zu 4 Namen (entsprechend 4 Rechnern auf der Gegenstelle) werden 
unterstützt.
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3rd Remote AR Name 3. Applikationsreferenzname der Gegenstelle
Bis zu 4 Namen (entsprechend 4 Rechnern auf der Gegenstelle) werden 
unterstützt.

4th Remote AR Name 4. Applikationsreferenzname der Gegenstelle
Bis zu 4 Namen (entsprechend 4 Rechnern auf der Gegenstelle) werden 
unterstützt.

Version
ICCP Version In dieser Auswahlliste wird die ICCP-Version eingestellt, mit der dieses 

Protokoll kompatibel sein soll.
Die Versionen 1996-08 und 2000-08 werden unterstützt.

Bilateral Table ID Identifikation der bilateralen Tabelle
In dieser Tabelle werden die über das Protokoll ausgetauschten Informa-
tionen aufgelistet und mit einem vereinbarten Namen versehen. Ver-
schiedene Versionen dieser Tabelle sollten unterschiedliche Identifikati-
onen aufweisen.

Heartbeat
Link Heartbeat Wenn das Kontrollkästchen markiert ist, dann werden Testtelegramme 

zur Verifikation der Funktionalität des Kommunikationslinks ausge-
tauscht.

Link Heartbeatinterval (msec) Intervall zwischen 2 Verifikationstelegrammen
Data Package Parameters
Max MM SPDU Size Maximale Größe der PDU für MMS-Berichte, in Bytes.

Die aktuelle PDU-Größe wird zwischen den kommunizierenden Peers 
ermittelt und kann unterhalb der Maximalgröße liegen. Die ermittelt PDU-
Größe wird verwendet, um große Datenmengen in kleinere Einheiten für 
die Lieferung zu unterteilen.

Client Response Timeout (s) Wenn der ICCP-Client eine Select- oder Operate-Anforderung von einer 
Überwachungseinheit erhält und die Anforderung an den ICCP-Server 
schickt, startet dieser Timer. Der ICCP-Server muss die Anforderung vor 
Ablauf dieser Zeit quittieren.

Association Request Timeout (s) Nach Ablauf dieser Zeit ist die Zeit für einen Verbindungsversuch über-
schritten. Das heißt, wenn Ihr System die Verbindung initialisiert, dann 
sendet es eine Nachricht an den Peer, um eine Verbindung aufzubauen. 
Wenn innerhalb der unter Association Request Time-out eingestellten 
Zeit keine Antwort eintrifft, dann interpretiert Ihr System das als fehlge-
schlagenen Verbindungsaufbau. Das System wartet dann die unter As-
sociation Request Retry eingestellte Zeit ab, bevor es erneut versucht, 
eine Verbindung aufzubauen. Das ist nur von Bedeutung, wenn der Pa-
rameter Association Initiator auf Yes eingestellt ist.

Association Request Retry (s) Das ist die Anzahl an Sekunden, die zwischen Verbindungsversuchen 
liegen muss. D.h. nach einem fehlgeschlagenen Verbindungsversuch 
darf das System erst nach Ablauf dieser Zeit einen neuen Verbindungs-
versuch starten. Siehe auch Association Request Time-out. Das ist 
nur von Bedeutung, wenn der Parameter Association Initiator auf Ye-
seingestellt ist.

Server Settings
Server Response Timeout (s) Dieser Zeitüberschreitungswert wird nur vom ICCP-Server verwendet. 

Der ICCP-Client sendet eine Select- oder Operate-Anforderung. Der 
ICCP-Server erhält diese Anforderung und sendet sie an eine Überwa-
chungseinrichtung. Erst danach startet der Zähler.
Die Überwachungseinrichtung muss die Anforderung innerhalb dieser 
Zeit quittieren. Für einen problemlosen Betrieb mit ICCP empfiehlt Sie-
mens, für diesen Zeitüberschreitungswert einen Wert unterhalb des 
Client Response Timeout-Wertes einzustellen.

Element Erläuterung
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ICCP-Measurements

Wenn Sie das Unterverzeichnis Measurements eines ICCP-Protokolls ausgewählt haben, wird folgender mitt-
lerer Fensterbereich Communication - ICCP angezeigt.

Bild 4-34 ICCP-Measurements

Für die Definition der Messstellen müssen Voreinstellungen markiert werden, sodass nur diese bestimmten 
Parameter übernommen werden.

Im Fensterbereich Default settings for drag and drop operation sind mehrere Kontrollkästchen enthalten, 
mit denen man auswählen kann, welche Informationen per Drag & Drop über ICCP transferiert werden.

Server Reply Timeout (s) Wenn eine Nachricht an einen Server (Peer) gesendet wurde, liegt eine 
Zeitüberschreitung erst nach Ablauf dieser Anzahl von Sekunden vor. 
Wenn diese Zeit abläuft und der Peer nicht geantwortet hat, dann ist die 
Kommunikation zum Remote-Peer unterbrochen.

Shortest Periodic Interval (s) Für einen ICCP-Peer können periodische Datenübertragungen in Inter-
vallen notwendig sein, die vorher per Remote festgelegt wurden. Dieser 
Parameter ist das kürzeste Zeitintervall in Sekunden, das Ihr System ak-
zeptiert. Dieser Parameter verhindert, dass ein falsch konfigurierten 
Remote-ICCP-Peers Ihr System mit Datenanfragen überhäuft.
Beispiel: Sie haben diesen Wert z.B. auf 30 Sekunden eingestellt. Ein 
Client erstellt eine Übertragungsgruppe mit einer Periodizität von 10 Se-
kunden. ICCPNT erkennt diese Unterschreitung, erstellt einen Protokol-
leintrag und passt die Periodizität der Übertragungsgruppe automatisch 
auf 30 Sekunden an.

Element Erläuterung
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Anschließend werden die Messstellen per Drag & Drop in den mittleren Fensterbereich gezogen. Für jede 
Messstelle wird entsprechend den Voreinstellungen (Parameter) eine Zeile angelegt.

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Parameter der Messstellen erläutert.

Tabelle 4-34 ICCP-Parameter der Messstellen

Um die Events zu modifizieren gibt es 2 Möglichkeiten:

• Globale Änderung der Parameter nach Auswahl im unteren Teil des mittleren Fensterbereichs.

• Manuelle Änderung der Parameter, die nicht global geändert werden können.

Hierzu muss eine Zeile der Messstelle markiert werden. Die voreingestellten Parameter sind jetzt auch im 
unteren Teil des Fensterbereichs markiert. Entfernen Sie die Markierung z.B. von Max1. Die entsprechenden 
Zeilen für diesen Parameter werden gelöscht.

Element Erläuterung
Server objects Hier werden per Drag & Drop Messwerte aus den Available measure-

ments hinterlegt. Beachten Sie, dass je nach Selektion der Default set-
tings for drag and drop operations mit einer Drag-&-Drop-Operation 
mehrere Server objects angelegt werden können.

invert Wenn das Kontrollkästchen markiert ist, dann werden digitale Werte 1 
als 0 übertragen und umgekehrt.

Slope Mit einem Slope können Werte von SIGUARD PDP in ihrer Größe ange-
passt werden. Beispielsweise werden die Spannungen in SIGUARD 
PDP in der Regel in V verarbeitet. Wenn das Zielsystem die Werte in kV 
erhalten soll, dann tragen Sie hier einen Slope von 0.001 ein.

Offset Mit dem Offset können die Werte von SIGUARD PDP dem Zielsystem 
angepasst werden, indem der Offset auf den Ausgangswert aufaddiert 
wird.

Global Wenn das Kontrollkästchen markiert ist, kann das Zielsystem diese 
Daten weiter per ICCP verteilen.
Wenn das Kontrollkästchen nicht markiert ist, dann ist eine Weiterleitung 
durch das Zielsystem nicht erlaubt.
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Bild 4-35 ICCP-Measurements mit ausgeblendetem Parameter
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ICCP-Groupindication

Mit diesem Editor können Sie durch SIGUARD PDP erzeugte Überwachungsmeldungen, wie z.B. Kommuni-
kationsfehler zu einer PMU oder Fehler im Archiv, an ein SCADA-System übermitteln und dort anzeigen. Sie 
können aus der Vielzahl der SIGUARD PDP-Meldungen einzelne oder ganze Gruppen auswählen und einem 
oder mehreren ICCP-Events zuordnen.

Wenn Sie das Unterverzeichnis Groupindication eines ICCP-Protokolls ausgewählt haben, wird folgender 
mittlerer Fensterbereich Communication - ICCP Measurements angezeigt.

Bild 4-36 ICCP-Groupindication

Es werden verschiedene Ereignisse ausgewählt, die per Drag & Drop in den mittleren Fensterbereich gezogen 
werden.
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Bild 4-37 ICCP-Groupindication mit eingefügten Events

Einzel-Events können einer bestehenden Gruppe zugeordnet werden (Einfügen in graues Feld unterhalb des 
Objektnamens).

Sammel-Events werden nach dem Einfügen als Gruppe mit neuem Objektnamen angelegt (Einfügen in weißes 
Feld in der Spalte Objectname).

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten der Parameter der Events erläutert.

Tabelle 4-35 ICCP Parameter für Groupindication

Element Erläuterung
Objectname Name des ICCP Event Objekts
Incidencekey Mit Incidence Key und Element Type werden die Ereignisse von 

SIGUARD PDP identifiziert, die zur Übertragung an das ICCP-Zielsys-
tem ausgewählt sind. Mehrere SIGUARD PDP-Ereignisse können zu 
einem ICCP-Ereignis verknüpft werden.

Elementtype

ID ID ist der Name des Objekts, das der Grund des Events ist. Auf den ent-
sprechenden Seiten im Engineer, auf denen Sie das Objekt parametrie-
ren, sehen Sie denselben Namen. Wenn kein Objekt mit diesem Event 
zusammenhängt, haben Sie keine ID.

invert Mit diesem Kontrollkästchen wird gesteuert, ob bei SIGUARD PDP-Er-
eignissen eine 0 oder eine 1 übertragen wird.
Wenn das Kontrollkästchen aktiviert ist, dann wird bei einem auftreten-
den Ereignis von SIGUARD eine 1 übertragen.

Global Wenn das Kontrollkästchen markiert ist, kann das Zielsystem diese 
Daten weiter per ICCP verteilen.
Wenn das Kontrollkästchen nicht markiert ist, dann ist eine Weiterleitung 
durch das Zielsystem nicht erlaubt.
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4.8.4 OPC
.

SIGUARD PDP enthält einen OPC-Server, der Zugriff auf die Daten von SIGUARD mittels des Data Access 
Profils Version 3 erlaubt.

 HINWEIS

Beachten Sie, dass Sie für die Funktion von OPC eine entsprechende SIGUARD PDP-Lizenz benötigen. Die 
Existenz dieser Lizenz wird im SIGUARD PDP Engineer nicht abgefragt.

 

Für die Konfiguration der Messstellen für den OPC-Server wird der Ordner OPC markiert.

Bild 4-38

Für die Konfiguration der Messstellen für den OPC-Server wird der Ordner OPC ausgewählt und ein neuer 
OPC-Server angelegt..

Weitere Informationen erhalten Sie im Administrator-Handbuch im Kapitel OCP.
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Funktionen

Folgende Funktionen können bei ausgewähltem Ordner OPC ausgeführt werden.

Tabelle 4-36 Funktionen für PDC-Server und logischen PMUs

OPC-Parameter

Wenn Sie einen neuen OPC-Server angelegt haben, wird folgender mittlerer Fensterbereich Communication 
- OPC angezeigt.

Bild 4-39 OPC-Server definieren

In der nachfolgenden Tabelle sind die Einstellmöglichkeiten für den OPC-Server erläutert.

Element Erläuterung
Klicken Sie auf die Schaltfläche New, um einen neuen OPC-Server zu 
definieren und Messstellen diesem OPC-Server zuzuordnen
Klicken Sie auf die Schaltfläche Del, um einen bestehenden OPC-Server 
zu löschen.
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Tabelle 4-37 OPC-Kommunikationsparameter

Bild 4-40 OPC-Server mit zugeordneten Messstellen

Weitere Informationen zum Speichern, Aktivieren und Validieren des Projekts erhalten Sie im Kapitel 
4.9 Gemeinsame Funktionen.

Element Erläuterung
Server name Definition des Namens des OPC-Servers.
Port Port, an dem der OPC-Server angeschlossen ist.
Measurement Hier können durch Drag-&-Drop-Operationen die Messwerte aus der 

Liste Available measurements eingefügt werden, die zur Weiterleitung 
durch den SIGUARD PDP OPC-Server vorgesehen sind.

invert Diese Einstellung ist nur bei digitalen Messwerten aktiv.
Wenn das Kontrollkästchen markiert ist, dann wird die Darstellung des 
Binärsignals invertiert, d.h. eine 1 wird als 0 übertragen und umgekehrt.
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4.9 Gemeinsame Funktionen
.

Für alle Editoren in SIGUARD PDP Engineer stehen folgende gemeinsame Funktionen zur Verfügung.

Eingaben

Ein Eingabefeld ist rot hinterlegt, wenn eine Eingabe erwartet wird. Eingaben werden in die Konfiguration über-
nommen mit:

• Betätigung der <Enter>-Taste

• Betätigung der <Tab>-Taste

• Bewegen des Cursors aus dem Eingabefeld

Eingaben von Zahlen mit nicht ganzzahligen Werten sind nur gültig, wenn sie mit Punkt eingegeben werden 
(z.B. 0.01).

Speichern eines Projekts

Nach jeder Änderung oder Neukonfiguration sollten die Daten eines Projekts gespeichert werden (lokale Kopie 
der Konfiguration). Eine Konfiguration, die noch nicht valide ist, kann zwar gespeichert, aber nicht aktiviert 
werden.

Validierung

Aktuelle Fehler können während der Eingabe in Kurzinfos (Tooltipps) angezeigt werden. Eine komplette Vali-

dierung erfolgt über das Menü Projekt > Validate oder das entsprechende Symbol . Wenn Fehlermeldun-
gen angezeigt werden, dann müssen Sie die Konfiguration nachbearbeiten. Wenn die Validierung fehlerfrei ist, 
kann das Projekt für den Laufzeitprozess aktiviert werden.

• Aktuelle Fehlermeldungen

Zu jedem Element, das mit einem Warnsymbol  markiert ist, kann eine Kurzinfo (Tooltipp) angezeigt 
werden. Zeigen Sie hierfür mit dem Cursor auf das Element. Die Kurzinfo enthält den Elementtyp und eine 
Beschreibung der aufgetretenen Fehler.
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Bild 4-41 Aktuelle Fehler im Tooltipp

• Fehlermeldungen nach Validierung

Im unteren Fensterbereich Project validation - Errors werden Fehlermeldungen auf Grund der Validie-
rung angezeigt, z.B.:

- Info (Registername): Beschreibung

- Error (Registername): Fehlerbeschreibung
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Bild 4-42 Beispiel einer Fehlermeldung

Dieser Fensterbereich kann bis auf die Überschrift ausgeblendet werden. In der Überschrift wird die Anzahl der 

Fehlermeldungen angezeigt. Wenn Fehlermeldungen auftreten, erscheint zusätzlich ein rotes Warnsymbol  
in der Übersicht (z.B. in der Baumstruktur von Calculated measurements), um zu verdeutlichen, von welcher 
Konfiguration die Fehlermeldung ausgelöst wurde.

Nach Bearbeitung der Fehlermeldungen und erneuter Validierung sollten keine Fehler mehr angezeigt werden. 
Das Projekt ist valide.

Aktivierung eines Projekts

Nach erfolgreicher Validierung kann ein geöffnetes und gespeichertes Projekt dem Runtime-Prozess zur Ver-

fügung gestellt werden. Dies erfolgt über das Menü Projekt > Activate oder das entsprechende Symbol . 
Hierbei wird die Konfiguration an eine definierte Stelle im SIGUARD PDP UI geschrieben oder eine bestehende 
Konfiguration mit der lokalen Kopie aus SIGUARD PDP Engineer überschrieben. SIGUARD PDP UI muss an-
schließend neu gestartet werden.

■
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5.1 Übersicht
5.1 Übersicht
.

Anhand von Beispielen soll Ihnen der Umgang mit SIGUARD PDP Engineer näher gebracht werden.

Die vorgeschlagene Vorgehensweise soll die einzelnen Schritte zur Parametrierung mit 
SIGUARD PDP Engineer verdeutlichen.
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5.2 Beispiel: Projekt, PMU
.

Gehen Sie in folgenden Schritten vor:

• Legen Sie ein neues Projekt an.

• Legen Sie eine neue physikalische PMU an.

• Legen Sie eine neue logische PMU an.

• Definieren Sie Messstellen für diese logische PMU.

• Speichern Sie das Projekt.

• Führen Sie eine Validierung durch.

• Aktivieren Sie das Projekt für den Laufzeitprozess, wenn die Konfiguration komplett ist.

Neues Projekt anlegen

✧ Klicken Sie auf die Schaltfläche , um ein neues Projekt anzulegen.

Der Dialog zum Eingeben des Projektnamens wird angezeigt.

Bild 5-1 Dialog Create New Project

✧ Geben Sie den Namen für das neue Projekt ein.

✧ Bestätigen Sie die Eingabe mit der Schaltfläche Create.
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Vorhandenes Projekt öffnen

✧ Klicken Sie auf die Schaltfläche , um ein vorhandenes Projekt zu öffnen.

Der Dialog zum Öffnen eines Projekts wird angezeigt.

Bild 5-2 Dialog Open

✧ Wählen Sie das Verzeichnis, in dem die Datei vom Typ SIGUARD Engineering File steht.

✧ Markieren Sie die SIGUARD PDP Engineer-Datei (SEF-Format).

✧ Bestätigen Sie die Auswahl mit der Schaltfläche Open.

Die Daten des Projekts werden geladen.
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Mit SIGUARD PDP Engineer arbeiten
5.2 Beispiel: Projekt, PMU
Neue physikalische PMU anlegen

✧ Wählen Sie die Registerkarte PMU aus.

✧ Markieren Sie das Verzeichnis All PMUs.

✧ Klicken Sie auf die Schaltfläche  im Fensterbereich Available PMUs, um eine neue physikalische 
PMU anzulegen.

Das Fenster zum Eingeben der Parameter für eine physikalische PMU wird angezeigt.

Bild 5-3 Parameter der physikalischen PMU 

Füllen Sie die rot markierten Pflichteingabefelder aus.

✧ Geben Sie den Namen im Feld PMU device name ein und bestätigen Sie mit der <Enter>-Taste.

Der Name wird in die Übersicht Available PMUs übernommen.

✧ Geben Sie die PMU device ID ein (aus der PMU übernehmen).

✧ Geben Sie die IP Address ein (aus der PMU übernehmen).

✧ Geben Sie den Port ein (aus der PMU übernehmen).
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Mit SIGUARD PDP Engineer arbeiten
5.2 Beispiel: Projekt, PMU
Neue logische PMU anlegen

Unter jeder physikalischen PMU muss immer eine logische PMU angelegt werden. Die neue physikalische 
PMU ist immer noch markiert.

✧ Klicken Sie auf die Schaltfläche  im Fensterbereich Available PMUs, um eine neue logische PMU 
anzulegen.

Das Fenster zum Eingeben der Parameter für eine logische PMU wird angezeigt:

Bild 5-4 Parameter der logischen PMU

Füllen Sie die rot markierten Pflichteingabefelder aus.

✧ Geben Sie den Namen im Feld Logical PMU name ein und bestätigen Sie mit der <Enter>-Taste.

Der Name wird in die Übersicht Available PMUs übernommen.

✧ Geben Sie die Logical PMU ID ein (aus der PMU übernehmen).
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Mit SIGUARD PDP Engineer arbeiten
5.2 Beispiel: Projekt, PMU
Messstellen definieren

✧ Markieren Sie das Feld Name in der Tabelle.

Der Name des PMU device und die Logical PMU ID werden übernommen.

✧ Geben Sie einen Namen für die Messstelle ein.

Eine zweite Zeile wird in die Tabelle eingefügt. Diese Zeile kann für die Definition einer weiteren Messstelle 
verwendet werden.

Bild 5-5 Name der Messstelle

✧ Geben Sie den Index ein (aus der PMU übernehmen).

✧ Geben Sie den Typ der Messstelle über die Auswahlliste Type ein (aus der PMU übernehmen).

Der ausgewählte Parameter wird übernommen.
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Mit SIGUARD PDP Engineer arbeiten
5.2 Beispiel: Projekt, PMU
Bild 5-6 Auswahlliste Type

✧ Geben Sie die Einheit der Messstelle über die Auswahlliste Unit ein (aus der PMU übernehmen).

Der ausgewählte Parameter wird in das Feld Type übernommen.
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Mit SIGUARD PDP Engineer arbeiten
5.2 Beispiel: Projekt, PMU
Bild 5-7 Auswahlliste Unit

✧ Markieren Sie das entsprechende Kontrollkästchen Archive, wenn die Messwerte dieser Messstelle im 
Archiv gespeichert werden sollen.

✧ Geben Sie in der Spalte Nominal den Nennwert ein.

✧ Geben Sie die unteren Grenzwerte (Min1 bis Min3) ein und markieren Sie die entsprechenden Kontroll-
kästchen.

✧ Geben Sie die oberen Grenzwerte (Max1 bis Max3) ein und markieren Sie die entsprechenden Kontroll-
kästchen.

✧ Geben Sie den Factor PSS ein (Standard = 1).

✧ Markieren Sie die Kontrollkästen für die Werte, die für die Messung einbezogen werden sollen.

Projekt speichern

✧ Klicken Sie auf die Schaltfläche , um das Projekt zu speichern.

Validierung durchführen

✧ Klicken Sie auf die Schaltfläche , um das Projekt auf Validierung zu prüfen.

Wenn noch Fehler enthalten sind, werden diese als Error (Project): ... angezeigt.

Wenn die Validierung fehlerfrei ist, wird dies als Information Info (Project): ... angezeigt.
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Mit SIGUARD PDP Engineer arbeiten
5.2 Beispiel: Projekt, PMU
Bild 5-8 Info (Project)

Projekt aktivieren

✧ Klicken Sie auf die Schaltfläche , um das Projekt für den Laufzeitprozess zu aktivieren.

 HINWEIS

Aktivieren Sie ein Projekt erst dann, wenn die Konfiguration vollständig ist.

 

SIGUARD PDP Phasor Data Processing, Handbuch
E50417-H1000-C419-A3, Ausgabe 11.2011

164

http://siemens-russia.com/


Mit SIGUARD PDP Engineer arbeiten
5.3 Beispiel: Berechnete Werte
5.3 Beispiel: Berechnete Werte
.

Gehen Sie in folgenden Schritten vor:

• Legen Sie ein neues Projekt an (siehe 5.2 Beispiel: Projekt, PMU).

• Legen Sie einen neuen berechneten Wert an.

• Geben Sie die Parameter für diesen berechneten Wert ein.

• Speichern Sie das Projekt.

• Führen Sie eine Validierung durch.

• Aktivieren Sie das Projekt für den Laufzeitprozess, wenn die Konfiguration komplett ist.

Neue berechnete Werte anlegen

✧ Wählen Sie die Registerkarte Calculation aus.

✧ Markieren Sie das Verzeichnis All calculated objects.

✧ Klicken Sie auf die Schaltfläche , um einen neuen berechneten Wert anzulegen.

Das Fenster zum Eingeben der Parameter wird angezeigt.

Bild 5-9 Parameter für einen berechneten Wert

Füllen Sie die rot markierten Pflichteingabefelder aus.

✧ Geben Sie den Namen des neuen berechneten Wertes ein und bestätigen mit der <Enter>-Taste.

Der Name wird in die Übersicht übernommen.
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Mit SIGUARD PDP Engineer arbeiten
5.3 Beispiel: Berechnete Werte
✧ Geben Sie den Factor ein (Standard = 1).

✧ Geben Sie eine Formel über das Auswahlfeld Formula ein (z.B. Add two analogs).

Die ausgewählte Formel wird übernommen.

Bild 5-10 Auswahl der Formel

✧ Markieren Sie das Kontrollkästchen Save results to archive, wenn die berechnete Messung im Archiv 
gespeichert werden soll.

Projekt speichern

✧ Klicken Sie auf die Schaltfläche , um das Projekt zu speichern.

Validierung durchführen

✧ Klicken Sie auf die Schaltfläche , um das Projekt auf Validierung zu prüfen.

Wenn noch Fehler enthalten sind, werden diese als Error (Calculation): ... angezeigt.
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Mit SIGUARD PDP Engineer arbeiten
5.3 Beispiel: Berechnete Werte
Bild 5-11 Fehlende Eingangsmessgrößen

Die fehlenden Eingangsmessgrößen werden als Fehler angezeigt (Felder sind rot hinterlegt).

✧ Ziehen Sie die Eingangsmessgrößen aus Available measurements (Typ: Analog) in die Felder Input 
measurements.

Die Fehlermeldung wird nicht mehr abgezeigt.

Projekt aktivieren

✧ Klicken Sie auf die Schaltfläche , um das Projekt für den Laufzeitprozess zu aktivieren.

 HINWEIS

Aktivieren Sie ein Projekt erst dann, wenn die Konfiguration vollständig ist.

 

■
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Mit SIGUARD PDP Engineer arbeiten
5.3 Beispiel: Berechnete Werte
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Glossar

Google Earth

Google Earth ist eine Software der Firma Google Inc. und stellt einen virtuellen Globus dar. Sie kann Satelliten- 
und Luftbilder unterschiedlicher Auflösung mit Geodaten überlagern und auf einem digitalen Höhenmodell der 
Erde zeigen.

In SIGUARD PDP wird die Landkarte, die im Fensterbereich SIGUARD PDP UI - Map dargestellt ist, auf Basis 
der Karten von Google Earth erstellt.

SIGUARD PDP (Phasor Data Processing)

Software zur Zustandsüberwachung der Energieverteilung in weitverzweigten Energienetzen.

SIMEAS R-PMU

SIMEAS R-PMU ist ein Gerät, das neben Schreibern über eine integrierte Phasor Measurement Unit (PMU) 
verfügt. Die PMU misst Phasoren und stellt diese als Datenbasis zur Verfügung. Es handelt sich dabei um eine 
Messung der Vektorgrößen von Spannungen und Strömen mit hoher Genauigkeit in Bezug auf Amplitude, 
Phasenwinkel und Zeitsynchronisation.
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